Oracle

Human Capital Management Cloud
Securing HCM

Release 13 (update 18B)
## Contents

**Preface**

1. **An Introduction to HCM Security in the Cloud**
   - Securing Oracle HCM Cloud: Overview
   - Role-Based Security: Explained
   - Predefined HCM Roles: Explained
   - Role Types: Explained
   - Role Inheritance: Explained
   - Duty Role Components: Explained
   - Aggregate Privileges: Explained
   - Security Configuration: Points to Consider
   - Reviewing Predefined Roles: Explained
   - Oracle Fusion Applications Security Console: Explained

2. **Creating Implementation Users**
   - HCM Implementation Users: Explained
   - Creating HCM Implementation Users: Overview
   - Synchronizing User and Role Information: Procedure
   - Importing Users and Roles into Applications Security: Procedure
   - Creating the TechAdmin Implementation User: Procedure
   - Creating the HCMUser Implementation User: Procedure

3. **Creating HCM Data Roles for Implementation Users**
   - Overview
   - Creating the HRAnalyst_ViewAll Data Role: Procedure
   - Creating the HCMApplicationAdministrator_ViewAll Data Role: Procedure
   - Creating the HRSpecialist_ViewAll Data Role: Procedure
   - Creating HCM Data Roles for Workforce Compensation Implementation Users: Procedure
   - Creating HCM Data Roles for Global Payroll Implementation Users: Procedure
## Security

4 **Enabling Basic Data Access for Abstract Roles**

- Assigning Security Profiles to Abstract Roles: Explained
- Assigning Security Profiles to Abstract Roles: Worked Example

5 **Assigning Roles to Implementation Users**

- Creating a Role Mapping for HCM Implementation Data Roles: Procedure
- Assigning Abstract and Data Roles to HCMUser: Procedure
- Verifying HCMUser Access: Procedure
- Resetting the Cloud Service Administrator Sign-In Details: Procedure

6 **Setting Up Applications Security**

- Defining Security Synchronization Processes and Preferences: Overview
- Defining the Default User-Name Format: Explained
- Setting Password Policy: Explained
- Setting Role Preferences: Explained
- User Categories: Explained
- Adding Users to a User Category: Procedures
- Managing User-Name and Password Notifications: Explained
- Creating a Notification Template: Procedure
- Scheduling the Import User and Role Application Security Data Process: Procedure
- Importing User Login History: Explained
- Send Pending LDAP Requests: Explained
- Scheduling the Send Pending LDAP Requests Process: Procedure
- Running Retrieve Latest LDAP Changes: Procedure

7 **Working with the Bridge for Microsoft Active Directory**

- Bridge for Microsoft Active Directory: Explained
- Synchronizing Information Between Source and Target Applications: Explained
- Mapping Information Between Source and Target Applications for Synchronization: Explained
- Using the Bridge for Microsoft Active Directory
- FAQs for Working with the Bridge for Microsoft Active Directory
8 Preparing for Application Users

Overview
User and Role-Provisioning Setup: Critical Choices
User Account Creation Option: Explained
User Account Role Provisioning Option: Explained
User Account Maintenance Option: Explained
User Account Creation for Terminated Workers Option: Explained
Setting the User and Role Provisioning Options: Procedure
Provisioning Abstract Roles to Users Automatically: Procedure
FAQs for Preparing for Application Users

9 Creating Application Users

Points to Consider
Using the New Person Tasks: Procedure
Using the Create User Task: Procedure
FAQs for Creating Application Users

10 Managing Application Users

Managing User Accounts: Procedure
Changing User Names: Explained
Sending Personal Data to LDAP: Explained
Processing a User Account Request: Explained
Linking Existing User Accounts to Person Records: Explained
Suspending User Accounts: Explained
Managing Application Users on the Security Console: Explained
Providing Read-Only Access: Procedure
FAQs for Managing Application Users

11 Provisioning Roles to Application Users

Role Mappings: Explained
Creating a Role Mapping: Procedure
Role Mappings: Examples
Role Provisioning and Deprovisioning: Explained
Autoprovisioning: Explained
Editing Role Mappings: Points to Consider
FAQs for Provisioning Roles to Application Users
12 Reporting on Application Users and Roles

Running the User Details System Extract Report: Procedure
User Details System Extract Report Parameters
User Details System Extract Report
Person User Information Reports
User History Report
LDAP Request Information Reports
Inactive Users Report
User Role Membership Report
User and Role Access Audit Report
User Password Changes Audit Report
FAQs for Reporting on Application Users and Roles

13 HCM Data Roles and Security Profiles

HCM Data Roles: Explained
HCM Security Profiles: Explained
Predefined HCM Security Profiles: Explained
Creating an HCM Data Role: Worked Example
Creating HCM Data Roles and Security Profiles: Points to Consider
Role Delegation: Explained
Enabling Role Delegation: Explained
Assigning Security Profiles to Job and Abstract Roles: Procedure
Previewing HCM Data Security: Explained
Configuring HCM Data Roles and Security Profiles for Audit: Procedure
HCM Data Roles Configuration Diagnostic Test
HCM Security Profile Configuration Diagnostic Test
HCM Securing Objects Metadata Diagnostic Test
FAQs for HCM Data Roles and Security Profiles
### 14 Person Security Profiles

- Securing Person Records: Points to Consider: 129
- Securing Person Records by Area of Responsibility: Procedure: 132
- Securing Person Records by Manager Hierarchy: Points to Consider: 133
- Specifying the Manager Type: Explained: 135
- Hierarchy Content: Explained: 136
- Securing Person Records by Person Type: Explained: 137
- Securing Person Records Using Custom Criteria: Examples: 138
- Tables and Views in Custom Criteria: Explained: 139
- FAQs for Person Security Profiles: 141

### 15 Organization and Other Security Profiles

- Securing Organizations: Points to Consider: 143
- Creating Organization Security Profiles: Examples: 144
- Securing Positions: Points to Consider: 145
- Creating Position Security Profiles: Examples: 146
- Creating Document Type Security Profiles: Examples: 147
- Legislative Data Group Security Profiles: Explained: 148
- Creating Payroll Security Profiles: Examples: 148
- Creating Flow Pattern Security Profiles: Examples: 149
- FAQs for Organization and Other Security Profiles: 151

### 16 Using the Security Console

- Graphical and Tabular Role Visualizations: Explained: 153
- Simulating Navigator Menus: Procedure: 154
- Reviewing Role Assignments: Procedure: 155
- Reviewing Role Hierarchies: Explained: 156
- Comparing Roles: Procedure: 156
- Reviewing Role Information on the Analytics Tab: Explained: 158
- Security Console Analytics for Database Resources: Explained: 158
# Creating and Editing Job, Abstract, and Duty Roles

- Copying HCM Roles: Points to Consider
- Security Console Role-Copy Options: Explained
- Copying Abstract Roles: Explained
- Copying Job and Abstract Roles: Procedure
- Editing Job and Abstract Roles: Procedure
- Creating Job or Abstract Roles from Scratch: Procedure
- Copying and Editing Duty Roles: Procedure

# Regenerating Roles

- Regenerating Roles: Explained
- Enabling the Grants Regeneration Process: Procedure
- Regenerating Multiple Data and Abstract Roles: Procedure

# Securing Content Sections in Person Profiles

- Securing Content Sections in Person Profiles: Explained
- Securing Content Sections in Person Profiles: Procedure

# Securing Access to Succession Plans, Incumbents, and Candidates

- Securing Access to Succession Plans, Incumbents, and Candidates: Overview
- Creating a Succession Plans Super User Job Role: Worked Example
- Configuring Access to Lists of Incumbents and Candidates: Worked Example

# Security and Reporting

- Oracle Fusion Transactional Business Intelligence Security: Explained
- How Reporting Data Is Secured: Explained
- Business Intelligence Roles: Explained
- Viewing Reporting Roles and Permissions: Procedure
- Business Intelligence Publisher Secured List Views: Explained
- Business Intelligence Publisher and PII Data: Explained
- Dimension Security: Explained
- FAQs for Security and Reporting
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td><strong>Auditing Oracle HCM Cloud Business Objects</strong></td>
<td>201</td>
</tr>
<tr>
<td></td>
<td>Auditing Oracle HCM Cloud Business Objects: Explained</td>
<td>201</td>
</tr>
<tr>
<td></td>
<td>Enabling Audit for Oracle HCM Cloud Business Objects: Procedure</td>
<td>201</td>
</tr>
<tr>
<td></td>
<td>Auditable Oracle HCM Cloud Business Objects</td>
<td>203</td>
</tr>
<tr>
<td></td>
<td>Enabling Access to HCM Audit Data: Points to Consider</td>
<td>204</td>
</tr>
<tr>
<td>23</td>
<td><strong>Certificate Management</strong></td>
<td>205</td>
</tr>
<tr>
<td></td>
<td>Managing Certificates: Explained</td>
<td>205</td>
</tr>
<tr>
<td></td>
<td>Generating Certificates: Explained</td>
<td>205</td>
</tr>
<tr>
<td></td>
<td>Generating a Signing Request: Procedure</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>Importing and Exporting X.509 Certificates: Procedure</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>Importing and Exporting PGP Certificates: Procedure</td>
<td>207</td>
</tr>
<tr>
<td></td>
<td>Deleting Certificates: Procedure</td>
<td>207</td>
</tr>
<tr>
<td>24</td>
<td><strong>Role Optimization</strong></td>
<td>209</td>
</tr>
<tr>
<td></td>
<td>Role Optimizer: Explained</td>
<td>209</td>
</tr>
<tr>
<td></td>
<td>Role Optimization Report</td>
<td>211</td>
</tr>
<tr>
<td>25</td>
<td><strong>Advanced Data Security</strong></td>
<td>213</td>
</tr>
<tr>
<td></td>
<td>Advanced Data Security: Explained</td>
<td>213</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons ❓ to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community**: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- **Guides and Videos**: Go to the Oracle Help Center to find guides and videos.

- **Training**: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 An Introduction to HCM Security in the Cloud

Securing Oracle HCM Cloud: Overview

Oracle Human Capital Management Cloud is secure as delivered. This guide explains how to enable user access to HCM functions and data. You perform many of the tasks in this guide during implementation. You can also perform most of them later and as requirements change. This topic summarizes the scope of this guide and identifies the contents of each chapter.

Guide Structure

This table describes the contents of each chapter in this guide.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>An Introduction to HCM Security in the Cloud</td>
<td>A brief overview of the concepts of role-based security and an introduction to the Oracle Fusion Applications Security Console</td>
</tr>
<tr>
<td>Creating Implementation Users</td>
<td>The role of implementation users and instructions for creating them</td>
</tr>
<tr>
<td>Creating HCM Data Roles for Implementation Users</td>
<td>How to provide the data access that enables implementation users to complete the functional implementation</td>
</tr>
<tr>
<td>Enabling Basic Data Access for Abstract Roles</td>
<td>How to provide basic data access for all employees, contingent workers, and line managers</td>
</tr>
<tr>
<td>Assigning Roles to Implementation Users</td>
<td>How to assign data and abstract roles to implementation users</td>
</tr>
<tr>
<td>Working with the Bridge for Microsoft Active Directory</td>
<td>How to install and configure the bridge for Microsoft Active Directory and synchronize user accounts</td>
</tr>
<tr>
<td>Preparing for Application Users</td>
<td>Enterprise-wide options and related decisions that affect application users</td>
</tr>
<tr>
<td>Creating Application Users</td>
<td>The ways in which you can create application users, with instructions for some methods</td>
</tr>
<tr>
<td>Managing Application Users</td>
<td>How to maintain user accounts throughout the workforce life cycle</td>
</tr>
<tr>
<td>Provisioning Roles to Application Users</td>
<td>The ways in which application users can acquire roles, with instructions for creating some standard role mappings</td>
</tr>
</tbody>
</table>
## Chapter 1
### Reporting on Application Users and Roles
- Reporting on user accounts, inactive users, roles provisioned to users, and password changes

### HCM Data Roles and Security Profiles
- How to create and manage HCM data roles and use HCM security profiles to identify the data that users can access

### Person Security Profiles
- How to secure access to person records

### Organization and Other Security Profiles
- How to secure access to organizations, positions, document types, legislative data groups, payrolls, and payroll flows

### Using the Security Console
- How to use the Security Console to review role hierarchies and role analytics

### Creating and Editing Job, Abstract, and Duty Roles
- How to copy predefined roles to create roles, how to create roles from scratch, and how to edit custom roles

### Regenerating Roles
- How to regenerate the data security policies of data and abstract roles when the role hierarchy changes

### Securing Content Sections in Person Profiles
- How to secure user access to content-type data in person profiles

### Securing Access to Succession Plans, Incumbents, and Candidates
- How to create a super user role to enable access to all succession plans, and how to configure restricted access to lists of incumbents and candidates

### Security and Reporting
- How to enable users to run Oracle Transactional Business Intelligence and Oracle Business Intelligence Publisher reports

### Auditing Oracle HCM Cloud Business Objects
- How to configure audit for HCM business objects and access audit reports

### Certificate Management
- How to generate, import, export, and delete PGP and X.509 certificates for data encryption and decryption

### Role Optimization
- How to use the optional Role Optimization Report to analyze the role hierarchy for redundancies and other inefficiencies

### Advanced Data Security
- An introduction to these optional cloud services:
  - Database Vault for Oracle Fusion Human Capital Management Security Cloud Service
  - Transparent Data Encryption for Oracle Fusion Human Capital Management Security Cloud Service

During implementation, you perform security-related tasks from a functional area task list or implementation project. Once the implementation is complete, you can perform most security-related tasks on the Security Console. Any exceptions are identified in relevant topics. For example, you hire workers in the New Person work area, not on the Security Console.
Role-Based Security: Explained

In Oracle Fusion Applications, users have roles through which they gain access to functions and data. Users can have any number of roles.

In this figure, user Lynda Jones has three roles.

When Lynda signs in to Oracle Human Capital Management Cloud (Oracle HCM Cloud), she doesn't have to select a role. All of these roles are active concurrently.

The functions and data that Lynda can access are determined by this combination of roles.

- As an employee, Lynda can access employee functions and data.
- As a line manager, Lynda can access line-manager functions and data.
- As a human resource specialist (HR specialist), Lynda can access HR specialist functions and data for Vision Operations.

Role-Based Access Control

Role-based security in Oracle Fusion Applications controls who can do what on which data.

This table summarizes role-based access.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who</td>
<td>Is a role assigned to a user</td>
</tr>
<tr>
<td>What</td>
<td>Is a function that users with the role can perform</td>
</tr>
</tbody>
</table>
Component | Description
--- | ---
Which Data | Is the set of data that users with the role can access when performing the function

This table provides some examples of role-based access.

<table>
<thead>
<tr>
<th>Who</th>
<th>What</th>
<th>Which Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line managers</td>
<td>Can create performance documents</td>
<td>For workers in their reporting hierarchies</td>
</tr>
<tr>
<td>Employees</td>
<td>Can view payslips</td>
<td>For themselves</td>
</tr>
<tr>
<td>Payroll managers</td>
<td>Can report payroll balances</td>
<td>For specified payrolls</td>
</tr>
<tr>
<td>HR specialists</td>
<td>Can transfer workers</td>
<td>For workers in specified organizations</td>
</tr>
</tbody>
</table>

Predefined HCM Roles: Explained

Many job and abstract roles are predefined in Oracle Human Capital Management Cloud (Oracle HCM Cloud). This list shows the main predefined HCM roles:

- Benefits Administrator
- Benefits Manager
- Benefits Specialist
- Compensation Administrator
- Compensation Analyst
- Compensation Manager
- Compensation Specialist
- Contingent Worker
- Employee
- Environment, Health and Safety Manager
- Human Capital Management Application Administrator
- Human Capital Management Integration Specialist
- Human Resource Analyst
- Human Resource Manager
- Human Resource Specialist
- Line Manager
- Payroll Administrator
- Payroll Manager
- Power Recruiter
- Recruiting Administrator
These predefined roles are part of the Oracle HCM Cloud security reference implementation. The security reference implementation is a predefined set of security definitions that you can use as supplied.

Also included in the security reference implementation are roles that are common to all Oracle Fusion applications, such as:

- Application Implementation Consultant
- IT Security Manager

You can include the predefined roles in HCM data roles, for example. Typically, you assign the Employee, Contingent Worker, and Line Manager abstract roles directly to users.

**Role Types: Explained**

Oracle Human Capital Management Cloud (Oracle HCM Cloud) defines five types of roles:

- Data roles
- Abstract roles
- Job roles
- Aggregate privileges
- Duty roles

This topic introduces the role types.

**Data Roles**

Data roles combine a worker’s job and the data that users with the job must access. For example, the HCM data role Country Human Resource Specialist combines a job (human resource specialist) with a data scope (country). You define the data scope of a data role in one or more HCM security profiles. HCM data roles aren’t part of the security reference implementation. You define all HCM data roles locally and assign them directly to users.

**Abstract Roles**

Abstract roles represent a worker’s role in the enterprise independently of the job that you hire the worker to do. Three abstract roles are predefined in Oracle HCM Cloud:

- Employee
- Contingent Worker
- Line Manager

You can also create abstract roles. All workers are likely to have at least one abstract role. Their abstract roles enable users to access standard functions, such as managing their own information and searching the worker directory. You assign abstract roles directly to users.
Job Roles

Job roles represent the job that you hire a worker to perform. Human Resource Analyst and Payroll Manager are examples of predefined job roles. You can also create job roles. Typically, you include job roles in data roles and assign those data roles to users. The IT Security Manager and Application Implementation Consultant predefined job roles are exceptions to this general rule because they’re not considered HCM job roles. Also, you don’t define their data scope in HCM security profiles.

Aggregate Privileges

Aggregate privileges combine the functional privilege for an individual task or duty with the relevant data security policies. The functional privileges that aggregate privileges provide may grant access to task flows, application pages, work areas, reports, batch programs, and so on. Job and abstract roles inherit aggregate privileges directly. Aggregate privileges don’t inherit other roles. All aggregate privileges are predefined and you can’t edit them. Although you can’t create aggregate privileges, you can include the predefined aggregate privileges in custom job and abstract roles. You don’t assign aggregate privileges directly to users.

Duty Roles

Each predefined duty role represents a logical grouping of privileges that you may want to copy and edit. Duty roles differ from aggregate privileges as follows:

- They include multiple function security privileges.
- They can inherit aggregate privileges and other duty roles.
- You can create duty roles.

Job and abstract roles may inherit duty roles either directly or indirectly. You can include predefined and custom duty roles in custom job and abstract roles. You don’t assign duty roles directly to users.

Role Inheritance: Explained

Each role is a hierarchy of other roles:

- HCM data roles inherit job or abstract roles.
- Job and abstract roles inherit many aggregate privileges. They may also inherit a few duty roles.

  In addition to aggregate privileges and duty roles, job and abstract roles are granted many function security privileges and data security policies directly.

- Duty roles can inherit other duty roles and aggregate privileges.

You can explore the complete structure of a job or abstract role on the Security Console.

When you assign data and abstract roles to users, they inherit all of the data and function security associated with those roles.

Role Inheritance Example

This example shows how roles are inherited.
The figure shows a few representative aggregate privileges and a single duty role. In reality, job and abstract roles inherit many aggregate privileges. Any duty roles that they inherit may themselves inherit duty roles and aggregate privileges.

In this example, user Bob Price has two roles:

- HR Specialist Vision Corporation, a data role
- Employee, an abstract role

This table describes the two roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Specialist Vision Corporation</td>
<td>Inherits the job role Human Resource Specialist. This role inherits the aggregate privileges and duty roles that provide access to the tasks and functions that a human resource specialist performs. The security profile assigned to the data role provides the data access for the role.</td>
</tr>
<tr>
<td>Employee</td>
<td>Inherits the aggregate privileges and duty roles that provide access to all tasks and functions, unrelated to a specific job, that every employee performs. The security profile assigned to the abstract role provides the data access for the role.</td>
</tr>
</tbody>
</table>
Duty Role Components: Explained

This topic describes the components of a typical duty role. You must understand how duty roles are constructed if you plan to create duty roles, for example.

Function security privileges and data security policies are granted to duty roles. Duty roles may also inherit aggregate privileges and other duty roles. For example, the Workforce Structures Management duty role has the structure shown in this figure.

In addition to its aggregate privileges, the Workforce Structures Management duty role is granted many function security privileges and data security policies.

Data Security Policies

Many data security policies are granted directly to the Workforce Structures Management duty role, including Manage Location, Manage Assignment Grade, and Manage HR Job. It also acquires data security policies indirectly, from its aggregate privileges.

Each data security policy combines:

- The role to which the data security policy is granted. The role can be a duty role, such as Workforce Structures Management, job role, abstract role, or aggregate privilege.
- A business object, such as assignment grade, that’s being accessed. The data security policy identifies this resource by its table name, which is PER_GRADES_F for assignment grade.
- The condition, if any, that controls access to specific instances of the business object. Conditions are usually specified for resources that you secure using HCM security profiles. Otherwise, business object instances can be
identified by key values. For example, a user with the Workforce Structures Management duty role can manage all grades in the enterprise.

- A data security privilege that defines permitted actions on the data. For example, Manage Assignment Grade is a data security privilege.

Function Security Privileges

Many function security privileges are granted directly to the Workforce Structures Management duty role, including Manage Location, Manage Assignment Grade, and Manage HR Job. It also acquires function security privileges indirectly, from its aggregate privileges.

Each function security privilege secures the code resources that make up the relevant pages, such as the Manage Grades and Manage Locations pages. Some user interfaces aren’t subject to data security, so some function security privileges have no equivalent data security policy.

Predefined Duty Roles

The predefined duty roles represent logical groupings of privileges that you may want to manage as a group. They also represent real-world groups of tasks. For example, the predefined Human Resource Specialist job role inherits the Workforce Structures Management duty role. To create a Human Resource Specialist job role with no access to workforce structures, you would:

1. Copy the predefined job role.
2. Remove the Workforce Structures Management duty role from the copy.

Aggregate Privileges: Explained

Aggregate privileges are a type of role. Each aggregate privilege combines a single function security privilege with related data security policies. All aggregate privileges are predefined. This topic describes how aggregate privileges are named and used.

Aggregate Privilege Names

An aggregate privilege takes its name from the function security privilege that it includes. For example, the Promote Worker aggregate privilege includes the Promote Worker function security privilege.

Aggregate Privileges in the Role Hierarchy

Job roles and abstract roles inherit aggregate privileges directly. Duty roles may also inherit aggregate privileges. However, aggregate privileges can’t inherit other roles of any type. As most function and data security in job and abstract roles is provided by aggregate privileges, the role hierarchy has few levels. This flat hierarchy is easy to manage.

Use of Aggregate Privileges in Custom Roles

You can include aggregate privileges in the role hierarchy of a custom role. Treat aggregate privileges as role building blocks.
Creating, Editing, or Copying Aggregate Privileges

You can’t create, edit, or copy aggregate privileges, nor can you grant the privileges from an aggregate privilege to another role. The purpose of an aggregate privilege is to grant a function security privilege only in combination with a specific data security policy. Therefore, you must use the aggregate privilege as a single entity.

If you copy a job or abstract role, then the source role’s aggregate privileges are never copied. Instead, role membership is added automatically to the aggregate privilege for the copied role.

Security Configuration: Points to Consider

If the predefined security reference implementation doesn’t fully represent your enterprise, then you can make changes. For example, the predefined Line Manager abstract role includes compensation management privileges. If some of your line managers don’t handle compensation, then you can create a line manager role without those privileges. To create a role, you can either copy an existing role or create a role from scratch.

During implementation, you evaluate the predefined roles and decide whether changes are needed. You can identify predefined roles easily by their role codes, which all have the prefix `ORA_`. For example, the role code of the Payroll Manager job role is `ORA_PAY_PAYROLL_MANAGER_JOB`. All predefined roles are granted many function security privileges and data security policies. They also inherit aggregate privileges and duty roles. To make minor changes to a role, copying and editing the predefined role is the more efficient approach. Creating roles from scratch is most successful when the role has very few privileges and you can identify them easily.

Missing Enterprise Jobs

If jobs exist in your enterprise that aren’t represented in the security reference implementation, then you can create your own job roles. Add aggregate privileges and duty roles to custom job roles, as appropriate.

Predefined Roles with Different Privileges

If the privileges for a predefined job role don’t match the corresponding job in your enterprise, then you can create your own version of the role. If you copy the predefined role, then you can edit the copy. You can add or remove aggregate privileges, duty roles, function security privileges, and data security policies, as appropriate.

Predefined Roles with Missing Privileges

If the privileges for a job aren’t defined in the security reference implementation, then you can create your own duty roles. However, the typical implementation doesn’t use custom duty roles. You can’t create aggregate privileges.

Reviewing Predefined Roles: Explained

This topic describes some of the ways in which you can access information about predefined roles. This information can help you to identify which users need each role and whether to make any changes before provisioning roles.
The Security Console

On the Security Console, you can:

- Review the role hierarchy of any job, abstract, or duty role.
- Extract the role hierarchy to a spreadsheet.
- Identify the function security privileges and data security policies granted to a role.
- Compare roles to identify differences.

💡 Tip: The role codes of all predefined roles have the prefix `ORA_`.

Reports

You can run the User and Role Access Audit Report. This XML-format report identifies the function security privileges and data security policies for a specified role, all roles, a specified user, or all users.

The Security Reference Manuals

Two manuals describe the security reference implementation for Oracle HCM Cloud users:

- The Security Reference for Oracle Applications Cloud includes descriptions of all predefined security data that’s common to Oracle Fusion Applications.
- The Security Reference for Oracle HCM Cloud includes descriptions of all predefined security data for Oracle HCM Cloud.

Both manuals contain a section for each predefined job and abstract role. For each role, you can review its:

- Duty roles and aggregate privileges
- Role hierarchy
- Function security privileges
- Data security policies

You can access the security reference manuals on docs.oracle.com.

Oracle Fusion Applications Security Console: Explained

The Oracle Fusion Applications Security Console is an easy-to-use administrative work area where you perform most security-management tasks. This topic introduces the Security Console and describes how to access it.

Security Console Functions

Use the Security Console to:

- Review role hierarchies and role analytics.
Note: You can review HCM data roles on the Security Console. However, you must manage them on the Manage Data Roles and Security Profiles page.

- Create and manage custom job, abstract, and duty roles.
- Review the roles assigned to users.
- Create and manage implementation users and their roles.
- Compare roles.
- Simulate the Navigator for a user or role.
- Manage the default format of user names and the enterprise password policy.
- Manage notifications for user-lifecycle events, such as password expiration.
- Manage PGP and X.509 certificates for data encryption and decryption.
- Set up federation, and synchronize user and role information between Oracle Fusion Applications Security and Microsoft Active Directory, if appropriate.

Accessing the Security Console

You must have the IT Security Manager job role to access the Security Console. You open the Security Console by selecting the Security Console work area. These tasks, performed in the Setup and Maintenance work area, also open the Security Console:

- Manage Job Roles
- Manage Duties
- Create Implementation Users
- Revoke Data Role from Implementation Users
HCM Implementation Users: Explained

Implementation users:

- Manage the implementation of Oracle Human Capital Management Cloud (Oracle HCM Cloud).
- Administer application users and security, both during and after implementation.
- Set up basic enterprise structures.

Implementation users have the necessary access for both initial implementation of the Oracle HCM Cloud service and its ongoing maintenance. You’re recommended to create at least one implementation user.

How Implementation Users Differ from Application Users

Thanks to job roles such as Application Implementation Consultant, implementation users have unrestricted access to large amounts of data. However, the need for this level of access is temporary. After implementation, both application users and administrators can perform their tasks using less powerful roles. For an implementation user, only a user account exists. No person record exists in Oracle HCM Cloud.

Who Creates Implementation Users?

The Oracle HCM Cloud service administrator creates initial implementation users.

Recommended Implementation Users

You’re recommended to create the implementation users shown in this table to ensure segregation of critical duties.

<table>
<thead>
<tr>
<th>Implementation User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TechAdmin</td>
<td>Performs technical setup duties, including security setup. This user is intended for technical superusers.</td>
</tr>
<tr>
<td>HCMUser</td>
<td>Performs functional setup duties. This user is intended for users who are performing the Oracle HCM Cloud implementation steps.</td>
</tr>
</tbody>
</table>

Additional implementation users may be useful, depending on the size of the enterprise and the structure of the implementation team. For example:

- An application implementation manager can assign implementation tasks to other implementation users. This implementation user has the Application Implementation Manager job role.
- A product family application administrator can perform implementation tasks for a specific product. This approach may be of interest if you’re implementing multiple Oracle Fusion products and want an implementor for each product.
Tip: The Human Capital Management Application Administrator job role can access only HCM setup tasks. The Application Implementation Consultant job role can access all Oracle Fusion Applications setup tasks.

Creating HCM Implementation Users: Overview

As the service administrator for the Oracle HCM Cloud service, you’re sent sign-in details when your environments are provisioned. This topic summarizes how to access the service for the first time and set up implementation users to perform the implementation. You must complete these steps before you release the environment to your implementation team.

You’re recommended to create implementation users in the test environment first. Migrate your implementation to the production environment only after you have validated it. With this approach, the implementation team can learn how to implement security before setting up application users in the production environment.

Accessing the Oracle HCM Cloud Service

The welcome or service-activation email from Oracle provides the service URLs, user name, and temporary password for the test or production environment. Refer to the email for the environment that you’re setting up. The Identity Domain value is the environment name. For example, HCMA could be the production environment and HCMA-TEST could be the test environment.

Sign in to the test or production Oracle HCM Cloud service using the service home URL from the welcome or service-activation email. The URL ends with either AtkHomePageWelcome or HcmFusionHome.

When you sign in for the first time, use the password from the welcome or service-activation email. You’re prompted to change the password. Make a note of the new password, which is the service administrator password for subsequent access to the service. You’re recommended not to share your sign-in details with other users.

Creating Implementation Users

This table summarizes the process of creating implementation users and assigning roles to them.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task or Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run User and Roles Synchronization Process</td>
<td>You run the process Retrieve Latest LDAP Changes to copy data from your LDAP directory server to Oracle HCM Cloud.</td>
</tr>
<tr>
<td>2</td>
<td>Import Users and Roles into Application Security</td>
<td>You perform this task to initialize the Oracle Fusion Applications Security tables.</td>
</tr>
<tr>
<td>3</td>
<td>Create Implementation Users</td>
<td>You create the TechAdmin and HCMUser implementation users and assign required job roles to them if these users don’t already exist in your environment.</td>
</tr>
</tbody>
</table>
Creating Implementation Users

<table>
<thead>
<tr>
<th>Step</th>
<th>Task or Activity</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | Create Data Roles for Implementation Users | To enable implementation users to access HCM data, you create the following data roles:  
- HRAnalyst_ViewAll  
- HCMApplicationAdministrator_ViewAll  
- HR_Specialist_ViewAll  
You create additional data roles if you have licensed the Oracle Fusion Workforce Compensation Cloud Service or the Oracle Fusion Global Payroll Cloud Service. |
| 5    | Assign Security Profiles to Abstract Roles | Enable basic data access for the predefined Employee, Contingent Worker, and Line Manager abstract roles.  
You perform this task at this stage of the implementation so that implementation users with abstract roles have the required data access. However, all application users with abstract roles also benefit from this step. |
| 6    | Create a Generic Role Mapping for HCM Data Roles | Enable the HCM data roles created in step 4 to be provisioned to implementation users. |
| 7    | Assign Abstract and Data Roles to the HCMUser Implementation User | Assign roles to the HCMUser implementation user that enable functional implementation to proceed. |
| 8    | Verify HCMUser Access | Confirm that the HCMUser implementation user can access the functions enabled by the assigned roles. |

Reset your service administrator password after completing these steps.

Synchronizing User and Role Information: Procedure

You run the process Retrieve Latest LDAP Changes once during implementation. This process copies data from the LDAP directory to the Oracle Fusion Applications Security tables. Thereafter, the data is synchronized automatically. To run this process, perform the task Run User and Roles Synchronization Process as described in this topic.
Running the Retrieve Latest LDAP Changes Process

Follow these steps:

1. Sign in to your Oracle Applications Cloud service environment as the service administrator.
2. In the Setup and Maintenance work area, go to the following for your offering:
   - Functional Area: Initial Users
   - Task: Run User and Roles Synchronization Process

   On the process submission page for the Retrieve Latest LDAP Changes process:

3. Click Submit.
4. Click OK to close the confirmation message.

Importing Users and Roles into Applications Security: Procedure

To implement security, you must use the Security Console. Before you can use the Security Console, you must initialize the Oracle Fusion Applications Security tables with existing user and role information. To initialize these tables, you perform the Import Users and Roles into Application Security task. This topic describes how to perform this task.

Running the Import User and Role Application Security Data Process

Sign in as the Oracle HCM Cloud service administrator and follow these steps:

1. In the Setup and Maintenance work area, go to the following for your offering:
   - Functional Area: Initial Users
   - Task: Import Users and Roles into Application Security

2. On the Import Users and Roles into Application Security page, click Submit.

The Import User and Role Application Security Data process starts. When the process completes, you can use the Security Console.

Note: You’re recommended to schedule this process to run daily after your implementation users exist.

Related Topics

- Scheduling the Import User and Role Application Security Data Process: Procedure
Creating the TechAdmin Implementation User: Procedure

This topic describes how to create the TechAdmin implementation user and assign roles to the user.

Creating the TechAdmin Implementation User

Sign in as the Oracle HCM Cloud service administrator and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Initial Users
   - Task: Create Implementation Users
3. Complete the fields on the Add User Account page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Person Type</td>
<td>None</td>
</tr>
<tr>
<td>Last Name</td>
<td>TechAdmin</td>
</tr>
<tr>
<td>Email</td>
<td>A valid email for the user</td>
</tr>
<tr>
<td>User Name</td>
<td>TechAdmin</td>
</tr>
<tr>
<td>Password</td>
<td>Any value that complies with the password policy</td>
</tr>
</tbody>
</table>

To view the password policy, click the Help icon by the Password field.

*Note:* Make a note of the password. The user who first signs in as TechAdmin must change the password.

Assigning Roles to TechAdmin

To assign job roles to the TechAdmin implementation user, follow these steps:

1. In the Roles section of the Add User Account page, click Add Role.
2. In the Add Role Membership dialog box, search for the IT Security Manager job role.
3. In the search results, select the role and click Add Role Membership.
4. Click OK to close the Confirmation dialog box.
5. Repeat from step 2 to add each of the following job roles to the TechAdmin user:
   - Application Implementation Consultant
   - Application Diagnostics Administrator
Four job roles now appear in the Roles section of the Add User Account page.

6. Click **Save and Close**.

**Note:** Application Implementation Consultant is a powerful role that has unrestricted access to a large amount of data. Once the implementation is complete, you’re recommended to revoke this role from all users using the Revoke Data Role from Implementation Users task. For ongoing maintenance of Oracle HCM Cloud setup data, use a less powerful role. For example, use an HCM data role based on the Human Capital Management Application Administrator role.

---

### Creating the HCMUser Implementation User: Procedure

This topic explains how to create the HCMUser implementation user and assign roles to the user.

#### Creating the HCMUser Implementation User

Sign in as the Oracle HCM Cloud service administrator and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Initial Users
   - Task: Create Implementation Users
2. On the User Accounts page of the Security Console, click **Add User Account**.
3. Complete the fields on the Add User Account page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Person Type</td>
<td>None</td>
</tr>
<tr>
<td>Last Name</td>
<td>HCMUser</td>
</tr>
<tr>
<td>Email</td>
<td>A valid email for the user</td>
</tr>
<tr>
<td>User Name</td>
<td>HCMUser</td>
</tr>
<tr>
<td>Password</td>
<td>Any value that complies with the password policy</td>
</tr>
</tbody>
</table>

To view the password policy, click the **Help** icon by the **Password** field.

**Note:** Make a note of the password. The user who first signs in as HCMUser must change the password.
Assigning Roles to HCMUser

To assign job roles to the HCMUser implementation user, follow these steps:

1. In the Roles section of the Add User Account page, click Add Role.
2. In the Add Role Membership dialog box, search for the Application Administrator job role.
3. In the search results, select the role and click Add Role Membership.
4. Click OK to close the Confirmation dialog box.
5. Repeat from step 2 to add each of the following job roles to the HCMUser user:
   - Application Implementation Consultant
   - Application Diagnostics Regular User
   - Application Diagnostics Viewer

Four job roles now appear in the Roles section of the Add User Account page.

6. Click Save and Close.

Note: Application Implementation Consultant is a powerful role that has unrestricted access to a large amount of data. Once the implementation is complete, you’re recommended to revoke this role from all users using the Revoke Data Role from Implementation Users task. For ongoing maintenance of Oracle HCM Cloud setup data, use a less powerful role. For example, use an HCM data role based on the Human Capital Management Application Administrator role.
3 Creating HCM Data Roles for Implementation Users

Overview

You create HCM data roles to enable the HCMUser implementation user to access HCM data and complete the functional implementation. This topic introduces the HCM data roles that you must create.

Create the following HCM data roles:

- HRAnalyst_ViewAll
- HCMApplicationAdministrator_ViewAll
- HRSpecialist_ViewAll

If you have licensed the Oracle Fusion Workforce Compensation Cloud Service, then you need also to create the following HCM data roles:

- CompensationAdmin_ViewAll
- CompensationMgr_ViewAll

If you have licensed the Oracle Fusion Global Payroll Cloud Service, then you need also to create the following HCM data roles:

- PayrollAdmin_ViewAll
- PayrollMgr_ViewAll

Creating the HRAnalyst_ViewAll Data Role: Procedure

This topic describes how to create the HRAnalyst_ViewAll data role. This role is one of several that the HCMUser implementation user must have to complete the functional implementation.

Creating the HRAnalyst_ViewAll Data Role

Sign in as the TechAdmin user. If this is the first use of this user name, then you’re prompted to change the password. You use the new password whenever you sign in as this user subsequently.

Follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role
2. In the Search Results section of the Manage Data Roles and Security Profiles page, click Create.
3. Complete the fields on the Create Data Role: Select Role page as shown in the following table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role Name</td>
<td>HRAnalyst_ViewAll</td>
</tr>
<tr>
<td>Job Role</td>
<td>Human Resource Analyst</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. In the sections of the Create Data Role: Security Criteria page, select the predefined security profiles shown in this table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Security Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Legislative Data Group</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Public Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Document Type</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll Flow</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

6. Click **Review**.
7. On the Create Data Role: Review page, click **Submit**.
8. On the Manage Data Roles and Security Profiles page, search for the HRAnalyst_ViewAll data role to confirm that it exists.

Creating the HCMAplicationAdministrator_ViewAll Data Role: Procedure

This topic describes how to create the HCMAplicationAdministrator_View All data role. This role is one of several that the HCMUser implementation user must have to complete the functional implementation.

Creating the HCMAplicationAdministrator_ViewAll Data Role

If you’re already on the Manage Data Roles and Security Profiles page, then follow this procedure from step 2. Otherwise, sign in as the TechAdmin user and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
Creating HCM Data Roles for Implementation Users

Creating HRSpecialist_ViewAll Data Role: Procedure

This topic describes how to create the HRSpecialist_ViewAll data role. This role is one of several that the HCMUser implementation user must have to complete the functional implementation.
Creating the HRSpecialist_ViewAll Data Role

If you’re already on the Manage Data Roles and Security Profiles page, then follow this procedure from step 2. Otherwise, sign in as the TechAdmin user and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role

2. In the Search Results section of the Manage Data Roles and Security Profiles page, click **Create**.
3. Complete the fields on the Create Data Role: Select Role page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role Name</td>
<td>HRSpecialist_ViewAll</td>
</tr>
<tr>
<td>Job Role</td>
<td>Human Resource Specialist</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. In the sections of the Create Data Role: Security Criteria page, select the predefined security profiles shown in this table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Security Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Countries</td>
<td>View All Countries</td>
</tr>
<tr>
<td>Legislative Data Group</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Public Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Document Type</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll</td>
<td>View All Payrolls</td>
</tr>
<tr>
<td>Payroll Flow</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

6. Click **Review**.
7. On the Create Data Role: Review page, click **Submit**.
8. On the Manage Data Roles and Security Profiles page, search for the HRSpecialist_ViewAll data role to confirm that it exists.
Creating HCM Data Roles for Workforce Compensation Implementation Users: Procedure

If you have licensed the Oracle Fusion Workforce Compensation Cloud Service, then you create the following HCM data roles:

- CompensationAdmin_ViewAll
- CompensationMgr_ViewAll

This topic explains how to create these roles by performing the Assign Security Profiles to Role task.

Creating the CompensationAdmin_ViewAll Data Role

If you’re already on the Manage Data Roles and Security Profiles page, then follow this procedure from step 2. Otherwise, sign in as the TechAdmin user and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role

2. In the Search Results section of the Manage Data Roles and Security Profiles page, click Create.

3. Complete the fields on the Create Data Role: Select Role page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role Name</td>
<td>CompensationAdmin_ViewAll</td>
</tr>
<tr>
<td>Job Role</td>
<td>Compensation Administrator</td>
</tr>
</tbody>
</table>

4. Click Next.

5. In the sections of the Create Data Role: Security Criteria page, select the predefined security profiles shown in this table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Security Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Legislative Data Group</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Payroll</td>
<td>View All Payrolls</td>
</tr>
<tr>
<td>Payroll Flow</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>
6. Click **Review**.
7. On the Create Data Role: Review page, click **Submit**.
8. On the Manage Data Roles and Security Profiles page, search for the CompensationAdmin_ViewAll data role to confirm that it exists.

### Creating the CompensationMgr_ViewAll Data Role

Follow these steps:

1. In the Search Results section of the Manage Data Roles and Security Profiles page, click **Create**.
2. Complete the fields on the Create Data Role: Select Role page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Role Name</strong></td>
<td>CompensationMgr_ViewAll</td>
</tr>
<tr>
<td><strong>Job Role</strong></td>
<td>Compensation Manager</td>
</tr>
</tbody>
</table>

3. Click **Next**.
4. In the sections of the Create Data Role: Security Criteria page, select the predefined security profiles shown in this table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Security Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organization</strong></td>
<td>View All Organizations</td>
</tr>
<tr>
<td><strong>Position</strong></td>
<td>View All Positions</td>
</tr>
<tr>
<td><strong>Countries</strong></td>
<td>View All Countries</td>
</tr>
<tr>
<td><strong>Legislative Data Group</strong></td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td><strong>Person</strong></td>
<td>View All People</td>
</tr>
<tr>
<td><strong>Public Person</strong></td>
<td>View All People</td>
</tr>
<tr>
<td><strong>Document Type</strong></td>
<td>View All Document Types</td>
</tr>
<tr>
<td><strong>Payroll Flow</strong></td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

5. Click **Review**.
6. On the Create Data Role: Review page, click **Submit**.
7. On the Manage Data Roles and Security Profiles page, search for the CompensationMgr_ViewAll data role to confirm that it exists.
Creating HCM Data Roles for Global Payroll Implementation Users: Procedure

If you have licensed the Oracle Fusion Global Payroll Cloud Service, then you create the following HCM data roles:

- PayrollAdmin_ViewAll
- PayrollMgr_ViewAll

This topic explains how to create these roles using the Assign Security Profiles to Role task.

Creating the PayrollAdmin_ViewAll Data Role

If you’re already on the Manage Data Roles and Security Profiles page, then follow this procedure from step 2. Otherwise, sign in as the TechAdmin user and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role
2. In the Search Results section of the Manage Data Roles and Security Profiles page, click Create.
3. Complete the fields on the Create Data Role: Select Role page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role Name</td>
<td>PayrollAdmin_ViewAll</td>
</tr>
<tr>
<td>Job Role</td>
<td>Payroll Administrator</td>
</tr>
</tbody>
</table>

4. Click Next.
5. In the sections of the Create Data Role: Security Criteria page, select the predefined security profiles shown in this table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Security Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Legislative Data Group</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Document Type</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll</td>
<td>View All Payrolls</td>
</tr>
</tbody>
</table>
Creating the PayrollMgr_ViewAll Data Role

Follow these steps:

1. In the Search Results section of the Manage Data Roles and Security Profiles page, click Create.
2. Complete the fields on the Create Data Role: Select Role page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role Name</td>
<td>PayrollMgr_ViewAll</td>
</tr>
<tr>
<td>Job Role</td>
<td>Payroll Manager</td>
</tr>
</tbody>
</table>

3. Click Next.
4. In the sections of the Create Data Role: Security Criteria page, select the predefined security profiles shown in this table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Security Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Legislative Data Group</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person</td>
<td>View All People</td>
</tr>
<tr>
<td>Document Type</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll</td>
<td>View All Payrolls</td>
</tr>
<tr>
<td>Payroll Flow</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

5. Click Review.
6. On the Create Data Role: Review page, click Submit.
7. On the Manage Data Roles and Security Profiles page, search for the PayrollMgr_ViewAll data role to confirm that it exists.
4 Enabling Basic Data Access for Abstract Roles

Assigning Security Profiles to Abstract Roles: Explained

These abstract roles are predefined in Oracle HCM Cloud:

- Employee
- Contingent Worker
- Line Manager

Users with these roles can sign in and open application pages. However, they have no automatic access to data. For example, employees can open the Directory but their searches return no results. Line managers can access My Team functions but can't see data for their organizations. To enable basic HCM data access for users with abstract roles, you assign security profiles directly to those roles.

Predefined Security Profiles to Assign to Abstract Roles

This table identifies the predefined security profiles that you can assign directly to the Employee, Line Manager, and Contingent Worker abstract roles.

<table>
<thead>
<tr>
<th>Security Profile Type</th>
<th>Employee</th>
<th>Contingent Worker</th>
<th>Line Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person</td>
<td>View Own Record</td>
<td>View Own Record</td>
<td>View Manager Hierarchy</td>
</tr>
<tr>
<td>Public person</td>
<td>View All Workers</td>
<td>View All Workers</td>
<td>View All Workers</td>
</tr>
<tr>
<td>Organization</td>
<td>View All Organizations</td>
<td>View All Organizations</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position</td>
<td>View All Positions</td>
<td>View All Positions</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Legislative data group</td>
<td>View All Legislative Data Groups</td>
<td>View All Legislative Data Groups</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Country</td>
<td>View All Countries</td>
<td>View All Countries</td>
<td>View All Countries</td>
</tr>
<tr>
<td>Document type</td>
<td>View All Document Types</td>
<td>View All Document Types</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>View All Payrolls</td>
</tr>
<tr>
<td>Payroll flow</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

After implementation, you may want to change aspects of this data access. For example, you may want to create your own security profiles and assign those directly to abstract roles.
Note: Such changes apply to all users who have the abstract role.

HCM Data Roles

Users who have abstract roles are likely to gain additional data access from the HCM data roles that you define for their job roles. For example, you may create an HCM data role for benefits representatives to access person records in a legal employer. Such data access is in addition to any access provided by abstract roles.

Assigning Security Profiles to Abstract Roles: Worked Example

To enable basic data access for the predefined Employee, Contingent Worker, and Line Manager abstract roles, you assign predefined security profiles to them during implementation. This example shows how to assign security profiles to abstract roles using the Assign Security Profiles to Role task.

Searching for the Employee Abstract Role

1. Sign in as the TechAdmin user or another user with the IT Security Manager job role or privileges.
2. In the Setup and Maintenance work area, go to the following for your offering:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role
3. On the Manage Data Roles and Security Profiles page, enter Employee in the Role field. Click Search.
4. In the Search Results section, select the predefined Employee role and click Edit.

Assigning Security Profiles to the Employee Abstract Role

1. On the Edit Data Role: Role Details page, click Next.
2. On the Edit Data Role: Security Criteria page, select the security profiles shown in the following table. You may see a subset of these security profiles, depending on the combination of cloud services that you’re implementing.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Security Profile</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position Security Profile</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Country Security Profile</td>
<td>View All Countries</td>
</tr>
<tr>
<td>LDG Security Profile</td>
<td>View All Legislative Data Groups</td>
</tr>
</tbody>
</table>
Field | Value
--- | ---
Person Security Profile (Person section) | View Own Record
Person Security Profile (Public Person section) | View All Workers
Document Type Security Profile | View All Document Types

3. Click **Review**.
4. On the Edit Data Role: Review page, click **Submit**.
5. On the Manage Data Roles and Security Profiles page, search again for the predefined Employee role.
6. In the Search Results region, confirm that the **Assigned** icon appears in the **Security Profiles** column for the Employee role.

The **Assigned** icon, a check mark, confirms that security profiles are assigned to the role.

Repeat the steps in Searching for the Employee Abstract Role and Assigning Security Profiles to the Employee Abstract Role for the predefined Contingent Worker role.

**Searching for the Line Manager Abstract Role**

1. On the Manage Data Roles and Security Profiles page, enter Line Manager in the **Role** field. Click **Search**.
2. In the Search Results section, select the predefined Line Manager role and click **Edit**.

**Assigning Security Profiles to the Line Manager Abstract Role**

1. On the Edit Data Role: Role Details page, click **Next**.
2. On the Edit Data Role: Security Criteria page, select the security profiles shown in the following table. You may see a subset of these security profiles, depending on the combination of cloud services that you're implementing.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Security Profile</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position Security Profile</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Country Security Profile</td>
<td>View All Countries</td>
</tr>
<tr>
<td>LDG Security Profile</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person Security Profile (Person section)</td>
<td>View Manager Hierarchy</td>
</tr>
<tr>
<td>Person Security Profile (Public Person section)</td>
<td>View All Workers</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Document Type Security Profile</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll</td>
<td>View All Payrolls</td>
</tr>
<tr>
<td>Payroll Flow</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

3. Click **Review**.
4. On the Edit Data Role: Review page, click **Submit**
5. On the Manage Data Roles and Security Profiles page, search again for the predefined Line Manager role.
6. In the search results, confirm that the **Assigned** icon appears in the **Security Profiles** column for the Line Manager role.

The **Assigned** icon confirms that security profiles are assigned to the role.
5 Assigning Roles to Implementation Users

Creating a Role Mapping for HCM Implementation Data Roles: Procedure

You create a role mapping to enable you to provision the implementation data roles to implementation users, such as HCMUser. This topic describes how to create the role mapping.

Creating the Role Mapping

Sign in as the TechAdmin user.

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Manage Role Provisioning Rules
2. In the Search Results section of the Manage Role Mappings page, click Create.
   The Create Role Mapping page opens.
3. In the Mapping Name field, enter Requestable Roles.
4. In the Conditions section, set HR Assignment Status to Active.
5. In the Associated Roles section, add a row.
6. In the Role Name field, search for and select the HRAnalyst_ViewAll HCM data role.
7. Select the Requestable option.
   Ensure that the Self-Requestable and Autoprovision options aren’t selected.

   \[\text{Note:}\] If Autoprovision is selected automatically, then deselect it.
8. Repeat steps 6 and 7 for these roles:
   - HCMAppliactionAdministrator_ViewAll
   - HRSpecialist_ViewAll
9. If you created any of the following roles, then repeat steps 6 and 7 for each one:
   - CompensationAdmin_ViewAll
   - CompensationMgr_ViewAll
   - PayrollAdmin_ViewAll
   - PayrollMgr_ViewAll
10. Click Save and Close. On the Manage Role Mappings page, click Done.

   \[\text{Note:}\] When your implementation is complete, you’re recommended to delete this role mapping to prevent application users from provisioning these roles.
Assigning Abstract and Data Roles to HCMUser: Procedure

The implementation user HCMUser has some job roles that were assigned when the user was created. This topic explains how to assign abstract and HCM data roles to enable HCMUser to complete the functional implementation.

Editing HCMUser

Follow these steps:

1. Sign in as the TechAdmin user.
2. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Initial Users
   - Task: Create Implementation Users
4. In the search results, click the user name to open the User Account Details page.

   These roles appear in the list of roles already assigned to HCMUser:
   - All Users
   - Application Administrator
   - Application Implementation Consultant
   - Application Diagnostics Regular User
   - Application Diagnostics Viewer

5. Click Edit.

Assigning Roles to HCMUser

Follow these steps:

1. In the Roles section of the User Account Details page, click Add Role.
2. In the Add Role Membership dialog box, search for the predefined Employee abstract role.
3. In the search results, select the role and click Add Role Membership.
4. Click OK to close the Confirmation dialog box.
5. Repeat from step 2 to add these abstract and HCM data roles to HCMUser:
   - Contingent Worker
   - Line Manager
   - HRSpecialist_ViewAll
   - HRAnalyst_ViewAll
   - HCMApplicationAdministrator_ViewAll

If you have licensed the relevant cloud services and created these HCM data roles, then add them to HCMUser:
   - CompensationAdmin_ViewAll
   - CompensationMgr_ViewAll
Assigning Roles to Implementation Users

- PayrollAdmin_ViewAll
- PayrollMgr_ViewAll

HCMUser now has between 11 and 15 roles, depending on the cloud services that you have licensed.

Tip: If you add a role by mistake, you can select it and click Delete.

6. Click Save and Close.

Verifying HCMUser Access: Procedure

This topic explains how to verify that the HCMUser implementation user can access the functions enabled by the assigned roles.

1. Sign in using the HCMUser user name and password.

As this is the first use of this user name, you're prompted to change the password. HCMUser uses the new password to sign in subsequently.

2. Open the Navigator. In the Navigator, verify that:

- Entries such as Career Development, Goals, and Performance appear under My Client Groups, if you use Talent Management.
- The Compensation entry appears under My Client Groups, if you use Compensation Management.
- The Payroll entries appear under Payroll, if you use Global Payroll.

3. Sign out.

Tip: You can also use the Security Console to verify user access. On the Roles tab, search for HCMUser. In the search results, select the user, right-click, and select Simulate Navigator. In the simulated navigator, any entry without a lock icon is available to the user.

HCMUser can now complete the functional implementation of Oracle HCM Cloud.

Resetting the Cloud Service Administrator Sign-In Details: Procedure

After setting up your implementation users, you can reset the service administrator sign-in details for your Oracle Applications Cloud service. You reset these details to avoid problems later when you're loaded to the service as an employee. This topic describes how to reset the service administrator sign-in details.
Resetting the Service Administrator Sign-In Details

Sign in to your Oracle Applications Cloud service using the TechAdmin user name and password and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Initial Users
   - Task: Create Implementation Users
2. On the User Accounts page of the Security Console, search for your service administrator user name, which is typically your email. Your service activation mail contains this value.
3. In the search results, click your service administrator user name to open the User Account Details page.
4. Click Edit.
5. Change the User Name value to ServiceAdmin.
6. Delete any value in the First Name field.
7. Change the value in the Last Name field to ServiceAdmin.
8. Delete the value in the Email field.
9. Click Save and Close.
10. Sign out of your Oracle Applications Cloud service.

After making these changes, you use the user name ServiceAdmin when signing in as the service administrator.
6 Setting Up Applications Security

Defining Security Synchronization Processes and Preferences: Overview

During implementation the TechAdmin user, who has the IT Security Manager job role, performs the tasks in the Initial Users functional area. This topic introduces some of these tasks. They’re described in more detail in this chapter.

Manage Applications Security Preferences

This task opens the Administration tab of the Security Console.

On the General subtab of the Security Console Administration tab, you:

- Define the default format of user names for the enterprise.
- Set the enterprise password policy.
- Specify for how long certificates remain valid by default. Certificates establish keys for the encryption and decryption of data that Oracle HCM Cloud exchanges with other applications.
- Specify how often a warning appears to remind Security Console users to import latest user and role information.
- Indicate whether users who have the IT Security Manager or IT Auditor job role can reset passwords manually.

On the Roles subtab of the Security Console Administration tab, you:

- Specify default prefix and suffix values for copied roles.
- Specify a limit to the number of nodes that can appear in graphical representations of roles on the Roles tab of the Security Console.
- Specify whether hierarchies on the Roles tab appear in graphical or tabular format by default.
- Manage editing of user-role memberships.
- Manage editing of data security policies.

On the Bridge for Active Directory subtab of the Security Console Administration tab, you configure the bridge for Microsoft Active Directory.

On the User Categories tab of the Security Console, you:

- Create user categories.
- Add users to user categories.
- Manage the notification of user and password events to users in a selected user category.
- Create notification templates for a selected user category.
Import Users and Roles into Application Security

This task runs a process that initializes and maintains the Oracle Fusion Applications Security tables. You’re recommended to schedule this process to run daily.

Import User Login History

This task runs a process that imports the history of user access to Oracle Fusion Applications. This information is required by the Inactive Users Report.

Defining the Default User-Name Format: Explained

During implementation, you specify the default format of user names for the enterprise. This topic describes the available formats. To select a format, you perform the Manage Applications Security Preferences task, which opens the General subtab of the Security Console Administration tab. In the User Preferences section of this subtab, you select a user-name format. You can also change the enterprise format at any time on the Security Console.

User-Name Formats

This table describes the available user-name formats.

<table>
<thead>
<tr>
<th>User-Name Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email</strong></td>
<td>The work email (or party email, for party users) is the user name. For example, the user name for <a href="mailto:john.smith@example.com">john.smith@example.com</a> is <a href="mailto:john.smith@example.com">john.smith@example.com</a>. To make duplicate names unique, a number is added. For example, <a href="mailto:john.smith2@example.com">john.smith2@example.com</a> may be used if <a href="mailto:john.smith@example.com">john.smith@example.com</a> and <a href="mailto:john.smith1@example.com">john.smith1@example.com</a> already exist. Email is the default format.</td>
</tr>
<tr>
<td><strong>FirstName.LastName</strong></td>
<td>The user name is the worker’s first and last names separated by a single period. For example, the user name for John Frank Smith is john.smith. To make duplicate names unique, either the user’s middle name or a random character is used. For example, John Smith’s user name could be john.frank.smith or john.x.smith.</td>
</tr>
<tr>
<td><strong>FirstName.LastName</strong></td>
<td>The user name is the worker’s last name prefixed with the initial of the worker’s first name. For example, the user name for John Smith is jsmith.</td>
</tr>
<tr>
<td><strong>Person or party number</strong></td>
<td>The party number or person number is the user name. If your enterprise uses manual person numbering, then any number that’s entered during the hiring process becomes the user name. Otherwise, the number is generated automatically and can’t be edited. The automatically generated number becomes the user name. For example, if John Smith’s person number is 987654, then the user name is 987654.</td>
</tr>
</tbody>
</table>

If you select a different user-name rule, then click **Save**. The change takes effect immediately.
System User Names

The selected user-name rule may fail. For example, a person’s party number, person number, or email may not be available when the user account is requested. In this case, a system user name is generated by applying these options in the following order until a unique user name is defined:

1. Email
2. FirstName.LastName
3. If only the last name is available, then a random character is prefixed to the last name.

The Security Console option **Generate system user name when generation rule fails** controls whether a system user name is generated. You can disable this option. In this case, an error is raised if the user name can’t be generated in the selected format.

**Tip:** If a system user name is generated, then it can be edited later to specify a preferred value.

Editing User Names

Human resource (HR) specialists and line managers can enter user names in any format to override default user names when hiring workers. HR specialists can also edit user names for individual users on the Edit User and Manage User Account pages. The maximum length of the user name is 80 characters.

Work Email

The line manager or HR specialist may omit the work email when hiring the worker. In this case, the email can’t be added later by editing the worker details. However, you can edit the user on the Security Console and enter the email there. To use work email as the user name after a different user name has been generated, edit the existing user name.

Setting Password Policy: Explained

During implementation, you set the password policy for the enterprise. This topic describes the available options. To set the password policy, you perform the Manage Applications Security Preferences task, which opens the General subtab of the Security Console Administration tab. In the Password Policy section of this subtab, you select appropriate values. You can also change the enterprise policy at any time on the Security Console.

Password Policy Options

This table describes the available options for setting password policy.

<table>
<thead>
<tr>
<th>Password-Policy Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days Before Password Expiration</td>
<td>Specifies the number of days for which a password remains valid. After this period, users must reset their passwords. By default, users whose passwords expire must follow the Forgot Password process.</td>
<td>90</td>
</tr>
</tbody>
</table>
## Password-Policy Option

<table>
<thead>
<tr>
<th>Password-Policy Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days Before Password Expiry Warning</td>
<td>Specifies when a user is notified that a password is about to expire. By default, users are prompted to sign in and change their passwords. This value must be equal to or less than the value of the Days Before Password Expiration option.</td>
<td>80</td>
</tr>
<tr>
<td>Hours Before Password Reset Token Expiration</td>
<td>When users request a password reset, they’re sent a password-reset link. This option specifies how long a reset-password link remains active. If the link expires before the password is reset, then reset must be requested again. You can enter any value between 1 and 9999.</td>
<td>4</td>
</tr>
<tr>
<td>Password Complexity</td>
<td>Specifies whether passwords must be simple, complex, or very complex. Password validation rules identify passwords that fail the selected complexity test.</td>
<td>Simple</td>
</tr>
<tr>
<td>Disallow last password</td>
<td>Select to ensure that the new password is different from the last password.</td>
<td>No</td>
</tr>
<tr>
<td>Administrator can manually reset password</td>
<td>Passwords can be either generated automatically or reset manually by the IT Security Manager or IT Auditor. Select this option to allow user passwords to be reset manually. All passwords, whether reset manually or generated automatically, must satisfy the current complexity rule.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Note: This value is 10 for new installations from Release 18B.*

## Password Expiry Report

The Password Expiry Report sends the password-expiration-warning and password-expired notifications. You must schedule the Password Expiry Report to run daily. To schedule the report:

1. In the Scheduled Processes work area, click **Schedule New Process**.
2. In the **Schedule Process** dialog box, search for and select the Password Expiry Report process.
3. Click **OK**.
4. In the **Process Details** dialog box, click **Advanced**.
5. On the Schedule tab, set **Run** to **Using a schedule**.
6. Select a **Frequency** value. For example, select **Daily**.
7. Select a start date and time.
8. Click **Submit**.

*Note: Users are notified when passwords are about to expire, have already expired, or have been reset only if appropriate notification templates are enabled. The predefined notification templates for these events are Password Expiry Warning Template, Password Expiration Template, and Password Reset Template.*
Setting Role Preferences: Explained

During implementation, you set default role preferences for the enterprise. This topic describes the role preferences and their effects. To set role preferences, you perform the Manage Applications Security Preferences task, which opens the General subtab of the Security Console Administration tab. From there, click the Roles subtab. You can also set role preferences at any time on the Security Console.

Copied-Role Names

To create roles, you're recommended to copy predefined roles and edit the copied roles. When you copy a predefined role:

- The ORA_ prefix, which identifies predefined roles, is removed automatically from the role code of the copied role.
- The enterprise prefix and suffix values are added automatically to the role name and code of the copied role.

You specify enterprise prefix and suffix values on the Roles subtab of the Security Console Administration tab. By default:

- Prefix values are blank.
- The role-name suffix is Custom.
- The role-code suffix is _CUSTOM.

For example, if you copy the Benefits Administrator job role (ORA_BEN_BENEFITS_ADMINISTRATOR_JOB), then the default name and code of the copied role are:

- Benefits Administrator Custom
- BEN_BENEFITS_ADMINISTRATOR_JOB_CUSTOM

You can supply prefix values and change the suffix values, as required. If you change these values, then click Save. The changes take effect immediately.

Graph Nodes and Default Views

On the Roles tab of the Security Console, you can display role hierarchies. By default, these hierarchies appear in tabular format. To use graphical format by default, deselect the Enable default table view option on the Roles subtab of the Security Console Administration tab.

When role hierarchies appear on the Roles tab, the number of nodes can be very high. To limit the number of nodes in the graphical view, set the Graph Node Limit option on the Roles subtab of the Security Console Administration tab. When you display a role hierarchy with more nodes than the specified limit, you're recommended to switch to the tabular format.

Data Security Policies and User Role Membership

By default, when creating or editing roles on the Security Console, you can manage their data security policies and assign the roles directly to users. These actions are controlled by the following options on the Roles subtab of the Security Console Administration tab:

- Enable edit of data security policies
- Enable edit of user role membership

Oracle HCM Cloud customers are recommended to disable these options. You're unlikely to have to edit data security policies directly, as they're generated automatically when you include security profiles in HCM data roles. If necessary, you
can regenerate HCM data roles and abstract roles to which security profiles are assigned. For example, if you edit the security profiles in an HCM data role, then you regenerate the role to regenerate its data security policies.

To manage the automatic provisioning of roles to users, you create role mappings. Manual provisioning of roles to application users on the Security Console isn’t recommended.

Related Topics

- Copying HCM Roles: Points to Consider
- Role Provisioning and Deprovisioning: Explained
- Regenerating Roles: Explained

User Categories: Explained

You can categorize and segregate users based on the various functional and operational requirements. A user category provides you with an option to group a set of users such that the specified settings apply to everyone in that group. Typical scenarios in which you may want to group users are:

- Users belong to different organizations within an enterprise and each organization follows a different user management policy.
- Practices related to resetting passwords are not uniform across users.
- Users have different preferences in receiving automated notifications for various tasks they perform in the application.

On the Security Console page, click the User Category tab. You can perform the following tasks:

- Segregate users into categories
- Specify Next URL
- Enable notifications

Segregate Users into Categories

Create user categories and add existing users to them. All existing users are automatically assigned to the Default user category unless otherwise specified. You may create more categories depending upon your requirement and assign users to those categories.

Note: You can assign a user to only one category.

Specify Next URL

Specify a URL to redirect your users to a website or an application instead of going back to the Sign In page, whenever they reset their password. For example, a user places a password reset request and receives an Email for resetting the password. After the new password is authenticated, the user can be directed to a website or application. If nothing is specified, the user is directed to Oracle Applications Cloud Sign In page. You can specify only one URL per user category.

Enable Notifications

By default, notifications are enabled but you can enable or disable the sending of notifications to users, based on their preferences. To achieve this, you can enable or disable notifications separately for each user category. If users belonging to
a specific category don’t want to receive any notification, you can disable notifications for all life cycle events. Alternatively, if users want to receive notifications only for some events, you can selectively enable the functionality for those events.

Notifications are sent for a set of predefined events. To trigger a notification, you must create a notification template and map it to the required event. Depending on the requirement, you can add or delete a template that is mapped to a particular event.

**Note:** You can’t edit or delete predefined notification templates that begin with the prefix ORA. You can only enable or disable them. However, you can update or delete the user-defined templates. User Category feature supports both SCIM protocol and HCM Data Loader for performing any bulk updates.

**Related Topics**
- Using REST API to Add Users to a User Category

### Adding Users to a User Category: Procedures

Using the Security Console, you can add existing users to an existing user category or create a new category and add them. When you create new users, they are automatically assigned to the default category. At a later point, you can edit the user account and update the user category. You can assign a user to only one category.

**Note:** If you are creating new users using Security Console, you can also assign a user category at the time of creation.

You can add users to a user category in three different ways:

- Create a user category and add users to it
- Add users to an existing user category
- Specify the user category for an existing user

**Note:** You can create and delete a user category only using the Security Console. Once the required user categories are available in the application, you can use them in SCIM REST APIs and data loaders. You can’t rename a user category.

### Adding Users to a New User Category

To create a user category and add users:

1. On the Security Console, click **User Categories > Create**.
2. Click **Edit**, specify the user category details, and click **Save and Close**.
3. Click the Users tab and click **Edit**.
4. On the Users Category: Users page, click **Add**.
5. In the Add Users dialog box, search for and select the user, and click **Add**.
6. Repeat adding users until you have added the required users and click **Done**.
7. Click **Done** on each page until you return to the User Categories page.
Adding Users to an Existing User Category

To add users to an existing user category:

1. On the Security Console, click **User Categories** and click an existing user category to open it.
2. Click the Users tab and click **Edit**.
3. On the Users Category: Users page, click **Add**.
4. On the Add Users dialog box, search for and select the user, and click **Add**.
5. Repeat adding users until you have added the required users and click **Done**.
6. Click **Done** on each page until you return to the User Categories page.

Specifying the User Category for an Existing User

To add an existing user to a user category:

1. On the Security Console, click **Users**.
2. Search for and select the user for whom you want to specify the user category.
3. On the User Account Details page, click **Edit**.
4. In the User Information section, select the **User Category**. The Default user category remains set for a user until you change it.
5. Click **Save and Close**.
6. On the User Account Details page, click **Done**.

You can delete user categories if you don’t require them. However, you must ensure that no user is associated with that user category. Otherwise, you can’t proceed with the delete task. On the User Categories page, click the **X** icon in the row to delete the user category.

Managing User-Name and Password Notifications: Explained

By default, users in all user categories are notified automatically of changes to their user accounts and passwords. These notifications are based on notification templates. Many templates are predefined, and you can create templates for any user category. During implementation, you identify the notifications that you plan to use for each user category and disable any that aren’t needed. This topic introduces the predefined notification templates and explains how to enable and disable notifications.

Predefined Notification Templates

This table describes the predefined notification templates. Each template is associated with a predefined event. For example, the Password Reset Template is associated with the password-reset event. You can see these notification templates and their associated events on the User Category: Notifications page of the Security Console for a user category.

<table>
<thead>
<tr>
<th>Notification Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Expiry Warning Template</td>
<td>Warns the user that a password is expiring soon and provides instructions for resetting the password.</td>
</tr>
<tr>
<td>Password Expiration Template</td>
<td>Notifies the user that a password has expired and provides instructions for resetting the password.</td>
</tr>
</tbody>
</table>
Oracle Human Capital Management Cloud
Securing HCM

Chapter 6
Setting Up Applications Security

<table>
<thead>
<tr>
<th>Notification Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forgot User Name Template</td>
<td>Sends the user name to a user who requested the reminder.</td>
</tr>
<tr>
<td>Password Generated Template</td>
<td>Notifies the user that a password has been generated automatically and provides instructions for resetting the password.</td>
</tr>
<tr>
<td>Password Reset Template</td>
<td>Sends a reset-password link to a user who performed the Reset Password action on the My Account page.</td>
</tr>
<tr>
<td>Password Reset Confirmation Template</td>
<td>Notifies the user when a password has been reset.</td>
</tr>
<tr>
<td>New Account Template</td>
<td>Notifies a user when a user account is created and provides a reset-password link.</td>
</tr>
<tr>
<td>New Account Manager Template</td>
<td>Notifies the user's manager when a user account is created.</td>
</tr>
</tbody>
</table>

When you create a user category, it’s associated automatically with the predefined notification templates, which are all enabled.

You can't edit the predefined templates. However, you can create templates and disable the predefined versions. Each predefined event can be associated with only one enabled notification template at a time.

Enabling and Disabling Notifications

For any notification to be sent to the users in a user category, notifications in general must be enabled for the user category. Ensure that the Enable notifications option on the User Category: Notifications page is selected. When notifications are enabled, you can disable specific templates. For example, if you disable the New Account Template, then users in the relevant user category aren’t notified when their accounts are created. Other notifications continue to be sent.

To disable a template:

1. Click Edit on the User Category: Notifications page.
2. In edit mode, click the template name.
3. In the template dialog box, deselect the Enabled option.
4. Click Save and Close.

Creating a Notification Template: Procedure

Predefined notification templates exist for events related to the user-account life cycle, such as user-account creation and password reset. When templates are enabled, users are notified automatically of events that affect them. To provide your own notifications, you create notification templates. This topic explains how to create a notification template for a user category.

Creating a Notification Template

Follow these steps:

1. Open the Security Console and click the User Categories tab.
2. On the User Categories page, click the name of the relevant user category.
3. On the User Categories: Details page, click the Notifications subtab.
4. On the User Category: Notifications page, click **Edit**.
5. Click **Add Template**.
6. In the **Add Notification Template** dialog box:
   
   a. Enter the template name.
   b. In the **Event** field, select a value. The predefined content for the selected event appears automatically in the **Message Subject** and **Message Text** fields. Tokens in the message text are replaced automatically in generated notifications with values specific to the user.
   c. Update the **Message Subject** field, as required. The text that you enter here appears in the subject line of the notification email.
   d. Update the message text, as required.

   This table shows the tokens supported in the message text.

<table>
<thead>
<tr>
<th>Token</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>notificationUserName</td>
<td>User name to which notifications are sent</td>
</tr>
<tr>
<td>userEmailAddress</td>
<td>Address to which email notifications are sent</td>
</tr>
<tr>
<td>userLoginId</td>
<td>User name</td>
</tr>
<tr>
<td>firstName</td>
<td>User's first name</td>
</tr>
<tr>
<td>lastName</td>
<td>User's last name</td>
</tr>
<tr>
<td>managerFirstName</td>
<td>Manager’s first name</td>
</tr>
<tr>
<td>managerLastName</td>
<td>Manager’s last name</td>
</tr>
<tr>
<td>loginURL</td>
<td>URL where the user can sign in</td>
</tr>
<tr>
<td>resetURL</td>
<td>URL where the user can reset his or her password</td>
</tr>
<tr>
<td>CRLFX</td>
<td>New line</td>
</tr>
<tr>
<td>SP4</td>
<td>Four spaces</td>
</tr>
</tbody>
</table>

   e. To enable the template, select the **Enabled** option.
   f. Click **Save and Close**.
7. Click **Save** on the User Category: Notifications page.

   **Note:** When you enable an added template for a predefined event, the predefined template for the same event is automatically disabled.
Scheduling the Import User and Role Application Security Data Process: Procedure

You must run the Import User and Role Application Security Data process to set up and maintain the Security Console. During implementation, you perform the Import Users and Roles into Application Security task to run this process. It copies users, roles, privileges, and data security policies from the LDAP directory, policy store, and Applications Core Grants schema to Oracle Fusion Applications Security tables. Having this information in the Oracle Fusion Applications Security tables makes the assisted search feature of the Security Console fast and reliable. After the process runs to completion for the first time, you’re recommended to schedule Import User and Role Application Security Data to run daily. This topic describes how to schedule the process.

🔗 Note: Whenever you run the process, it copies only those changes that were made since it last ran.

Scheduling the Process

Follow these steps to schedule the Import User and Role Application Security Data process:

1. Open the Scheduled Processes work area.
2. In the Search Results section of the Overview page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for and select the Import User and Role Application Security Data process.
4. Click OK.
5. In the Process Details dialog box, click Advanced.
6. On the Schedule tab, set Run to Using a schedule.
7. Set Frequency to Daily and Every to 1.
8. Enter start and end dates and times. The start time should be after any daily run of the Send Pending LDAP Requests process completes.
9. Click Submit.
10. Click OK to close the confirmation message.

Synchronization Process Preferences

On the General subtab of the Security Console Administration tab, you can set the Synchronization Process Preferences option. This option controls how frequently you’re reminded to run the Import User and Role Application Security Data process. By default, the warning appears if the process hasn’t run successfully in the last 6 hours. If you schedule the process to run daily, then you may want to increment this option to a value greater than 24.

Importing User Login History: Explained

During implementation, you perform the Import User Login History task in the Setup and Maintenance work area. This task runs a process that imports information about user access to Oracle Fusion Applications to the Oracle Fusion Applications Security tables. This information is required by the Inactive Users Report, which reports on users who have been inactive for a specified period. After you perform Import User Login History for the first time, you’re recommended to schedule it to run daily. In this way, you can ensure that the Inactive Users Report is up to date.
Scheduling the Import User Login History Process

Follow these steps:

1. Open the Scheduled Processes work area.
2. In the Search Results section of the Overview page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for and select the Import User Login History process.
4. Click OK.
5. In the Process Details dialog box, click Advanced.
6. On the Schedule tab, set Run to Using a schedule.
7. Set Frequency to Daily and Every to 1.
8. Enter start and end dates and times.
9. Click Submit.
10. Click OK to close the Confirmation message.

Related Topics
- Inactive Users Report

Send Pending LDAP Requests: Explained

You're recommended to run the Send Pending LDAP Requests process daily to send future-dated and bulk requests to your LDAP directory server. Schedule the process in the Scheduled Processes work area. This topic describes the purpose of Send Pending LDAP Requests.

Send Pending LDAP Requests sends the following items to the LDAP directory:

- Requests to create, suspend, and reactivate user accounts.
  - When you create a person record for a worker, a user-account request is generated automatically.
  - When a person has no roles and no current work relationships, a request to suspend the user account is generated automatically.
  - A request to reactivate a suspended user account is generated automatically if you rehire a terminated worker.

The process sends these requests to the LDAP directory unless the automatic creation and management of user accounts are disabled for the enterprise.

- Work emails.
  - If you include work emails when you create person records, then the process sends those emails to the LDAP directory.

- Role provisioning and deprovisioning requests.
  - The process sends these requests to the LDAP directory unless automatic role provisioning is disabled for the enterprise.

- Changes to person attributes for individual users.
  - The process sends this information to the LDAP directory unless the automatic management of user accounts is disabled for the enterprise.
• Information about HCM data roles, which originate in Oracle HCM Cloud.

Note: All of these items are sent to the LDAP directory automatically unless they're either future-dated or generated by bulk data upload. You run the process Send Pending LDAP Requests to send future-dated and bulk requests to the LDAP directory.

Only one instance of Send Pending LDAP Requests can run at a time.

Scheduling the Send Pending LDAP Requests Process: Procedure

The Send Pending LDAP Requests process sends bulk requests and future-dated requests that are now active to your LDAP directory. You're recommended to schedule the Send Pending LDAP Requests process to run daily. This procedure explains how to schedule the process.

Note: Schedule the process only when your implementation is complete. Once you schedule the process you can’t run it on an as-needed basis, which may be necessary during implementation.

Scheduling the Send Pending LDAP Requests Process

Follow these steps:

1. Open the Scheduled Processes work area.
2. Click Schedule New Process in the Search Results section of the Overview page.
3. In the Schedule New Process dialog box, search for and select the Send Pending LDAP Requests process.
4. In the Process Details dialog box, set User Type to identify the types of users to be processed. Values are Person, Party, and All. You’re recommended to leave User Type set to All.
5. The Batch Size field specifies the number of requests in a single batch. For example, if 400 requests exist and you set Batch Size to 25, then the process creates 16 batches of requests to process in parallel.

The value 25, which means that the batch size is calculated automatically, is recommended.
6. Click Advanced.
7. On the Schedule tab, set Run to Using a schedule.
8. In the Frequency field, select Daily.
9. Enter the start and end dates and times.
10. Click Submit.

Running Retrieve Latest LDAP Changes: Procedure

Information about users and roles in your LDAP directory is available automatically to Oracle Cloud Applications. However, in specific circumstances you’re recommended to run the Retrieve Latest LDAP Changes process. This topic describes when and how to run Retrieve Latest LDAP Changes.

You run Retrieve Latest LDAP Changes if you believe data-integrity or synchronization issues may have occurred between Oracle Cloud Applications and your LDAP directory server. For example, you may notice differences between roles on the
Security Console and roles on the Create Role Mapping page. On-premises customers should also run this process after applying monthly updates.

Running Retrieve Latest LDAP Changes

Sign in with the IT Security Manager job role and follow these steps:

1. Open the Scheduled Processes work area.
2. Click Schedule New Process in the Search Results section of the Overview page.
   
   The Schedule New Process dialog box opens.
3. In the Name field, search for and select the Retrieve Latest LDAP Changes process.
4. Click OK to close the Schedule New Process dialog box.
5. In the Process Details dialog box, click Submit.
6. Click OK, then Close.
7. On the Scheduled Processes page, click the Refresh icon.

   Repeat this step periodically until the process completes.

>Note: Only one instance of Retrieve Latest LDAP Changes can run at a time.
Working with the Bridge for Microsoft Active Directory

Bridge for Microsoft Active Directory: Explained

The bridge for Microsoft Active Directory synchronizes user account information between Oracle Applications Cloud and Microsoft Active Directory. Using the bridge, you can copy user or role details from Oracle Applications Cloud (as the source) to Active Directory (as the target), or the other way around. Depending on the direction in which data synchronization is planned, you can specify one of them as the source and the other one as the target.

Using the Bridge for Microsoft Active Directory

To use the bridge for Active Directory and synchronize information between Oracle Applications Cloud and Active Directory, perform the following steps:

1. Configure the bridge for Active Directory. Set the configuration options on the Administration tab in the Security Console.
2. Map attributes between source and target applications for synchronization.
3. Download and install the bridge for Active Directory.
4. Perform initial synchronization of users.
5. Perform manual or automatic synchronization regularly to maintain consistency of data on the source and target applications.

Prerequisites

Before setting up the bridge between Active Directory and Oracle Applications Cloud, you must:

- Install Java Runtime environment (JRE). The bridge is compatible with JRE versions 6, 7, and 8.
- Install the bridge on a computer that can connect to your Active Directory server.
- Enable Single Sign-On (SSO) between Oracle Applications Cloud and your Active Directory instance.

Related Topics

- Running Bridge for Active Directory with Oracle Applications Cloud as the source
- Running Bridge for Active Directory with Active Directory as the source

Synchronizing Information Between Source and Target Applications: Explained

The bridge for Active Directory synchronizes user account information between Oracle Cloud Applications and Microsoft Active Directory.
After you provide the bridge configuration details, map the user account attributes between Oracle Cloud Applications and Microsoft Active Directory. When the mapping is complete, install and run the bridge for active directory. Initiate the initial synchronization of users between the source and target applications from the bridge application.

During synchronization, the bridge extracts data from the source and target applications, compares the data, and identifies the task that must be performed on the target application for consistency.

When synchronization completes, the bridge performs the required tasks on the target application. Any errors encountered during synchronization are recorded in the log files for review and correction.

After the initial synchronization is complete, you can configure the bridge to synchronize any changes between the source and target at regular intervals or on-demand.

The bridge for active directory can perform:

- Full synchronization
- Incremental synchronization

### Full Synchronization

The bridge starts full synchronization or full reconciliation when any of the following conditions are true:

- The source and target applications are synchronized for the first time.
- The bridge configuration for the active directory has changed.
- The Run Full Synchronization button is clicked.

To perform a full synchronization:

1. Click the Bridge for Active Directory tab on the Administration page in the Security Console.
2. Click User Attribute Mappings.
3. Expand the On Demand Synchronization section and click Run Full Synchronization.

**Note:** To disable full synchronization, click Cancel Full Synchronization.

### Incremental Synchronization

The bridge starts incremental synchronization when: any of the following conditions are true:

- The source and target were previously synchronized.
- The bridge configuration for the active directory has not changed.
- The Run Full Synchronization button isn’t clicked.

Incremental synchronization can be either on-demand (manually) or at regular intervals (automatically).
Mapping Information Between Source and Target Applications for Synchronization: Explained

After you install and configure the bridge, map the user account attributes between Oracle Cloud Applications and Microsoft Active Directory. Only when the mapping is complete, you can initiate the initial synchronization of users between the source and target applications.

Map the following user attributes:

- User account attributes
- Advanced user account attributes
- Group attributes

Mapping User Attributes

The following attributes of an Oracle Cloud Application user account are mapped to the corresponding attributes of an Active Directory user account:

- `displayName`: Display name of the user account.
- `emails.value`: Primary email associated with the user account.
- `name.familyName`: Last name of the user.
- `name.givenName`: First name of the user.
- `userName`: User name associated with the user account.

During synchronization, the attribute values from the source are copied over to the mapped target attributes.

The following table lists a typical mapping of attributes when Oracle Cloud Application is the source.

<table>
<thead>
<tr>
<th>Oracle Cloud Application as Source</th>
<th>Microsoft Active Directory as Target</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>emails.value</code></td>
<td>Mail</td>
</tr>
<tr>
<td><code>Username</code></td>
<td><code>cn</code></td>
</tr>
<tr>
<td><code>displayName</code></td>
<td><code>displayName</code></td>
</tr>
<tr>
<td><code>name.familyName</code></td>
<td><code>sn</code></td>
</tr>
<tr>
<td><code>name.givenName</code></td>
<td><code>givenName</code></td>
</tr>
<tr>
<td><code>Username</code></td>
<td><code>userPrincipalName</code></td>
</tr>
<tr>
<td><code>Username</code></td>
<td><code>sAMAccountName</code></td>
</tr>
</tbody>
</table>
The following table lists a typical mapping of attributes when Microsoft Active Directory is the source.

<table>
<thead>
<tr>
<th>Microsoft Active Directory as Source</th>
<th>Oracle Cloud Applications as Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail</td>
<td>emails.value</td>
</tr>
<tr>
<td>sAMAccountName</td>
<td>Username</td>
</tr>
<tr>
<td>displayName</td>
<td>displayName</td>
</tr>
<tr>
<td>givenName</td>
<td>name.givenName</td>
</tr>
<tr>
<td>sn</td>
<td>name. familyName</td>
</tr>
</tbody>
</table>

On the Security Console, click **Administration > Bridge for Active Directory** tab > **User Attribute Mappings**. Click **Add** to add or update the mapping between attributes of the source and target applications.

### Mapping Advanced Attributes

This is applicable when Active Directory is the source. Use the **Synchronize User Status** option to enable the account status, such as **Disabled**, to propagate to Oracle Cloud Applications.

### Using the Bridge for Microsoft Active Directory

#### Configuring the Bridge for Microsoft Active Directory: Procedure

Follow this procedure to configure the Bridge for Microsoft Active Directory. Sign in to Oracle Cloud Applications environment as an administrator with the IT Security Manager (**ORA_FND_IT_SECURITY_MANAGER_JOB**) role.

1. Click **Navigator > Security Console**.
2. On the Administration page, click the Bridge for Active Directory tab.
3. Click **Configuration**.
4. Expand the Base Configuration section and provide the following details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source of Truth</td>
<td>Select the source, such as Oracle Applications Cloud or Active Directory.</td>
</tr>
<tr>
<td>Synchronization Interval (Hours)</td>
<td>Enter the time interval (in hours) that the bridge uses to begin synchronization automatically. The default value is one hour.</td>
</tr>
<tr>
<td>Synchronization Paging Size</td>
<td>Enter the number of accounts that are synchronized in a single operation. The default value is 100 records.</td>
</tr>
</tbody>
</table>
### Chapter 7
Working with the Bridge for Microsoft Active Directory

#### Field | Description
--- | ---
Synchronization Error Threshold | Enter the maximum number of errors that can occur during synchronization. When the limit is reached, synchronization fails and stops. By default, synchronization stops after 50 errors have occurred.

Scheduler | Specify whether you want to automatically schedule synchronizations. If enabled, the synchronizations will run automatically as per the specified schedule and interval.

Role Integration | Specify whether you want to use role integration. It is applicable when Active Directory is the source.

Reset APPID Password | Enter a new password. During synchronization, this password is used by the bridge to connect to Oracle Cloud Applications.

5. Expand the Logging Configuration section and provide the following details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Enter the name of the log file. This file is created in the Active Directory folder on the computer where the Active Directory bridge is installed. The default value is ad_fasynch.log</td>
</tr>
<tr>
<td>Log Level</td>
<td>Specify the level at which messages must be logged during synchronization. The default level is set to Information.</td>
</tr>
<tr>
<td>Maximum Log Size</td>
<td>Specify the maximum size of the log file. The default value is 4 GB. When the maximum size is reached, a new log file is created.</td>
</tr>
</tbody>
</table>

6. Expand the Active Directory Configuration section and provide the following details. The bridge uses this information to connect to the Active Directory server.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Enter the host address of the Active Directory server.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port of the Active Directory server. The default non-SSL port is 389.</td>
</tr>
<tr>
<td>Enable SSL</td>
<td>Select this option for secure communication with the Active Directory server. When you select this option, the default port changes to 636.</td>
</tr>
<tr>
<td>Synchronization Strategy</td>
<td>Select the algorithm that must be used for synchronization. You can select Directory Synchronization or Update Sequence Number. The default value is Directory Synchronization.</td>
</tr>
</tbody>
</table>

**Note:** If you change the sequence number after the initial configuration, the synchronization process resets.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Base DN</td>
<td>Enter the distinguished name of the location in your Active Directory where the user accounts are created or retrieved by the bridge.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Search Base | Enter the same value as the User Base DN.

User Search Filter | Enter the LDAP query that is used by the bridge to retrieve the user account objects from the Active Directory. For example, (& (objectClass=user)(!(objectClass computer))).

Group Base DN | Enter the distinguished name of the location in your Active Directory from where the bridge fetches the groups.

*Note:* This field is applicable only when Active Directory is the source.

Group Search Filter | Enter the LDAP query that is used to fetch roles from your Active Directory server. For example, (objectClass= group).

*Note:* This field is applicable only when Active Directory is the source.

7. Expand the Network Proxy Configuration section and provide the details.

*Note:* Provide these details only when Active Directory is the source, and the bridge uses a proxy to connect to the Active Directory server.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Proxy Settings</td>
<td>Select this option to enable communication through a proxy between Oracle Applications Cloud and your Active Directory bridge. Use this option when you need to connect from an isolated network host.</td>
</tr>
<tr>
<td>Host</td>
<td>Enter a host name and address for the proxy.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter a port for the proxy.</td>
</tr>
<tr>
<td>Enable SSL</td>
<td>Select this option for secure communication with the proxy.</td>
</tr>
</tbody>
</table>

8. Expand the Heartbeat section and update the following details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heartbeat Interval</td>
<td>Enter the time interval, in seconds, at which heartbeat notifications are sent from the bridge to Oracle Applications Cloud to signal that the bridge is active. It is set to 60 seconds by default.</td>
</tr>
</tbody>
</table>

9. Click **Save** and click **OK**.
Downloading and Installing the Bridge for Active Directory: Procedure

Once you have set the configuration details for the bridge, download the bridge for Active Directory on a computer connected to your network. This computer must connect to both Oracle Cloud Application and your Microsoft Active Directory server instance.

1. Click **Navigator > Tools > Security Console**.
2. On the Administration page, click the Bridge for Active Directory tab.
3. Click **Launch**.
4. Review the message that appears and click **OK**.
5. Accept the notification to download the bridge file (adbridge.jnlp).
6. Open the bridge file (adbridge.jnlp) from your Web browser.
7. Enter **User name** and **Password** to sign in. You can use your Oracle Applications Cloud credentials to sign in.

   ✨ **Note:** You must have the IT Security Manager role (ORA_FND_IT_SECURITY_MANAGER_JOB) to access the bridge.

8. Click **OK**.
   The bridge for active directory is installed. Once the bridge is installed, you can open it.
9. Click **Run** to start the bridge.
10. Enter **User name** and **Password**. You can use your Oracle Applications Cloud credentials to sign in.

   ✨ **Note:** You must have the IT Security Manager role (ORA_FND_IT_SECURITY_MANAGER_JOB) to access the bridge.

11. Click **OK**.
12. Open the Bridge for Active Directory. The bridge automatically displays the necessary information configured through the Security Console.
13. Click the Configuration tab
14. In the Active Directory section, enter the **User name** and **Password** for the Active Directory sever.
15. In the Oracle Applications Cloud section, enter the **Password** for the Oracle Applications Cloud host.

   ✨ **Note:** The password must match the Reset APPID Password you had provided through the Security Console.

16. You can change the Oracle Cloud Application network settings. Click **Network Settings** to update the details.
17. Click **Save** and click **Close**.
   The bridge updates the setup information from Active Directory (attributes, groups) to Oracle Applications Cloud. Use this setup information to perform mapping in the Security Console.

Mapping Attributes and Groups for Synchronization: Procedure

Once you have set the configuration details for the bridge through the Security Console, download the bridge to a computer connected to your network. This computer must connect to both Oracle Applications Cloud and your Microsoft Active Directory server instance.

1. Click **Navigator > Security Console**.
2. On the Administration page, click the Bridge for Active Directory tab.
3. Click User Attribute Mappings.
4. Click Add to update the mapping between source user attributes and target user attributes.
5. Select the source attribute from the Source User Attribute list.
6. Select the target attribute from the Target User Attribute list.
7. Click OK.
8. Repeat steps 4 to 7 to map more attributes.
9. Click Save.
10. Expand the Advanced Attribute Mappings section.
11. Set the Synchronize User Account Status to either enable or disable, to determine whether to synchronize the account or not.
12. Click Save.
13. Click Group Mappings to map active directory groups to Oracle Cloud Application roles.
14. Click Add to add new group to role mapping or select an existing mapping and click the Actions drop-down list.
15. On the Add Role Mapping dialog box, select the Group and the Roles. When a user account is added to or removed from a group in the Active Directory, the corresponding Oracle Cloud Application user account is added to or removed from the mapped role in Oracle Cloud Applications.
16. Click OK.
17. Click Save.

Performing Initial Synchronization: Procedure

Follow these steps to perform the initial synchronization of users:

1. Start the Bridge for Active Directory.
2. Sign in to bridge using your Oracle Cloud Applications login credentials.
3. Click the Synchronization tab.
4. Click Run Now.
5. Click See Log Files to view the log files for any errors.
6. Click Close.

Performing Manual and Automatic Synchronization: Procedures

In the initial synchronization, data is copied from the source application to the target application. After the initial synchronization is complete, you can configure the bridge to synchronize any changes between the source and target applications, either on-demand (manually) or at regular intervals (automatically).

Manual Synchronization

Perform manual synchronization whenever you want to synchronize the source and target applications after the initial synchronization. To manually synchronize data, perform the following steps on the bridge:

1. Navigate to the Security Console and click the Active Directory tab.
2. Click the Synchronization tab and click Run Now.

Automatic Synchronization

You can configure the bridge to perform synchronization periodically as a Microsoft Windows service. Perform the following steps to configure automatic synchronization:

1. Start the bridge.
Click **Service Installation**.

Enter the user name and password of the account that is used to run the service. The account must have administrative privileges.

Click Install Windows Service.

On successful installation, the bridge is registered as a service with the name Bridge for Active Directory.

### Specifying the Synchronization Interval

Once the bridge is set up to run as a Windows Service, it periodically performs synchronization. The synchronization interval is specified in the Security Console and must be specified before the bridge is downloaded.

1. Select **Navigator > Security Console**.
2. Click the Administration tab.
3. Click the **Bridge for Active Directory** link.
4. Go to the Configuration tab and specify the Synchronization Interval (in hours).

### FAQs for Working with the Bridge for Microsoft Active Directory

**Can the bridge support other LDAP directories?**

No, the bridge can only be used for synchronization between Oracle Cloud Applications and Microsoft Active Directory.

**How often is information synchronized?**

Using the Microsoft Windows service, you can configure the bridge to perform synchronization periodically. The minimum interval between two synchronizations must be one hour.

**What types of Active Directory objects can be synchronized?**

You can synchronize Active Directory users and groups.

Use the following synchronization options:

- Synchronize users with Oracle Applications Cloud user accounts.
- Synchronize groups with Oracle Applications Cloud roles.

You can synchronize users when the source is either Oracle Applications Cloud or Active Directory. However, you can synchronize groups when the source is only Active Directory.

**What attributes can I synchronize?**

You can synchronize the following predefined attributes in Oracle Applications Cloud with any Active Directory attributes:
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>displayName</td>
<td>Display name of the user account.</td>
</tr>
<tr>
<td>emails.value</td>
<td>Primary email address associated with the user account.</td>
</tr>
<tr>
<td>name. familyName</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>name.givenName</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>Username</td>
<td>User name (name for signing in) associated with the user.</td>
</tr>
</tbody>
</table>

You can’t change or format an attribute during synchronization.

🔍 **Note:** You can synchronize only the predefined attributes, not any user-defined attribute.

### How can I view the log files?

To view the log files, click the Synchronization tab on the bridge application and click the **See Log Files** link. Information about each synchronization is recorded in the log files. The path to the log file on a Windows operating system is: `%APPDATA%\Oracle\AD Bridge\log`.  

---

![Oracle logo](https://www.oracle.com/images/oracle-logo.png)
Preparing for Application Users

Overview

During implementation, you prepare your Oracle HCM Cloud service for application users. Decisions made during this phase determine how you manage users by default. Most such decisions can be overridden. However, for efficient user management, you're recommended to configure your environment to both reflect enterprise policy and support most or all users.

Some key decisions and tasks are explained in this chapter and introduced in this table.

<table>
<thead>
<tr>
<th>Decision or Task</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whether user accounts are created automatically for application users</td>
<td>User Account Creation Option: Explained</td>
</tr>
<tr>
<td>How role provisioning is managed</td>
<td>User Account Role Provisioning Option: Explained</td>
</tr>
<tr>
<td>Whether user accounts are maintained automatically</td>
<td>User Account Maintenance Option: Explained</td>
</tr>
<tr>
<td>Whether user accounts are created for terminated workers that you load in bulk</td>
<td>User Account Creation for Terminated Workers Option: Explained</td>
</tr>
<tr>
<td>Ensuring that the Employee, Contingent Worker, and Line Manager abstract roles are provisioned automatically</td>
<td>Provisioning Abstract Roles to Users Automatically: Procedure</td>
</tr>
</tbody>
</table>

Some decisions affecting application users were made when the Security Console was set up. These decisions include:

- How user names are formed by default
- How passwords are formed and when they expire
- How users are notified of their sign-in details and password events, such as expiration warnings

You may want to review these settings on the Administration tab of the Security Console before creating application users.

Related Topics

- Defining the Default User-Name Format: Explained
- Setting Password Policy: Explained
- Managing User-Name and Password Notifications: Explained
User and Role-Provisioning Setup: Critical Choices

This topic introduces the user and role-provisioning options, which control the default management of some user-account features. To set these options, perform the Manage Enterprise HCM Information task in the Workforce Structures functional area for your offering. You can edit these values as necessary and specify an effective start date for changed values.

User Account Creation

The **User Account Creation** option controls:

- Whether user accounts are created automatically when you create a person, user, or party record
- The automatic provisioning of roles to users at account creation

This option may be of interest if:

- Some workers don’t need access to Oracle Applications Cloud.
- Your existing provisioning infrastructure creates user accounts, and you plan to integrate it with Oracle Applications Cloud.

User Account Role Provisioning

Once a user account exists, users both acquire and lose roles as specified by current role-provisioning rules. For example, managers may provision roles to users manually, and the termination process may remove roles from users automatically. You can control role provisioning by setting the **User Account Role Provisioning** option.

> Note: Roles that you provision to users directly on the Security Console aren’t affected by this option.

User Account Maintenance

The **User Account Maintenance** option controls whether user accounts are suspended and reactivated automatically. By default, a user’s account is suspended automatically when the user is terminated and reactivated automatically if the user is rehired.

User Account Creation for Terminated Workers

The **User Account Creation for Terminated Workers** option controls whether user-account requests for terminated workers are processed or suppressed. This option takes effect when you run the Send Pending LDAP Requests process.

User Account Creation Option: Explained

The **User Account Creation** option controls whether user accounts are created automatically when you create a person or party record. Use the Manage Enterprise HCM Information task to set this option.

This table describes the **User Account Creation** option values.
User Account Role Provisioning Option: Explained

Existing users both acquire and lose roles as specified by current role-provisioning rules. For example, users may request some roles for themselves and acquire others automatically. All provisioning changes are role requests that are processed by default. You can control what happens to role requests by setting the **User Account Role Provisioning** option. Use the Manage Enterprise HCM Information task to set this option.

This table describes the **User Account Role Provisioning** option values.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both person and party users</td>
<td>Role provisioning and deprovisioning occur for both person and party users.</td>
</tr>
<tr>
<td></td>
<td>This value is the default value.</td>
</tr>
<tr>
<td>Party users only</td>
<td>Role provisioning and deprovisioning occur for party users only. For person users, role requests are held in the LDAP requests table, where they’re identified as suppressed. They’re not processed.</td>
</tr>
<tr>
<td>None</td>
<td>For both person and party users, role requests are held in the LDAP requests table, where they’re identified as suppressed. They’re not processed.</td>
</tr>
</tbody>
</table>
User Account Maintenance Option: Explained

By default, a user’s account is suspended automatically when the user has no roles. This situation occurs typically at termination. The user account is reactivated automatically if you reverse the termination orrehire the worker. The **User Account Maintenance** option controls these actions. Use the Manage Enterprise HCM Information task to set this option.

This table describes the **User Account Maintenance** option values.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both person and party users</td>
<td>User accounts are maintained automatically for both person and party users.</td>
</tr>
<tr>
<td></td>
<td>This value is the default value.</td>
</tr>
<tr>
<td>Party users only</td>
<td>User accounts are maintained automatically for party users only.</td>
</tr>
<tr>
<td></td>
<td>For person users, account-maintenance requests are held in the LDAP requests table, where they’re identified as suppressed. They’re not processed.</td>
</tr>
<tr>
<td></td>
<td>Select this value if you manage accounts for person users in some other way.</td>
</tr>
<tr>
<td>None</td>
<td>For both person and party users, account-maintenance requests are held in the LDAP requests table, where they’re identified as suppressed. They’re not processed.</td>
</tr>
<tr>
<td></td>
<td>Select this value if you manage accounts for both person and party users in some other way.</td>
</tr>
</tbody>
</table>

User Account Creation for Terminated Workers Option: Explained

The **User Account Creation for Terminated Workers** option controls whether user accounts are created for terminated workers. It applies only when you run Send Pending LDAP Requests. Typically, you run Send Pending LDAP Requests after loading workers in bulk using HCM Data Loader, for example. This option doesn’t apply to workers created in the user interface unless they’re future-dated. Use the Manage Enterprise HCM Information task to set this option.

This table describes the **User Account Creation for Terminated Workers** option values.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No (or not set)</td>
<td>User-account requests generated for terminated workers are suppressed when you run Send Pending LDAP Requests.</td>
</tr>
<tr>
<td>Yes</td>
<td>User-account requests generated for terminated workers are processed when you run Send Pending LDAP Requests.</td>
</tr>
</tbody>
</table>
This option determines whether user-account requests for terminated workers are processed or suppressed. A user-account request is generated for a worker created by bulk upload only if:

- The **User Account Creation** enterprise option is set to **Both person and party users**.
- The **GeneratedUserAccountFlag** attribute for the Worker object isn’t set to **N**.

Otherwise, user-account requests for workers are suppressed and **User Account Creation for Terminated Workers** has no effect.

**Related Topics**

- **Send Pending LDAP Requests: Explained**

### Setting the User and Role Provisioning Options: Procedure

The user and role provisioning options control the creation and maintenance of user accounts for the enterprise. This procedure explains how to set these options. To create and maintain Oracle Applications Cloud user accounts automatically for all users, you can use the default settings.

### Setting the User and Role Provisioning Options

Follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Workforce Structures
   - Task: Manage Enterprise HCM Information
2. On the Enterprise page, select **Edit > Update**.
3. In the **Update Enterprise** dialog box, enter the effective date of any changes and click **OK**. The Edit Enterprise page opens.
4. Scroll down to the User and Role Provisioning Information section.
5. Set the User Account Options, as appropriate. The User Account Options are:
   - **User Account Creation**
   - **User Account Role Provisioning**
   - **User Account Maintenance**
   - **User Account Creation for Terminated Workers**

   These options are independent of each other. For example, you can set **User Account Creation** to **None** and **User Account Role Provisioning** to **Yes**.
6. Click **Submit** to save your changes.
7. Click **OK** to close the **Confirmation** dialog box.
Provisioning Abstract Roles to Users Automatically: Procedure

Provisioning the Employee, Contingent Worker, and Line Manager abstract roles automatically to users is efficient, as most users have at least one of these roles. It also ensures that users have basic access to functions and data when they first sign in. This topic explains how to set up automatic role provisioning during implementation using the Manage Role Provisioning Rules task.

Provisioning the Employee Role Automatically to Employees

Follow these steps:

1. Sign in as the TechAdmin user or another user with the IT Security Manager job role or privileges.
2. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Manage Role Provisioning Rules
3. In the Search Results section of the Manage Role Mappings page, click the Create icon. The Create Role Mapping page opens.
4. In the Mapping Name field enter Employee.
5. Complete the fields in the Conditions section of the Create Role Mapping page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Person Type</td>
<td>Employee</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
</tbody>
</table>
6. In the Associated Roles section of the Create Role Mapping page, add a row.
7. In the Role Name field of the Associated Roles section, click Search.
8. In the Search and Select dialog box, enter Employee in the Role Name field and click Search.
9. Select Employee in the search results and click OK.
10. If Autoprovision isn’t selected automatically, then select it. Ensure that the Requestable and Self-Requestable options aren’t selected.
11. Click Save and Close.

Provisioning the Contingent Worker Role Automatically to Contingent Workers

Repeat the steps in Provisioning the Employee Role Automatically to Employees, with the following changes:

- In step 4, enter Contingent Worker as the mapping name.
- In step 5, set System Person Type to Contingent Worker.
- In steps 8 and 9, search for and select the Contingent Worker role.
Provisioning the Line Manager Role Automatically to Line Managers

Follow these steps:

1. In the Search Results section of the Manage Role Mappings page, click the Create icon. The Create Role Mapping page opens.
2. In the Mapping Name field enter Line Manager.
3. Complete the fields in the Conditions section of the Create Role Mapping page as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Person Type</td>
<td>Employee</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
<tr>
<td>Manager with Reports</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Tip: Setting Manager with Reports to Yes is the same as setting Manager Type to Line Manager. You don’t need both values.

4. In the Associated Roles section of the Create Role Mapping page, add a row.
5. In the Role Name field of the Associated Roles section, click Search.
6. In the Search and Select dialog box, enter Line Manager in the Role Name field and click Search.
7. Select Line Manager in the search results and click OK.
8. If Autoprovision isn’t selected automatically, then select it. Ensure that the Requestable and Self-Requestable options aren’t selected.
9. Click Save and Close.
10. On the Manage Role Mappings page, click Done.

To provision the line manager role automatically to contingent workers, follow these steps to create an additional role mapping. In step 2, use a unique mapping name (for example, Contingent Worker Line Manager). In step 3, set System Person Type to Contingent Worker.

FAQs for Preparing for Application Users

Can I implement single sign-on in the cloud?

Yes. Single sign-on enables users to sign in once but access multiple applications, including Oracle Human Capital Management Cloud.

Submit a service request for implementation of single sign-on. For more information, see Oracle Applications Cloud Service Entitlements (2004494.1) on My Oracle Support at https://support.oracle.com.

Related Topics

- Oracle Applications Cloud Service Entitlements (2004494.1)
9 Creating Application Users

Points to Consider

When you create person records in Oracle HCM Cloud, user accounts can be created automatically. The User and Role Provisioning options control whether user accounts are created and maintained automatically. You set these options for the enterprise during implementation using the Manage Enterprise HCM Information task.

Some enterprises use applications other than Oracle HCM Cloud to manage user and role provisioning. In this case, you set the User and Role Provisioning options to prevent automatic creation of user accounts. Oracle HCM Cloud user accounts don't provide access to other enterprise applications.

Creating Person Records

You can create person records:

- Individually, using tasks such as Hire an Employee
- By uploading them in bulk, using HCM Data Loader

During implementation, you can also use the Create User task to create individual application users with basic person records for test purposes. However, after implementation, you use tasks such as Hire an Employee and Add a Contingent Worker. These tasks are functionally rich and create the employment information required for Oracle HCM Cloud implementations. Don’t use Create User, which is intended primarily for Oracle Fusion Applications customers who aren’t implementing Oracle HCM Cloud.

Uploading Workers Using HCM Data Loader

To load workers using HCM Data Loader, use the Import and Load Data task in the Data Exchange work area. The enterprise option User Account Creation controls whether user accounts are created for all workers by default. You can prevent user accounts from being created for individual workers by setting the GeneratedUserAccountFlag attribute of the User Information component to N. You can also provide a user name in the uploaded data to override the default user-name format. You run the process Send Pending LDAP Requests to send bulk user-account requests for processing.

Note: If appropriate role mappings don’t exist when you load new workers, then user accounts are created but no roles are provisioned. User accounts without roles are automatically suspended when Send Pending LDAP Requests completes. To avoid this suspension, always create a role mapping for the workers you’re loading before you load them. Having the recommended role mapping to provision abstract roles automatically to employees, contingent workers, and line managers is sufficient in most cases.

Related Topics

- Provisioning Abstract Roles to Users Automatically: Procedure
Using the New Person Tasks: Procedure

Once the initial implementation of Oracle HCM Cloud is complete, person records can be created
- Individually, using tasks such as Hire an Employee in the New Person work area
- In bulk, by uploading person records using HCM Data Loader

This topic summarizes how to create person records using the Hire an Employee task, with emphasis on any steps that affect user and role provisioning.

Hiring an Employee: User-Name Values

You must have the Human Resource Specialist job role to hire an employee as described here. Follow these steps:

1. Open the New Person work area.
2. On the Tasks panel tab, select the Hire an Employee task. The Hire an Employee: Identification page opens.
3. If the Person Number value is Generated automatically, then the number is generated on approval of the hire. If the field is blank, then you can enter a person number.
   The user name is the person number if the generation rule for user names, as specified on the Security Console, is Person or party number.
4. You enter the person’s first and last names. Other names are optional. The user name is based on the person’s first and last names if the generation rule for user names is either FirstName.LastName or FLastName.
5. Click Next. The Hire an Employee: Person Information page opens.
6. A user can have only one work email. If you enter no work email when you create the person record, then an authorized user can enter it later on the Security Console. You can’t add it directly to the person record later. Once the person record exists, the email is managed on the Security Console.
   The user name is the work email if the generation rule for user names is Email.
7. Click Next.

Hiring an Employee: Roles

The Hire an Employee: Employment Information page opens. Many assignment details, including Assignment Status and Job, may occur as conditions in role mappings. For example, users may acquire a role automatically if their grade matches that in the associated role mapping.

1. Click Next. The Hire an Employee: Compensation and Other Information page opens.
   Any roles for which the employee qualifies automatically appear in the Role Requests region of the page.
2. To add roles manually, click Add Role. The Add Role dialog box opens.
3. Search for and select the role. A role that you can provision appears in a role mapping where you satisfy the conditions and the Requestable option is selected for the role.
   The selected role appears in the Role Requests region with the status Add requested. Repeat steps 2 and 3 for additional roles.
   This action:
   - Submits the Hire an Employee transaction for approval
o Creates a request to create the user account and provision the requested roles, on approval of the hire

\textbf{\textit{Note:}} User-account and role-provisioning requests are processed only if processing is enabled for the enterprise.

The user is notified of his or her sign-in details if an appropriate notification template is enabled.

Using the Create User Task: Procedure

During implementation, you can use the Create User task to create test application users. By default, this task creates a minimal person record and a user account. After implementation, you use tasks such as Hire an Employee to create application users. The Create User task isn't recommended after implementation is complete. This topic describes how to create a test user using the Create User task.

Sign in and follow these steps:

1. Select \textit{Navigator > My Team > Users, Roles and Delegations} to open the Search Person page.
2. In the Search Results section, click the \textit{Create} icon.

The Create User page opens.

Completing Personal Details

Follow these steps:

1. Enter the user's name.
2. In the \textit{Email} field, enter the user's primary email.
3. In the \textit{Hire Date} field, enter the hire date for a worker. For other types of users, enter a user start date. You can't edit this date after the user exists.

Completing User Details

You can either create a user account or link an existing, standalone user account.

To create a user account, you select \textit{Enter user name}. If you leave the \textit{User Name} field blank, then the user name is generated automatically in the enterprise default format. In this case, automatic creation of user accounts must be enabled for the enterprise. If you enter a user name, then that name is used if valid.

Alternatively, you may have created a standalone user account on the Security Console or using SCIM (REST) APIs. In this case, the user account isn’t linked to a person record when you create the account. To link such an account to the new person record:

1. Select \textit{Link user account}.
2. Click the \textit{Link} icon to open the \textit{Link User Account} dialog box.
3. In the \textit{Link User Account} dialog box, search for and select the user account. Accounts that are already linked to person records don't appear here.

\textbf{\textit{Tip:}} The account can be in any status. Its status isn’t changed when you link it.

4. Click \textit{OK} to link the account.
Setting User Notification Preferences

The **Send user name and password** option controls whether a notification containing the new user’s sign-in details is sent when the account is created. This option is enabled only if:

- Notifications are enabled on the Security Console.
- An appropriate notification template exists.

For example, if the predefined notification template **New Account Template** is enabled, then a notification is sent to the new user.

If you deselect this option, then you can send the email later by running the Send User Name and Password Email Notifications process. An appropriate notification template must be enabled at that time.

Completing Employment Information

Follow these steps:

1. Select a **Person Type** value.
2. Select **Legal Employer** and **Business Unit** values.

Adding Roles

Follow these steps:

1. Click **Autoprovision Roles**. Any roles for which the user qualifies automatically, based on the information that you have entered so far, appear in the Role Requests table.

   ➤ **Note:** If you linked an existing user account, then any roles that were already assigned externally and manually to the account appear in the Roles section. When you click **Autoprovision Roles**, the user’s entitlement to those roles is reviewed. If the user doesn’t qualify for the roles, based on the employment information entered so far, then their removal is requested.

2. To provision a role manually to the user, click **Add Role**. The **Add Role** dialog box opens.
3. Search for and select the role. The role must appear in a role mapping for which you satisfy the role-mapping conditions and where the **Requestable** option is selected for the role.

   The selected role appears in the Role Requests region with the status **Add requested**. The role request is created when you click **Save and Close**.

   Repeat steps 2 and 3 for additional roles.
4. Click **Save and Close**.
5. Click **Done**.

FAQs for Creating Application Users
How can I create a user account for a new worker?

When you create a person record, an Oracle Fusion Applications user account is created automatically if automatic creation of accounts is enabled. If a user account isn’t created automatically, then an authorized user can create it on the Security Console or using SCIM (REST) APIs. You can link such an account to the person record on the Manage User Account or Create User page.

How can I create a user account for an existing worker?

On the Manage User Account page, select **Create User Account**. Update account details, if appropriate, and click **Save**. Once the request is processed successfully, the account becomes available.

If automatic creation of accounts is disabled, then you can’t use the Create User Account action. Instead, authorized users can create user accounts on the Security Console.

Where do default user names come from?

User names are generated automatically in the format specified on the Security Console. The default format is the worker’s primary work email, but this value can be overridden for the enterprise. For example, your enterprise may use person number as the default user name.
10 Managing Application Users

Managing User Accounts: Procedure

Human resource specialists (HR specialists) can manage user accounts for users whose records they can access. This topic describes how to update a user account.

To access the user account page for a person:

1. Open the Person Management work area.
2. On the Search Person page, search for the person whose account you’re updating.
3. In the search results, select the person and select Actions > Personal and Employment > Manage User Account. The Manage User Account page opens.

Managing User Roles

To add a role:

1. Click Add Role.
   The Add Role dialog box opens.
2. In the Role Name field, search for the role that you want to add.
3. In the search results, select the role and click OK.
   The role appears in the Role Requests region with the status Add Requested.
4. Click Save.

To remove a role from any section of this page:

1. Select the role and click Remove.
2. In the Warning dialog box, click Yes to continue.
3. Click Save.

Clicking Save sends requests to add or remove roles to your LDAP directory server. Requests appear in the Role Requests in the Last 30 Days section. Once provisioned, roles appear in the Current Roles section.

To update a user’s roles automatically, select Actions > Autoprovision Roles. This action applies to roles for which the Autoprovision option is selected in all current role mappings. The user immediately:

- Acquires any role for which he or she qualifies but doesn’t currently have
- Loses any role for which he or she no longer qualifies

You’re recommended to autoprovision roles for individual users if you know that additional or updated role mappings exist that affect those users.

Copying Personal Data to LDAP

By default, changes to personal data, such as person name and phone, are copied to your LDAP directory periodically. To copy any changes immediately:

1. Select Actions > Copy Personal Data to LDAP.
2. In the Copy Personal Data to LDAP dialog box, click Overwrite LDAP.
Resetting Passwords

To reset a user’s password:

1. Select **Actions > Reset Password**.
2. In the **Warning** dialog box, click **Yes** to continue.
   
   This action sends a notification containing a reset-password link to the user’s work email.

   ✷ **Note**: A notification template for the password reset event must exist and be enabled. Otherwise, no notification is sent.

Editing User Names

To edit a user name:

1. Select **Actions > Edit User Name**.
2. In the **Update User Name** dialog box, enter the user name and click **OK**. The maximum length of the user name is 80 characters.
3. Click **Save**.

   This action sends the updated user name to your LDAP directory. Once the request is processed, the user can sign in using the updated name. As the user receives no automatic notification of the change, you’re recommended to send the details to the user.

   ✷ **Tip**: Users can add roles, autoprovion roles, and copy their personal data to LDAP by selecting **Navigator > Me > Roles and Delegations**. Line managers can add, remove, and autoprovion roles and copy personal data to LDAP for their reports from the Directory or by selecting **Navigator > My Team > Users, Roles and Delegations**.

Changing User Names: Explained

By default, user names are generated automatically in the enterprise default format when you create a person record. Users who have the human resource specialist (HR specialist) role can change user names for existing HCM users whose records they can access. This topic describes the automatic generation of user names and explains how to change an existing user name.

User Names When Creating Users

You create an HCM user by selecting a task, such as Hire an Employee, in the New Person work area. The user name is generated automatically in the enterprise default format. This table summarizes the effects of the available formats for Oracle HCM Cloud users.

<table>
<thead>
<tr>
<th>User-Name Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>The worker’s work email is the user name. If you don’t enter the work email when hiring the worker, then it can be entered later on the Security Console. This format is used by default. A different default format can be selected on the Administration tab of the Security Console.</td>
</tr>
</tbody>
</table>
### User-Name Format

<table>
<thead>
<tr>
<th>User-Name Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FirstName. LastName</td>
<td>The user name is the worker’s first and last names separated by a single period.</td>
</tr>
<tr>
<td>FLastName</td>
<td>The user name is the worker’s last name prefixed with the initial of the worker’s first name.</td>
</tr>
<tr>
<td>Person number</td>
<td>If your enterprise uses manual numbering, then any number that you enter becomes the user name. Otherwise, the number is generated automatically and you can’t edit it. The automatically generated number becomes the user name.</td>
</tr>
</tbody>
</table>

> **Note:** If the default user-name rule fails, then a system user name can be generated. The option to generate a system user name is enabled by default but can be disabled on the Security Console.

### Existing User Names

HR specialists can change an existing user name on the Manage User Account page.

To change a worker’s user name:

1. Search for and select the worker in the Person Management work area.
2. For the selected worker, select **Actions > Personal and Employment > Manage User Account**. 
3. On the Manage User Account page, select **Actions > Edit User Name**.

The updated name, which can be in any format, is sent automatically to your LDAP directory server. The maximum length of the user name is 80 characters.

> **Tip:** When you change an existing user name, the user’s password and roles remain the same. However, the user receives no automatic notification of the change. Therefore, you’re recommended to send details of the updated user name to the user.

### Sending Personal Data to LDAP: Explained

User accounts for users of Oracle Fusion Applications are maintained on your LDAP directory server. By default, Oracle HCM Cloud sends some personal information about users to the LDAP directory. This information includes the person number, person name, phone, and manager of the person’s primary assignment. HCM Cloud shares these details to ensure that user-account information matches the information about users in HCM Cloud.

This topic describes how and when you can send personal information explicitly to your LDAP directory.

### Bulk Creation of Users

After loading person records using HCM Data Loader, for example, you run the process Send Pending LDAP Requests. This process sends bulk requests for user accounts to the LDAP directory.

When you load person records in bulk, the order in which they’re created in HCM Cloud is undefined. Therefore, a person’s record may exist before the record for his or her manager. In such cases, the Send Pending LDAP Requests process includes no manager details for the person in the user-account request. The LDAP directory information therefore differs from the
information that HCM Cloud holds for the person. To correct any differences between these versions of personal details, you run the Send Personal Data for Multiple Users to LDAP process.

The Send Personal Data for Multiple Users to LDAP Process

Send Personal Data for Multiple Users to LDAP updates the LDAP directory information to match information held by HCM Cloud. You run the process for either all users or changed users only, as described in this table.

<table>
<thead>
<tr>
<th>User Population</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All users</td>
<td>The process sends personal details for all users to the LDAP directory, regardless of whether they have changed since personal details were last sent.</td>
</tr>
<tr>
<td>Changed users only</td>
<td>The process sends only personal details that have changed since details were last sent to the LDAP directory (regardless of how they were sent). This option is the default setting.</td>
</tr>
</tbody>
</table>

> **Note:** If User Account Maintenance is set to **No** for the enterprise, then the process doesn’t run.

The process doesn’t apply to party users.

You must have the Human Capital Management Application Administrator job role to run this process.

The Copy Personal Data to LDAP Action

Users can copy their own personal data to the LDAP directory from the Manage User Account page. Human resource specialists and line managers can also perform this action for users whose records they can access. By default, personal data changes are copied periodically to the LDAP directory. However, this action is available for copying changes immediately, if necessary.

**Related Topics**

- User and Role-Provisioning Setup: Critical Choices

Processing a User Account Request: Explained

This topic describes the Process User Account Request action, which may appear on the Manage User Account page for users who have no user account.

The Process User Account Request Action

The Process User Account Request action is available when the status of the worker’s user account is either **Requested** or **Failed**. These values indicate that the account request hasn’t completed.

Selecting this action submits the request again. Once the request completes successfully, the account becomes available to the user. Depending on your enterprise setup, the user may receive an email containing the user name and password.
Role Provisioning

Any roles that the user will have appear in the Roles section of the Manage User Account page. You can add or remove roles before selecting the Process User Account Request action. If you make changes to roles, then you must click **Save**.

The Send Pending LDAP Requests Process

The Process User Account Request action has the same effect as the Send Pending LDAP Requests process. If Send Pending LDAP Requests runs automatically at intervals, then you can wait for that process to run if you prefer. Using the Process User Account Request action, you can submit user-account requests immediately for individual workers.

Linking Existing User Accounts to Person Records: Expained

By default, when you create person records, user accounts are created automatically in your LDAP directory and linked to those person records. However, this automatic creation of user accounts can be disabled for the enterprise. For example, you may have some other way of managing user accounts, or user accounts may already exist in your LDAP directory. In this case, you must link the existing user account manually to the person record. This topic explains how to link an existing user account to a person record in Oracle HCM Cloud. You must have access to the person record to perform this task.

Linking an Existing User Account

Follow these steps:

1. In the Person Management work area, search for and select the worker.
2. For the selected worker, select **Actions > Personal and Employment > Manage User Account**.
3. On the Manage User Account page, select **Actions > Create User Account**. This action is available only for workers who don’t yet have a linked user account.
   
   Autoprosioning runs automatically, and any roles for which the user qualifies, based on current employment information, appear in the Role Requests section.
4. In the Edit User Account Details section, click **Link User Account**.
5. In the **Link User Account** dialog box, search for and select the user name.
   
   The list contains only those user accounts that aren’t already linked to an Oracle HCM Cloud person record.
6. Click **OK** to close the **Link User Account** dialog box.
7. Click **Save**.

Any roles that were already assigned externally and manually to the linked user account appear in the Current Roles section. If the user doesn’t qualify for those roles, based on current employment information, then their removal is requested. The Role Requests section of the Manage User Account page shows the roles for which the user qualifies. You can add roles, as appropriate, before clicking **Save**.

You can also link an existing user account to a new person record on the Create User page.
Suspending User Accounts: Explained

By default, user accounts are suspended automatically when a user has no roles. This automatic suspension of user accounts is controlled by the User Account Maintenance enterprise option. Human resource (HR) specialists can also suspend a user account manually, if necessary. This topic describes how automatic account suspension and reactivation occur. It also explains how to suspend a user account manually.

Automatic Suspension of User Accounts

When you terminate a work relationship:

- The user loses any automatically provisioned roles for which he or she no longer qualifies. This deprovisioning is automatic.
- If the user has no other active work relationships, then the user also loses manually provisioned roles. These are:
  - Roles that he or she requested
  - Roles that another user, such as a line manager, provisioned to the user

If the user has other, active work relationships, then he or she keeps any manually provisioned roles.

When terminating a work relationship, you specify whether the user is to lose roles on the termination date or on the day following termination.

A terminated worker’s user account is suspended automatically at termination only if he or she has no roles. Users can acquire roles automatically at termination, if an appropriate role mapping exists. In this case, the user account remains active.

Automatic Reactivation of User Accounts

User accounts are reactivated automatically when you reverse a termination or rehire a worker. If you reverse the termination of a work relationship, then:

- The user regains any role that he or she lost automatically at termination. For example, if the user automatically lost roles that had been provisioned manually, then those roles are reinstated.

  **Note:** If you removed any roles from the user manually at termination, then you must restore them to the user manually, if required.

- The user loses any role that he or she acquired automatically at termination.
- If the user account was suspended automatically at termination, then it’s automatically reactivated.

The autoprovisioning process runs automatically when you reverse a termination. Therefore, the user’s roles are updated automatically as specified by current role mappings.

When you rehire a worker, the user account is reactivated automatically and roles are provisioned automatically as specified by current role mappings. In all other cases, you must reactivate suspended user accounts manually on the Edit User page.

**Tip:** Authorized users can also manage user account status directly on the Security Console.
Manual Suspension of User Accounts

To suspend a user account manually, HR specialists follow these steps:

1. Select **Navigator > My Team > Users, Roles and Delegations**.
2. Search for and select the user to open the Edit User page.
3. In the User Details section of the Edit User page, set the **Active** value to **Inactive**. You can reactivate the account by setting the **Active** value back to **Active**.
4. Click **Save and Close**.

**Note:** Role provisioning isn’t affected by the manual suspension and reactivation of user accounts. For example, when you reactivate a user account manually, the user’s autoprovisioned roles aren’t updated unless you click **Autoprovision Roles** on the Edit User page. Similarly, a suspended user account isn’t reactivated when you click **Autoprovision Roles**. You must explicitly reactivate the user account first.

IT security managers can lock user accounts on the Security Console. Locking a user account on the Security Console or setting it to **Inactive** on the Edit User page prevents the user from signing in.

**Related Topics**

- User Account Maintenance Option: Explained

Managing Application Users on the Security Console: Explained

Human resource specialists and line managers use the Manage User Account task for routine management of user accounts and role provisioning. Users can perform some tasks, such as requesting or delegating roles, on the My Account page. IT security managers can also manage user accounts, if appropriate. They perform relevant tasks on the User Accounts page of the Security Console. This topic summarizes the user-management tasks that IT security managers can perform.

User Management on the Security Console

On the User Accounts page of the Security Console, IT security managers can:

- Create and manage user accounts. Typically, only accounts for implementation users are created and managed in this way.
- Delete the account of an implementation user, if required. User accounts of application users should not be deleted.
- Lock and unlock user accounts. Users can’t sign in to locked accounts.
- Make user accounts active or inactive.
- Reset user passwords, provided that the **Administrator can manually reset password** option on the Security Console Administration page is selected.
Providing Read-Only Access: Procedure

Some users may need read-only access to Oracle HCM Cloud. For example:

- A help desk representative must replicate a user’s transaction without saving any changes.
- An auditor reviews application data for regulatory reasons but isn’t authorized to change anything.

Read-only access is controlled by the Read Only Mode (FND_READ_ONLY_MODE) profile option. This topic describes how to set Read Only Mode for specific users.

Setting the Read Only Mode Profile Option

To enable read-only mode for a user:

1. In the Setup and Maintenance work area, open the Tasks panel tab and select Search. On the Search page, search for and select the Manage Administrator Profile Values task.
2. In the Search section of the Manage Administrator Profile Values page, enter FND_READ_ONLY_MODE in the Profile Option Code field and click Search.
3. In the FND_READ_ONLY_MODE: Profile Values section of the page, click the New icon.
4. In the new row of the profile values table:
   a. Set Profile Level to User.
   b. In the User Name field, search for and select the user.
   c. Set Profile Value to Enabled to activate read-only access for the selected user.
5. Click Save and Close.

When the user next signs in, a page banner reminds the user that read-only mode is in effect and no changes can be made.

FAQs for Managing Application Users

What happens when I autoprovion roles for a user?

The role-provisioning process reviews the user’s assignments against all current role mappings. The user immediately:

- Acquires any role for which he or she qualifies but doesn’t have
- Loses any role for which he or she no longer qualifies

You’re recommended to autoprovion roles to individual users on the Manage User Account page when new or changed role mappings exist. Otherwise, no automatic updating of roles occurs until you next update the user’s assignments.
Why did some roles appear automatically?

In a role mapping:

- The conditions specified for the role match the user’s assignment attributes, such as job.
- The role has the Autoprovision option selected.

Why is the user losing roles automatically?

The user acquired these roles automatically based on his or her assignment information. Changes to the user’s assignments mean that the user is no longer eligible for these roles. Therefore, the roles no longer appear.

If a deprovisioned role is one that you can provision manually to users, then you can reassign the role to the user, if appropriate.

Why can't I see the roles that I want to provision to a user?

You can provision a role if a role mapping exists for the role, the Requestable option is selected for the role in the role mapping, and at least one of your assignments satisfies the role-mapping conditions. Otherwise, you can’t provision the role to other users.

What happens if I deprovision a role from a user?

The user loses the access to functions and data that the removed role was providing exclusively. The user becomes aware of the change when he or she next signs in.

If the user acquired the role automatically, then future updates to the user’s assignments may mean that the user acquires the role again.

What's a delegated role?

A job, abstract, or data role that a user, known as the delegator, assigns to another user, known as the proxy user.

You can delegate a role either for a specified period, such as a planned absence, or indefinitely.

What happens if I revoke user access from a person with multiple active work relationships?

The person loses roles provisioned automatically for assignments in this work relationship only.

The person keeps roles that were:

- Provisioned manually
• Acquired automatically for other active work relationships

If the person has roles at termination, then the user account remains active. Otherwise, it’s suspended automatically.

Why does this worker have no user account?

Automatic creation of user accounts may be disabled in your enterprise. In this case, your enterprise may be managing user accounts outside Oracle HCM Cloud. You can link such an account to the worker’s person record on the Manage User Account or Create User page.

What happens when I link a user account?

The request to link the person or party record to the account goes automatically to your LDAP directory. Once the account status is Active, current roles appear in the Roles section of the Manage User Account or Edit User page. At this point, the user can sign in. You’re recommended to notify the user when the account is linked.

What happens if I edit a user name?

The updated user name is sent to your LDAP directory for processing when you click Save on the Manage User Account or Edit User page. The account status remains Active, and the user’s roles and password are unaffected. As the user isn’t notified automatically of the change, you’re recommended to notify the user.

Only human resource specialists can edit user names.

What happens when I copy personal data to LDAP?

User accounts are defined in your LDAP directory. The LDAP directory also holds some personal information about users, such as name, work phone, and work location address. Changes to personal information in Oracle Human Capital Management Cloud are copied automatically at intervals to your LDAP directory. To send any changes immediately, you can perform the Copy Personal Data to LDAP action. This action is optional.

What happens if I send the user name and password?

The user name and password go to the work email of the user or user’s line manager, if any. Notification templates for this event must exist and be enabled.

You can send these details once only for any user. If you deselect this option on the Manage User Account or Create User page, then you can send the details later. To do this, run the Send User Name and Password Email Notifications process.

What happens if I reset a user’s password?

A notification containing a reset-password link is sent to the user’s work email. A notification template for this event must exist and be enabled.
How can I notify users of their user names and passwords?

You can run the Send User Name and Password Email Notifications process in the Scheduled Processes work area. For users for whom you haven’t so far requested an email, this process sends out user names and reset-password links. The email goes to the work email of the user or the user’s line manager. You can send the user name and password once only to any user. A notification template for this event must exist and be enabled.

Can I enable user impersonation?

No. The user impersonation feature (Set Preferences > Proxies) is disabled for Oracle Human Capital Management Cloud users. It can be enabled on request, but its use isn’t recommended. User impersonation allows a proxy user uncontrolled access to the personal data of the impersonated user. The proxy user acquires all of that user’s roles, which is unsafe if you use employee self-service.
Role Mappings: Explained

Roles give users access to data and functions. To provision a role to users, you define a relationship, called a role mapping, between the role and some conditions. This topic describes how to provision roles to users both automatically and manually. Use the Manage Role Provisioning Rules task in the Setup and Maintenance work area.

> Note: All role provisioning generates requests to provision roles. Only when those requests are processed successfully is role provisioning complete.

Automatic Provisioning of Roles to Users

Role provisioning occurs automatically if:

- At least one of the user’s assignments matches all role-mapping conditions.
- You select the Autoprovision option for the role in the role mapping.

For example, for the data role Sales Manager Finance Department, you could select the Autoprovision option and specify the conditions shown in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Finance Department</td>
</tr>
<tr>
<td>Job</td>
<td>Sales Manager</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
</tbody>
</table>

Users with at least one assignment that matches these conditions acquire the role automatically when you either create or update the assignment. The provisioning process also removes automatically provisioned roles from users who no longer satisfy the role-mapping conditions.

Manual Provisioning of Roles to Users

Users such as line managers can provision roles manually to other users if:

- At least one of the assignments of the user who’s provisioning the role, for example, the line manager, matches all role-mapping conditions.
- You select the Requestable option for the role in the role mapping.

For example, for the data role Training Team Leader, you could select the Requestable option and specify the conditions shown in this table.
Any user with at least one assignment that matches both conditions can provision the role Training Team Leader manually to other users.

Users keep manually provisioned roles until either all of their work relationships are terminated or you deprovision the roles manually.

### Role Requests from Users

Users can request a role when managing their own accounts if:

- At least one of their assignments matches all role-mapping conditions.
- You select the **Self-requestable** option for the role in the role mapping.

For example, for the data role Expenses Reporter you could select the **Self-requestable** option and specify the conditions shown in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Finance Department</td>
</tr>
<tr>
<td>System Person Type</td>
<td>Employee</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
</tbody>
</table>

Any user with at least one assignment that matches these conditions can request the role. Self-requested roles are defined as manually provisioned.

Users keep manually provisioned roles until either all of their work relationships are terminated or you deprovision the roles manually.

### Role-Mapping Names

Role mapping names must be unique in the enterprise. Devise a naming scheme that shows the scope of each role mapping. For example, the role mapping Autoprovisioned Roles Sales could include all roles provisioned automatically to workers in the sales department.
Creating a Role Mapping: Procedure

To provision roles to users, you create role mappings. This topic explains how to create a role mapping.

Sign in as IT Security Manager and follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Manage Role Provisioning Rules

2. In the Search Results section of the Manage Role Mappings page, click **Create**.

   The Create Role Mapping page opens.

Defining the Role-Mapping Conditions

Set values in the Conditions section to specify when the role mapping applies. For example, the values shown in this table limit the mapping to current employees of the Procurement Department in Denver whose job is Chief Buyer.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Procurement Department</td>
</tr>
<tr>
<td>Job</td>
<td>Chief Buyer</td>
</tr>
<tr>
<td>Location</td>
<td>Denver</td>
</tr>
<tr>
<td>System Person Type</td>
<td>Employee</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
</tbody>
</table>

Users must have at least one assignment that meets all these conditions.

Identifying the Roles

1. In the Associated Roles section, click **Add Row**.
2. In the **Role Name** field, search for and select the role that you’re provisioning. For example, search for the data role **Procurement Analyst Denver**.
3. Select one or more of the role-provisioning options shown in this table.

<table>
<thead>
<tr>
<th>Role-Provisioning Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestable</td>
<td>Qualifying users can provision the role to other users.</td>
</tr>
<tr>
<td>Self-Requestable</td>
<td>Qualifying users can request the role for themselves.</td>
</tr>
</tbody>
</table>
Role-Provisioning Option | Description
--- | ---
Autoprovion | Qualifying users acquire the role automatically.

Qualifying users have at least one assignment that matches the role-mapping conditions.

> **Note:** Autoprovision is selected by default. Remember to deselect it if you don’t want autoprovisioning.

The **Delegation Allowed** option indicates whether users who have the role or can provision it to others can also delegate it. You can’t change this value, which is part of the role definition. When adding roles to a role mapping, you can search for roles that allow delegation.

4. If appropriate, add more rows to the Associated Roles section and select provisioning options. The role-mapping conditions apply to all roles in this section.

5. Click **Save and Close**.

**Applying Autoprovisioning**

You’re recommended to run the process Autoprovision Roles for All Users after creating or editing role mappings and after loading person records in bulk. This process compares all current user assignments with all current role mappings and creates appropriate autoprovisioning requests.

**Role Mappings: Examples**

You must provision roles to users either automatically or manually. This topic provides some examples of typical role mappings to support automatic and manual role provisioning.

**Creating a Role Mapping for Employees**

All employees must have the Employee role automatically from their hire dates. In addition, the few employees who claim expenses must request the Expenses Reporting data role.

You create a role mapping called All Employees and enter the conditions shown in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Person Type</strong></td>
<td>Employee</td>
</tr>
<tr>
<td><strong>HR Assignment Status</strong></td>
<td>Active</td>
</tr>
</tbody>
</table>

In the role mapping you include the:

- Employee role, and select the Autoprovion option
• Expenses Reporting role, and select the **Self-requestable** option

## Creating a Role Mapping for Line Managers

Any type of worker can be a line manager in the sales business unit. You create a role mapping called Line Manager Sales BU and enter the conditions shown in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Unit</td>
<td>Sales</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
<tr>
<td>Manager with Reports</td>
<td>Yes</td>
</tr>
</tbody>
</table>

You include the Line Manager role and select the **Autoprovision** option. Any worker with at least one assignment that matches the role-mapping conditions acquires the role automatically.

In the same role mapping, you can include roles that line managers can:

- Provision manually to other users.
  
  You select the **Requestable** option for these roles.

- Request for themselves.
  
  You select the **Self-requestable** option for these roles.

**Tip:** The **Manager with Reports** attribute always means a line manager. Setting the **Manager Type** attribute to **Line Manager** is the same as setting **Manager with Reports** to **Yes**. If your role mapping applies to managers of a type other than Line Manager, then don't set the **Manager with Reports** attribute.

## Creating a Role Mapping for Retirees

Retired workers have system access to manage their retirement accounts. You create a role mapping called All Retirees and enter the conditions shown in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Person Type</td>
<td>Retiree</td>
</tr>
<tr>
<td>HR Assignment Status</td>
<td>Inactive</td>
</tr>
</tbody>
</table>

You include the custom role Retiree in the role mapping and select the **Autoprovision** option. When at least one of a worker's assignments satisfies the role-mapping conditions, he or she acquires the role automatically.
Role Provisioning and Deprovisioning: Explained

You must provision roles to users. Otherwise, they have no access to data or functions and can't perform application tasks. This topic explains how role mappings control role provisioning and deprovisioning. Use the Manage Role Provisioning Rules or Manage HCM Role Provisioning Rules task to create role mappings.

Role Provisioning Methods

You can provision roles to users:

- Automatically
- Manually
  - Users such as line managers can provision roles manually to other users.
  - Users can request roles for themselves.

For both automatic and manual role provisioning, you create a role mapping to specify when a user becomes eligible for a role.

Role Types

You can provision data roles, abstract roles, and job roles to users. However, for Oracle HCM Cloud users, you typically include job roles in HCM data roles and provision those data roles.

Automatic Role Provisioning

Users acquire a role automatically when at least one of their assignments satisfies the conditions in the relevant role mapping. Provisioning occurs when you create or update worker assignments. For example, when you promote a worker to a management position, the worker acquires the line manager role automatically if an appropriate role mapping exists. All changes to assignments cause review and update of a worker’s automatically provisioned roles.

Role Deprovisioning

Users lose automatically provisioned roles when they no longer satisfy the role-mapping conditions. For example, a line manager loses an automatically provisioned line manager role when he or she stops being a line manager. You can also manually deprovision automatically provisioned roles at any time.

Users lose manually provisioned roles automatically only when all of their work relationships are terminated. Otherwise, users keep manually provisioned roles until you deprovision them manually.

Roles at Termination

When you terminate a work relationship, the user automatically loses all automatically provisioned roles for which he or she no longer qualifies. The user loses manually provisioned roles only if he or she has no other work relationships. Otherwise, the user keeps manually provisioned roles until you remove them manually.
The user who’s terminating a work relationship specifies when the user loses roles. Deprovisioning can occur:

- On the termination date
- On the day after the termination date

If you enter a future termination date, then role deprovisioning doesn’t occur until that date or the day after. The Role Requests in the Last 30 Days section on the Manage User Account page is updated only when the deprovisioning request is created. Entries remain in that section until they’re processed.

Role mappings can provision roles to users automatically at termination. For example, a terminated worker could acquire the custom role Retiree at termination based on assignment status and person type values.

Reversal of Termination

Reversing a termination removes any roles that the user acquired automatically at termination. It also provisions roles to the user as follows:

- Any manually provisioned roles that were lost automatically at termination are reinstated.
- As the autoprovisioning process runs automatically when a termination is reversed, roles are provisioned automatically as specified by current role-provisioning rules.

You must reinstate manually any roles that you removed manually, if appropriate.

Date-Effective Changes to Assignments

Automatic role provisioning and deprovisioning are based on current data. For a future-dated transaction, such as a future promotion, role provisioning occurs on the day the changes take effect. The Send Pending LDAP Requests process identifies future-dated transactions and manages role provisioning and deprovisioning at the appropriate time. These role-provisioning changes take effect on the system date. Therefore, a delay of up to 24 hours may occur before users in other time zones acquire their roles.

Autoprositioning: Explained

Autoprositioning is the automatic allocation or removal of user roles. It occurs for individual users when you create or update assignments. You can also apply autoprositioning explicitly for the enterprise using the Autoprosition Roles for All Users process. This topic explains the effects of applying autoprositioning for the enterprise.

Roles That Autoprositioning Affects

Autoprositioning applies only to roles that have the Autoprosition option enabled in a role mapping.

It doesn’t apply to roles without the Autoprosition option enabled.

The Autoprosition Roles for All Users Process

The Autoprosition Roles for All Users process compares all current user assignments with all current role mappings.

- Users with at least one assignment that matches the conditions in a role mapping and who don’t currently have the associated roles acquire those roles.
• Users who currently have the roles but no longer satisfy the associated role-mapping conditions lose those roles. When a user has no roles, his or her user account is also suspended automatically by default.

The process creates requests immediately to add or remove roles. These requests are processed by the Send Pending LDAP Requests process. When running Autoprovion Roles for All Users, you can specify when role requests are to be processed. You can either process them immediately or defer them as a batch to the next run of the Send Pending LDAP Requests process. Deferring the processing is better for performance, especially when thousands of role requests may be generated. Set the Process Generated Role Requests parameter to No to defer the processing. If you process the requests immediately, then Autoprovion Roles for All Users produces a report identifying the LDAP request ranges that were generated. Requests are processed on their effective dates.

When to Run the Process
You’re recommended to run Autoprovion Roles for All Users after creating or editing role mappings. You may also have to run it after loading person records in bulk if you request user accounts for those records. If an appropriate role mapping exists before the load, then this process isn’t necessary. Otherwise, you must run it to provision roles to new users loaded in bulk. Avoid running the process more than once in any day. Otherwise, the number of role requests that the process generates may slow the provisioning process.

Only one instance of Autoprovion Roles for All Users can run at a time.

Autoprovioning for Individual Users
You can apply autoprovioning for individual users on the Manage User Account page.

Related Topics
• What happens when I autoprovion roles for a user?
• Scheduling the Send Pending LDAP Requests Process: Procedure

Editing Role Mappings: Points to Consider
On the Edit Role Mapping page, you can update a role mapping. Changes that you make to start and end dates, role-mapping conditions, and the associated roles may affect current role provisioning. This topic describes when such changes take effect. To edit a role mapping, perform the Manage Role Provisioning Rules task in the Setup and Maintenance work area.

Making Changes to Roles That Were Provisioned Automatically
Changes to roles that were provisioned automatically take effect as soon as one of the following occurs:

• The Autoprovion Roles for All Users process runs.
  
  This process compares all current user assignments with all current role mappings and updates role provisioning as appropriate. You’re recommended to run this process after creating or editing role mappings and after loading person records in bulk.

• A human resource specialist (HR specialist) or line manager clicks Apply Autoprovioning on the Manage User Account or Edit User page for individual users affected by the role mapping.
This action compares the user’s current assignments with all current role mappings and updates the user’s roles as appropriate.

- An HR specialist or line manager creates or updates assignments of users affected by the role mapping.

These actions cause a user’s roles to be reevaluated.

Making Changes to Requestable Roles

Changes to requestable roles take effect immediately. If you remove a requestable role from the role mapping or change the role-mapping conditions, then:

- Users who currently have the role keep it.

Users such as line managers provision requestable roles manually to other users. Users lose manually provisioned roles automatically only when all of their work relationships are terminated. Otherwise, users keep manually provisioned roles until you deprovision them manually.

- Users who could provision the role to other users can no longer do so, unless they satisfy any revised role-mapping conditions.

Making Changes to Self-Requestable Roles

Changes to self-requestable roles take effect immediately. If you remove a self-requestable role from the role mapping or change the role-mapping conditions, then:

- Users who currently have the role keep it.

Users lose manually provisioned roles automatically only when all of their work relationships are terminated. Otherwise, users keep manually provisioned roles until you deprovision them manually.

- Users who could request the role can no longer do so, unless they satisfy any revised role-mapping conditions.

FAQs for Provisioning Roles to Application Users

What's a role-mapping condition?

Most are assignment attributes, such as job or department. At least one of a user’s assignments must match all assignment values in the role mapping for the user to qualify for the associated roles.

What's the difference between HR Assignment Status and Assignment Status?

Use HR Assignment Status to specify whether qualifying assignments must be active or inactive.

Use Assignment Status to specify a subcategory, such as Active - Payroll Eligible or Suspended - No Payroll.

When you select an HR Assignment Status value, the corresponding Assignment Status values appear. For example, if HR Assignment Status is Inactive, then Assignment Status values have the prefix Inactive or Suspended.
What's an associated role in a role mapping?

Any role that you want to provision to users. You can provision data roles, abstract roles, and job roles to users. The roles can be either predefined or custom.

What's the provisioning method?

The provisioning method identifies how the user acquired the role. This table describes its values.

<table>
<thead>
<tr>
<th>Provisioning Method</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The user qualifies for the role automatically based on his or her assignment attribute values.</td>
</tr>
<tr>
<td>Manual</td>
<td>Either another user assigned the role to the user, or the user requested the role.</td>
</tr>
<tr>
<td>External</td>
<td>The user acquired the role outside Oracle Applications Cloud.</td>
</tr>
</tbody>
</table>
12 Reporting on Application Users and Roles

Running the User Details System Extract Report: Procedure

The Oracle BI Publisher User Details System Extract Report includes details of selected Oracle Fusion Applications user accounts. To run this report, you must have a data role providing view-all access to person records for the Human Capital Management Application Administrator job role.

To run the report:

1. In the Contents pane of the Reports and Analytics work area, select Shared Folders > Human Capital Management > Workforce Management > Human Resources Dashboard.
2. Select the User Details System Extract report.
3. In the report window, click More.
4. On the Oracle Business Intelligence page for the report, select either Open to run the report immediately or More > Schedule to schedule the report.

User Details System Extract Report Parameters

The Oracle BI Publisher User Details System Extract Report includes details of Oracle Fusion Applications user accounts. This topic describes the report parameters. Run the report in the Reports and Analytics work area.

Parameters

User Population

Enter one of the values shown in this table to identify user accounts to include in the report.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCM</td>
<td>User accounts with an associated HCM person record.</td>
</tr>
<tr>
<td>TCA</td>
<td>User accounts with an associated party record.</td>
</tr>
<tr>
<td>LDAP</td>
<td>Accounts for users in the PER_USERS table who have no person number or party ID. Implementation users are in this category.</td>
</tr>
<tr>
<td>ALL</td>
<td>HCM, TCA, and LDAP user accounts.</td>
</tr>
</tbody>
</table>

From Date

Accounts for HCM and LDAP users that exist on or after this date appear in the report. If you specify no From Date value, then the report includes accounts with any creation date, subject only to any To Date value.
From and to dates don’t apply to the TCA user population. The report includes all TCA users if you include them in the report’s user population.

**To Date**

Accounts for HCM and LDAP users that exist on or before this date appear in the report. If you specify no **To Date** value, then the report includes accounts with any creation date, subject only to any **From Date** value.

From and to dates don’t apply to the TCA user population. The report includes all TCA users if you include them in the report’s user population.

**User Active Status**

Enter one of the values shown in this table to identify the user-account status.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Include active accounts, which belong to users with current roles.</td>
</tr>
<tr>
<td>I</td>
<td>Include inactive accounts, which belong to users with no current roles.</td>
</tr>
<tr>
<td>All</td>
<td>Include both active and inactive user accounts.</td>
</tr>
</tbody>
</table>

**User Details System Extract Report**

The Oracle BI Publisher User Details System Extract Report includes details of Oracle Fusion Applications user accounts. This topic describes the report contents.

Run the report in the Reports and Analytics work area.

**Report Results**

The report is an XML-formatted file where user accounts are grouped by type, as follows:

- Group 1 (G_1) includes HCM user accounts.
- Group 2 (G_2) includes TCA party user accounts.
- Group 3 (G_3) includes LDAP user accounts.

The information in the extract varies with the account type.

**HCM User Accounts**

**Business Unit Name**

The business unit from the primary work relationship.
Composite Last Update Date
The date when any one of a number of values, including assignment managers, location, job, and person type, was last updated.

Department
The department from the primary assignment.

Worker Type
The worker type from the user’s primary work relationship.

Generation Qualifier
The user’s name suffix (for example, Jr., Sr., or III).

Hire Date
The enterprise hire date.

Role Name
A list of roles currently provisioned to workers whose work relationships are all terminated. This value appears for active user accounts only.

Title
The job title from the user’s primary assignment.

TCA User Accounts

Organizations
A resource group.

Roles
A list of job, abstract, and data roles provisioned to the user.

Managers
The manager of a resource group.

LDAP User Accounts

Start Date
The account’s start date.

Created By
The user name of the user who created the account.
Person User Information Reports

This topic describes the Person User Dashboard and Person User Information Oracle Business Intelligence Publisher reports. Use these reports to extract the history of a specified Oracle HCM Cloud user account. To run the reports, you must inherit the ORA_PER_MANAGE_USER_AND_ROLES_DUTY_OBI duty role. Several predefined job roles, including IT Security Manager and Human Resource Specialist, inherit this duty role.

To run the reports:

1. Open the Reports and Analytics work area.
2. Select All Folders > Shared Folders > Human Capital Management > Workforce Management > Human Resources Dashboard.

Both reports appear in the Human Resources Dashboard folder.

Running the Person User Information Reports

Use the Person User Dashboard report to display user account information, specifically the person ID, of a specified user. Follow these steps:

1. Click the Person User Dashboard entry.
2. On the Person User Summary page, complete the parameters shown in this table to filter the report and click Apply:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>The user’s display name, for example, John Gorman</td>
</tr>
<tr>
<td>Last Name</td>
<td>The user’s last name, for example, Gorman</td>
</tr>
<tr>
<td>Start Date</td>
<td>The user’s start date. Users with start dates equal to or later than this date may appear in the report.</td>
</tr>
</tbody>
</table>

3. Once you have identified the user of interest, copy the person ID from the Person User Information table in the report. You use this person ID in the Person User Information report.

Use the Person User Information report to display the detailed history of a specified user account. Follow these steps:

1. In the Human Resources Dashboard folder, click Person User Information.
2. On the Person User Detail page, complete either or both of the parameters shown in this table and click Apply:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>The user’s start date. Users with start dates equal to or later than this date may appear in the report.</td>
</tr>
<tr>
<td>Person ID</td>
<td>The person ID copied from the Person User Dashboard report.</td>
</tr>
</tbody>
</table>
The report output includes:

- Person information
- User history
- Assigned roles and details of the associated role mappings
- Role delegation details
- LDAP request details
- Work relationship and assignment information

To save either of the reports to a spreadsheet, select Actions > Export > Excel

User History Report

This topic describes the User History report, which extracts and formats the history of a specified Oracle HCM Cloud user account. Oracle Support may ask you to run this report to help diagnose user-related errors. To run the report, you must inherit the ORA_PER_MANAGE_USER_AND_ROLES_DUTY_OBI (Manage Users) duty role. Several predefined job roles, including IT Security Manager and Human Resource Specialist, inherit this duty role.

Follow these steps to run the report.

1. Select Navigator > My Team > Users, Roles and Delegations.
2. On the Search Person page, search for the person of interest.
3. In the search results, click the person name to open the Edit User page.
4. On the Edit User page, click Print User History. In the User History dialog box, you can review the report.
5. Click Cancel to close the User History dialog box.

Tip: You don’t have to view the report. You can select Print User History > Download to download the PDF file. The file name is in the format <person ID>_UserHistory.pdf.

This report is identical to the Person User Information report, which authorized users can run in the Reports and Analytics work area.

Report Contents

For the selected user, the report includes:

- Person information
- User history
- Provisioned roles and details of any associated role mappings
- Role delegation details
- LDAP request details
- Work relationship and assignment information
LDAP Request Information Reports

This topic describes the LDAP Request Dashboard and LDAP Request Information reports. Use these reports to extract information about the status of LDAP requests. To run the reports, you must have the IT Security Manager job role.

To run the reports:

1. Open the Reports and Analytics work area.
2. In the Contents pane, select Shared Folders > Human Capital Management > Workforce Management > Human Resources Dashboard.

Both reports appear in the Human Resources Dashboard folder.

Running the LDAP Request Information Reports

Use the LDAP Request Dashboard report to display summaries of requests in specified categories. Follow these steps:

1. In the Human Resources Dashboard folder, click LDAP Request Dashboard > More. The Oracle Business Intelligence Catalog page opens.
2. Find the LDAP Request Dashboard entry on the Business Intelligence Catalog page and click Open to open the report.
3. On the LDAP Request Dashboard page, complete the parameters shown in this table to filter the report and click Apply.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within the Last N Days</td>
<td>Enter a number of days. The report includes LDAP requests updated within the specified period.</td>
</tr>
<tr>
<td>Request Type</td>
<td>Select an LDAP request type. The value can be one of Create, Update, Suspend, Activate, UserRoles, Terminate, and All.</td>
</tr>
<tr>
<td>Request Status</td>
<td>Select an LDAP request status. The value can be one of Complete, Faulted, In Progress, Request, Part Complete, Suppressed, Rejected, Consolidated, and All.</td>
</tr>
</tbody>
</table>

The report output includes:

- A summary of the enterprise settings for user-account creation and maintenance.
- Numbers of LDAP requests by status and type in both tabular and graphical formats.
- A summary table showing, for each request type, its status, equivalent user status, any error codes and descriptions, and the number of requests. All values are for the specified period.

You can refresh the report to update it as requests are processed.

Use the LDAP Request Information report to review details of the LDAP requests in the LDAP requests table in Oracle HCM Cloud. Follow these steps:

1. In the Human Resources Dashboard folder, click LDAP Request Information > More. The Oracle Business Intelligence Catalog page opens.
2. Find the LDAP Request Information entry on the Business Intelligence Catalog page and click Open to open the report.
3. On the LDAP Request Information page, complete the parameters shown in this table to filter the report and click Apply.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within the Last N Days</td>
<td>Enter a number of days. The report includes LDAP requests updated within the specified period.</td>
</tr>
<tr>
<td>Request Type</td>
<td>Select an LDAP request type. The value can be one of Create, Update, Suspend, Activate, UserRoles, Terminate, and All.</td>
</tr>
<tr>
<td>Request Status</td>
<td>Select an LDAP request status. The value can be one of Complete, Faulted, In Progress, Request, Part Complete, Suppressed, Rejected, Consolidated, and All.</td>
</tr>
</tbody>
</table>

The report includes a table showing for each request:
- The request date and type
- Whether the request is active
- The request status and its equivalent user status
- Error codes and descriptions, if appropriate
- Requested user names, if any
- The person to whom the request relates
- When the request was created and last updated

To save either of the reports to a spreadsheet, select Actions > Export > Excel.

### Inactive Users Report

Run the Inactive Users Report to identify users who haven't signed in for a specified period.

To run the report:

1. In the Scheduled Processes work area, click Schedule New Process.
2. Search for and select the Import User Login History process.

**Note:** Whenever you run the Inactive Users Report process, you must first run the Import User Login History process. This process imports information that the Inactive Users Report process uses to identify inactive users. You're recommended to schedule Import User Login History to run daily.

3. When the Import User Login History process completes, search for and select the Inactive Users Report process.
4. In the Process Details dialog box, set parameters to identify one or more users.
5. Click Submit.

### Inactive Users Report Parameters

All parameters except Days Since Last Activity are optional.
**User Name Begins With**
Enter one or more characters.

**First Name Begins With**
Enter one or more characters.

**Last Name Begins With**
Enter one or more characters.

**Department**
Enter the department from the user’s primary assignment.

**Location**
Enter the location from the user’s primary assignment.

**Days Since Last Activity**
Enter the number of days since the user last signed in. Use this parameter to specify the meaning of the term inactive user in your enterprise. Use other parameters to filter the results.

This value is required and is 30 by default. This value identifies users who haven’t signed in during the last 30 or more days.

**Last Activity Start Date**
Specify the start date of a period in which the last activity must fall.

**Last Activity End Date**
Specify the end date of a period in which the last activity must fall.

**Viewing the Report**
The process produces an Inactive_Users_List_processID.xml file and a Diagnostics_processID.zip file.

The report includes the following details for each user who satisfies the report parameters:

- Number of days since the user was last active
- Date of last activity
- User name
- First and last names
- Assignment department
- Assignment location
- City and country
- Report time stamp
Note: The information in the report relating to the user’s latest activity isn’t based solely on actions performed by the user in the UI. Actions performed on behalf of the user, which create user sessions, also affect these values. For example, running processes, making web service requests, and running batch processes are interpreted as user activity.

Related Topics

- Importing User Login History: Explained

User Role Membership Report

The User Role Membership Report lists role memberships for specified users.
To run the report process:

1. Open the Scheduled Processes work area.
2. Search for and select the User Role Membership Report process.

User Role Membership Report Parameters

You can specify any combination of the following parameters to identify the users whose role memberships are to appear in the report.

Note: The report may take a while to complete if you run it for all users, depending on the number of users and their roles.

User Name Begins With

Enter one or more characters of the user name.

First Name Begins With

Enter one or more characters from the user’s first name.

Last Name Begins With

Enter one or more characters from the user’s last name.

Department

Enter the department from the user’s primary assignment.

Location

Enter the location from the user’s primary assignment.
Viewing the Report

The process produces a UserRoleMemberships_processID_CSV.zip file and a Diagnostics_processID.zip file. The UserRoleMemberships_processID_CSV.zip file contains the report output in CSV format. The report shows the parameters that you specified, followed by the user details for each user in the specified population. The user details include the user name, first and last names, user status, department, location, and role memberships.

User and Role Access Audit Report

The User and Role Access Audit Report provides details of the function and data security privileges granted to specified users or roles. This information is equivalent to the information that you can see for a user or role on the Security Console. This report is based on data in the Applications Security tables, which you populate by running the Import User and Role Application Security Data process.

To run the User and Role Access Audit Report:

1. In the Scheduled Processes work area, click **Schedule New Process**.
2. Search for and select the User and Role Access Audit Report.
3. In the **Process Details** dialog box, set parameters and click **Submit**.
4. Click **OK** to close the confirmation message.

User and Role Access Audit Report Parameters

**Population Type**

Set this parameter to one of these values to run the report for one user, one role, multiple users, or all roles.

- **All roles**
- **Multiple users**
- **Role name**
- **User name**

**User Name**

Search for and select the user name of a single user.

This field is enabled only when **Population Type** is **User name**.

**Role Name**

Search for and select the name of a single aggregate privilege or data, job, abstract, or duty role.

This field is enabled only when **Population Type** is **Role name**.

**From User Name Starting With**

Enter one or more characters from the start of the first user name in a range of user names.
This field is enabled only when **Population Type** is **Multiple users**. It enables you to report on a subset of multiple users.

**To User Name Starting With**

Enter one or more characters from the start of the last user name in a range of user names.

This field is enabled only when **Population Type** is **Multiple users**. It enables you to report on a subset of multiple users.

**User Role Name Starts With**

Enter one or more characters from the start of a role name.

This field is enabled only when **Population Type** is **Multiple users**. It enables you to report on a subset of all users and roles.

**Data Security Policies**

Select **Data Security Policies** to view the data security report for any population. If you leave the option deselected, then only the function security report is generated.

> **Note:** If you don’t need the data security report, then leave the option deselected to reduce the report processing time.

**Debug**

Select **Debug** to include the role GUID in the report. The role GUID is used to troubleshoot. Select this option only when requested to do so by Oracle Support.

**Viewing the Report Results**

The report produces either one or two .zip files, depending on the parameters you select. When you select **Data Security Policies**, two .zip files are generated, one for data security policies and one for functional security policies in a hierarchical format.

The file names are in the following format: `[FILE_PREFIX]_[PROCESS_ID]_[DATE]_[TIME]_[FILE_SUFFIX]`. The file prefix depends on the specified **Population Type** value.

This table shows the file prefix values for each population type.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>File Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>USER_NAME</td>
</tr>
<tr>
<td>Role name</td>
<td>ROLE_NAME</td>
</tr>
<tr>
<td>Multiple users</td>
<td>MULTIPLE_USERS</td>
</tr>
<tr>
<td>All roles</td>
<td>ALL_ROLES</td>
</tr>
</tbody>
</table>
This table shows the file suffix, file format, and file contents for each population type.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>File Suffix</th>
<th>File Format</th>
<th>File Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>DataSec</td>
<td>CSV</td>
<td>Data security policies. The .zip file contains one file for all users or roles. The data security policies file is generated only when Data Security Policies is selected.</td>
</tr>
</tbody>
</table>

**Note:** Extract the data security policies only when necessary, as generating this report is time consuming.

<table>
<thead>
<tr>
<th>Any</th>
<th>Hierarchical</th>
<th>CSV</th>
<th>Functional security policies in a hierarchical format. The .zip file contains one file for each user or role.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple users</td>
<td>CSV</td>
<td>CSV</td>
<td>Functional security policies in a comma-separated, tabular format.</td>
</tr>
<tr>
<td>All roles</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The process also produces a .zip file containing a diagnostic log.

For example, if you report on a job role at 13.30 on 17 December 2015 with process ID 201547 and the Data Security Policies option selected, then the report files are:

- ROLE_NAME_201547_12-17-2015_13-30-00_DataSec.zip
- ROLE_NAME_201547_12-17-2015_13-30-00_Hierarchical.zip
- Diagnostic.zip

### User Password Changes Audit Report

This report identifies users whose passwords were changed in a specified period. You must have the ASE_USER_PASSWORD_CHANGES_AUDIT_REPORT_PRIV function security privilege to run this report. The predefined IT Security Manager job role has this privilege by default.

To run the User Password Changes Audit Report:

1. Open the Scheduled Processes work area.
2. Click **Schedule New Process**.
3. Search for and select the User Password Changes Audit Report.
4. In the **Process Details** dialog box, set parameters and click **Submit**.
5. Click **OK** to close the **Confirmation** message.
User Password Changes Audit Report Parameters

**Search Type**
Specify whether the report is for all users, a single, named user, or a subset of users identified by a name pattern that you specify.

**User Name**
Search for and select the user on whom you want to report. This field is enabled only when Search Type is set to Single user.

**User Name Pattern**
Enter one or more characters that appear in the user names on which you want to report. For example, you could report on all users whose user names begin with the characters SAL by entering SAL%. This field is enabled only when Search Type is set to User name pattern.

**Start Date**
Select the start date of the period during which password changes occurred. Changes made before this date don’t appear in the report.

**To Date**
Select the end date of the period during which password changes occurred. Changes made after this date don’t appear in the report.

**Sort By**
Specify how the report output is sorted. The report can be organized by either user name or the date when the password was changed.

**Viewing the Report Results**
The report produces these files:

- UserPasswordUpdateReport.csv
- UserPasswordUpdateReport.xml
- Diagnostics_[process ID].log

For each user whose password changed in the specified period, the report includes:

- The user name.
- The first and last names of the user.
- The user name of the person who changed the password.
- How the password was changed:
  - ADMIN means that the change was made for the user by a line manager or the IT Security manager, for example.
SELF_SERVICE means that the user made the change by setting preferences or requesting a password reset, for example.

FORGOT_PASSWORD means that the user clicked the Forgot Password link when signing in.

- The date and time of the change.

FAQs for Reporting on Application Users and Roles

Can I extract details of all Oracle Fusion Applications users?

Yes. The Oracle BI Publisher report User Details System Extract provides details of user accounts. For example, you can produce a report showing all user accounts, inactive user accounts, or accounts created between specified dates. To run the report, you need a data role that provides view-all access to person records for the Human Capital Management Application Administrator job role.

How can I find out which roles a user has?

Search for and select the user on the Roles tab of the Security Console. In the visualization area, you can see the user's role hierarchy in tabular or graphical format.

Alternatively, you can run the User Role Membership Report for one or more users.
13 HCM Data Roles and Security Profiles

HCM Data Roles: Explained

HCM data roles combine a job role with the data that users with the role must access. You identify the data in security profiles. As data roles are specific to the enterprise, no predefined HCM data roles exist.

To create an HCM data role, you perform the Assign Security Profiles to Role task in the Setup and Maintenance work area. After implementation, you can also perform this task in the Workforce Structures work area. The Assign Security Profiles to Role task opens the Manage Data Roles and Security Profiles page. You must have the IT Security Manager job role to perform this task.

Job Role Selection

When you create an HCM data role, you include a job role. The HCM object types that the job role accesses are identified automatically, and sections for the appropriate security profiles appear.

For example, if you select the job role Human Resource Analyst, then sections for managed person, public person, organization, position, LDG, document type, and payroll flow appear. You select or create security profiles for those object types in the HCM data role.

If you select a job role that doesn’t access objects secured by security profiles, then you can’t create an HCM data role.

🔗 Note: You must ensure that the job role doesn’t have directly assigned security profiles. Search for the job role on the Manage Data Roles and Security Profiles page. In the search results, confirm that no check mark appears in the Security Profiles Assigned column. If security profiles are assigned to the job role, then you must revoke them before including the job role in an HCM data role. You can reassign the security profiles to the job role after creating the HCM data role.

Security Profiles

For each object type, you can include only one security profile in an HCM data role.

Components of the HCM Data Role

The following figure summarizes the components of an HCM data role.

The job role that you select in the HCM data role is granted many function security privileges and data security policies directly. It also inherits many aggregate privileges, and may inherit some duty roles. Each aggregate privilege or duty role has its own function security privileges and related data security policies. Relevant HCM object types are identified automatically from the data security policies that the job role is granted either directly or indirectly. The specific instances of the objects
required by this HCM data role are identified in security profiles and stored in a data instance set. This figure shows these components of the HCM data role.

For example, the human resource specialist job role inherits the Manage Work Relationship and Promote Worker aggregate privileges, among many others. The aggregate privileges provide both function security privileges, such as Manage Work Relationship and Promote Worker, and access to objects, such as Assignment. Security profiles identify specific instances of those objects for the HCM data role, such as persons with assignments in a specified legal employer.

HCM Security Profiles: Explained

Security profiles identify instances of Human Capital Management (HCM) objects. For example, a person security profile identifies one or more Person objects, and a payroll security profile identifies one or more Payroll objects. This topic describes how to create and use security profiles and identifies the HCM objects that need them. To manage security profiles, you must have the IT Security Manager job role.

Use of HCM Security Profiles

You include security profiles in HCM data roles to identify the data that users with those roles can access. You can also assign security profiles directly to abstract roles, such as employee. However, you’re unlikely to assign them directly to job roles, because users with same job role usually access different sets of data.
HCM Object Types
You can create security profiles for the following HCM object types:

- Person
  - Managed Person
  - Public Person
- Organization
- Position
- Legislative Data Group (LDG)
- Country
- Document Type
- Payroll
- Payroll Flow

Two uses exist for the person security profile because many users access two distinct sets of people.

- The Managed Person security profile identifies people you can perform actions against.
- The Public Person security profile identifies people you can search for in the worker directory.

This type of security profile also secures some lists of values. For example, the Change Manager and Hire pages include a person list of values that the public person security profile secures. The person who’s selecting the manager for a worker may not have view access to that manager through a managed person security profile.

Security Criteria in HCM Security Profiles
In a security profile, you specify the criteria that identify data instances of the relevant type. For example, in an organization security profile, you can identify organizations by organization hierarchy, classification, or name. All criteria in a security profile apply. For example, if you identify organizations by both organization hierarchy and classification, then only organizations that satisfy both criteria belong to the data instance set.

Access to Future-Dated Objects
By default, users can’t access future-dated organization, position, or person objects.

To enable access to future-dated:

- Organizations, select the Include future organizations option in the organization security profile
- Positions, select the Include future positions option in the position security profile
- Person records, select the Include future people option in the person security profile

Security Profile Creation
You can create security profiles either individually or while creating an HCM data role. For standard requirements, it’s more efficient to create the security profiles individually and include them in appropriate HCM data roles.

To create security profiles individually, use the relevant security profile task. For example, to create a position security profile, use the Manage Position Security Profile task in the Setup and Maintenance or Workforce Structures work area.
Security profiles that provide view-all access are predefined.

Reuse of Security Profiles
Regardless of how you create them, all security profiles are reusable.

You can include security profiles in other security profiles. For example, you can include an organization security profile in a position security profile to secure positions by department or business unit. One security profile inherits the data instance set defined by another.

Predefined HCM Security Profiles: Explained
The Oracle Human Capital Management Cloud security reference implementation includes the predefined HCM security profiles shown in this table.

<table>
<thead>
<tr>
<th>Security Profile Name</th>
<th>Security Profile Type</th>
<th>Data Instance Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>View All People</td>
<td>Person</td>
<td>All person records in the enterprise</td>
</tr>
<tr>
<td>View Own Record</td>
<td>Person</td>
<td>The signed-in user’s own person record and the person records of that user’s contacts</td>
</tr>
<tr>
<td>View Manager Hierarchy</td>
<td>Person</td>
<td>The signed-in user’s line manager hierarchy</td>
</tr>
<tr>
<td>View All Workers</td>
<td>Person</td>
<td>The person records of all people with currently active or suspended assignments in the enterprise</td>
</tr>
<tr>
<td>View All Organizations</td>
<td>Organization</td>
<td>All organizations in the enterprise</td>
</tr>
<tr>
<td>View All Positions</td>
<td>Position</td>
<td>All positions in the enterprise</td>
</tr>
<tr>
<td>View All Legislative Data Groups</td>
<td>LDG</td>
<td>All LDGs in the enterprise</td>
</tr>
<tr>
<td>View All Countries</td>
<td>Country</td>
<td>All countries in the FND_ TERRITORIES table</td>
</tr>
<tr>
<td>View All Document Types</td>
<td>Document Type</td>
<td>All administrator-defined document types in the enterprise</td>
</tr>
<tr>
<td>View All Payrolls</td>
<td>Payroll</td>
<td>All payrolls in the enterprise</td>
</tr>
<tr>
<td>View All Flows</td>
<td>Payroll Flow</td>
<td>All payroll flows in the enterprise</td>
</tr>
</tbody>
</table>

You can include the predefined security profiles in any HCM data role, but you can’t edit them. The View all option is disabled in any security profile that you create. This restriction exists because predefined security profiles meet this requirement.
Creating an HCM Data Role: Worked Example

This example shows how to create an HCM data role.

Vision Corporation is a global enterprise with multiple legal employers. Each human resource (HR) specialist in Vision Corporation has a defined area of responsibility as the human resources representative for a single legal employer. This example shows how to create a single HCM data role that you can assign to all HR specialists in Vision Corporation. This data role secures access to person records based on each HR specialist’s area of responsibility.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which job role does the HCM data role include?</td>
<td>Human resource specialist</td>
</tr>
<tr>
<td>Can the role be delegated?</td>
<td>No</td>
</tr>
<tr>
<td>Which person records do users access?</td>
<td>Person records of all employees, contingent workers, pending workers, nonworkers, and candidates with job offers in the legal employer for which they have the specified responsibility</td>
</tr>
<tr>
<td>Which public person records do users access?</td>
<td>All</td>
</tr>
<tr>
<td>Which organizations do users access?</td>
<td>All</td>
</tr>
<tr>
<td>Which positions do users access?</td>
<td>All</td>
</tr>
<tr>
<td>Which countries do users see in lists of countries?</td>
<td>All</td>
</tr>
<tr>
<td>Which legislative data groups (LDGs) do users access?</td>
<td>All</td>
</tr>
<tr>
<td>Which document types do users access?</td>
<td>All</td>
</tr>
<tr>
<td>Which payrolls do users access?</td>
<td>All</td>
</tr>
<tr>
<td>Which payroll flows do users access?</td>
<td>All</td>
</tr>
</tbody>
</table>

Summary of the Tasks

Create the HCM data role by:

1. Naming the HCM data role and selecting the associated job role
2. Specifying the security criteria for each HCM object type
3. Creating any new security profiles
4. Reviewing and submitting the HCM data role

Prerequisites

Before you can perform these tasks:

1. HR specialists must have been identified for each legal employer.
2. An area of responsibility must have been created for each HR specialist. The Responsibility Type is set to Human resources representative, and the scope of responsibility is set to the relevant legal employer.
3. You must have confirmed that no security profiles are assigned directly to the Human Resource Specialist job role.

Naming the HCM Data Role and Selecting the Job Role

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role
2. In the Search Results section of the Manage Data Roles and Security Profiles page, click Create.
3. On the Create Data Role: Select Role page, complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role</td>
<td>Legal Employer HR Specialist</td>
</tr>
<tr>
<td>Job Role</td>
<td>Human Resource Specialist</td>
</tr>
<tr>
<td>Delegation Allowed</td>
<td>No</td>
</tr>
</tbody>
</table>

4. Click Next.

Specifying Security Criteria for Each HCM Object Type

1. In the Organization section of the Create Data Role: Security Criteria page, select the predefined organization security profile View All Organizations.
2. In the Position section, select the predefined position security profile View All Positions.
3. In the Countries section, select the predefined country security profile View All Countries.
4. In the Legislative Data Group section, select the predefined LDG security profile View All Legislative Data Groups.
5. In the Person section, complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Security Profile</td>
<td>Create New</td>
</tr>
<tr>
<td>Name</td>
<td>Workers by Legal Employer</td>
</tr>
<tr>
<td>Secure by Area of Responsibility</td>
<td>Yes</td>
</tr>
</tbody>
</table>
6. In the Public Person section, select the predefined person security profile View All People.
7. In the Document Type section, select the predefined document type security profile View All Document Types.
8. In the Payroll section, select the predefined payroll security profile View All Payrolls.
9. In the Payroll Flow section, select the predefined payroll flow security profile View All Flows.
10. Click **Next** until you reach the Assign Security Profiles to Role: Person Security Profile page.

### Creating the Person Security Profile

1. In the Area of Responsibility section, ensure that the **Secure by area of responsibility** option is selected.
2. Complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsibility Type</td>
<td>Human resources representative</td>
</tr>
<tr>
<td>Scope of Responsibility</td>
<td>Legal employer</td>
</tr>
</tbody>
</table>

3. Select the **Candidate with offer** option. Other worker-type options are selected by default.
4. Click **Review**.

### Review and Submit the HCM Data Role

1. Review the HCM data role.
2. Click **Submit**.
3. On the Manage Data Roles and Security Profiles page, search for the HCM data role. In the search results, confirm that the role status is **Requested**. When the role status is **Request Complete**, you can provision the role to users.

### Creating HCM Data Roles and Security Profiles: Points to Consider

Planning your use of HCM data roles and security profiles helps minimize maintenance and eases their introduction in your enterprise. This topic suggests some approaches.

#### Minimizing Numbers of Data Roles and Security Profiles

Secure access to person records based on a user’s areas of responsibility whenever possible. Using this approach, you can:

- Reduce dramatically the number of HCM data roles and security profiles that you must manage.
- Avoid the performance problems that can occur with large numbers of HCM data roles.
Identifying Standard Requirements

Most enterprises are likely to have some standard requirements for data access. For example, multiple HCM data roles may need access to all organizations in a single country. If you create an organization security profile that provides this access, then you can include it in multiple HCM data roles. This approach simplifies the management of HCM data roles and security profiles, and may also prevent the creation of duplicate security profiles.

Naming HCM Data Roles and Security Profiles

You're recommended to define and use a naming scheme for HCM data roles and security profiles.

A security profile name can identify the scope of the resulting data instance set. For example, the position security profile name All Positions Sales Department conveys that the security profile identifies all positions in the Sales Department.

An HCM data role name can include both the name of the inherited job role and the data scope. For example, the HCM data role Human Resource Specialist Legal Employer identifies both the job role and the role scope. HCM data role names must contain fewer than 55 characters.

Planning Data Access for Each HCM Data Role

An HCM data role can include only one security profile of each type. For example, you can include one organization security profile, one managed person security profile, and one public person security profile. Therefore, you must plan the requirements of any HCM data role to ensure that each security profile identifies all required data instances. For example, if a user accesses both legal employers and departments, then the organization security profile must identify both types of organizations.

Providing Access to All Instances of an Object

To provide access to all instances of an HCM object, use the appropriate predefined security profile. For example, to provide access to all person records in the enterprise, use the predefined security profile View All People.

Auditing Changes to HCM Data Roles and Security Profiles

A user with the Application Implementation Consultant job role can enable audit of changes to HCM data roles and security profiles for the enterprise.

Role Delegation: Explained

Role delegation is the assignment of a role from one user, known as the delegator, to another user, known as the proxy. The delegation can be either for a specified period, such as a planned absence, or indefinite.

You can delegate roles in the Roles and Approvals Delegated to Others section on the Manage User Account page. Select Navigator > Me > Roles and Delegations.

Actions Enabled by Delegation

The proxy user can perform the tasks of the delegated role on the relevant data. For example, a line manager can manage absence records for his or her reports. If that manager delegates the line manager role, then the proxy can also manage the absence records of the delegator’s reports. The delegator doesn’t lose the role while it’s delegated.
The proxy user signs in using his or her own user name, but has additional function and data privileges from the delegated role.

Proxy Users
You can delegate roles to any user whose details you can access by means of a public person security profile. This security profile typically controls access to person details in the worker directory.

Roles That You Can Delegate
You can delegate any role that you have currently, provided that:

- The role is enabled for delegation.
- The assignment that qualifies you for the role doesn't have a future-dated termination.

You can also delegate any role that you can provision to other users, provided that the role is enabled for delegation. By delegating roles rather than provisioning them to a user, you can:

- Specify a limited period for the delegation.
- Enable the proxy user to access your data.

Duplicate Roles
If the proxy user already has the role, then the role isn't provisioned again. However, the proxy user gains access to the data that's accessible using the delegator's role.

For example, you may delegate the line manager role to a proxy user who already has the role. The proxy user can access both your data (for example, your manager hierarchy) and his or her own data while the role is delegated.

The proxy's My Account page shows the delegated role in the Roles Delegated to Me section, even though only access to the associated data has been delegated.

Delegation from Multiple Delegators
Multiple users can delegate the same role to the same proxy for overlapping periods. If the proxy user already has the role, then the role isn't provisioned again. However, the proxy can access the data associated with the delegated roles. For example, three line managers delegate the line manager role to the same proxy for the following periods:

- Manager 1, January and February
- Manager 2, February and March
- Manager 3, January through April

This table shows by month which manager hierarchies the proxy can access.

<table>
<thead>
<tr>
<th>Month</th>
<th>Manager 1 Hierarchy</th>
<th>Manager 2 Hierarchy</th>
<th>Manager 3 Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>February</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>March</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
For example, the proxy can access the hierarchies of all three managers in February. If the proxy is a line manager, then the proxy can access his or her own manager hierarchy in addition to those from other managers.

Note: A single delegator can't delegate the same role to the same proxy more than once for overlapping periods.

Role Delegation Dates
You can enter both start and end dates or a start date only.

- If the start date is today’s date, then the delegation is immediate.
- If the start and end dates are the same, then the delegation is immediate on the start date. A request to end the delegation is generated on the same date and processed when the Send Pending LDAP Requests process next runs.
- If the start and end dates are different and in the future, then requests to start and end delegation are generated on the relevant dates. They’re processed when Send Pending LDAP Requests runs on those dates.
- If you change a delegation date to today’s date, then the change is immediate if the start and end dates are different. If they’re the same, then a request to end the delegation is generated and processed when Send Pending LDAP Requests next runs.
- If you enter no end date, then the delegation is indefinite.

Role delegation ends automatically if the proxy user’s assignment is terminated.

Enabling Role Delegation: Explained
By default, delegation isn’t enabled for any predefined HCM job or abstract role. You can change the delegation setting of any predefined HCM role, except the Employee and Contingent Worker abstract roles. You can also enable delegation for HCM data roles, custom job roles, and custom abstract roles.

This topic describes how to manage role delegation using the Assign Security Profiles to Role task in the Setup and Maintenance or Workforce Structures work area. You must have the IT Security Manager job role to manage role delegation.

Delegation of HCM Data Roles
When you create an HCM data role, you can indicate whether delegation is allowed on the Create Data Role: Select Role page.

When you edit an HCM data role, you can change the delegation setting on the Edit Data Role: Role Details page. If you deselect the Delegation Allowed option, then currently delegated roles aren’t affected.
**Note:** You can delegate HCM data roles in which access to person records is managed using custom criteria. However, the SQL predicate in the Custom Criteria section of the person security profile must handle the delegation logic.

Delegation of Custom Job and Abstract Roles

If you create an abstract role, then you can enable it for delegation when you assign security profiles to it directly. To assign security profiles to abstract roles, you perform the Assign Security Profiles to Role task. On the Edit Data Role: Role Details page, you select **Delegation Allowed**. As soon as you submit the role, delegation is enabled.

**Note:** You can’t delegate access to your own record. For example, you may assign the predefined View Own Record security profile to your custom role. Alternatively, you may create a person security profile that enables access to your own record and assign it to your custom role. In both cases, you can enable the role for delegation. Although the role itself can be delegated, access to your record isn’t delegated. However, the delegated role can provide access to other data instances.

You can enable custom job roles for delegation in the same way, but you’re unlikely to assign security profiles to them directly. Typically, job roles are inherited by HCM data roles, which you can enable for delegation.

Assigning Security Profiles to Job and Abstract Roles: Procedure

To give users access to data you usually create HCM data roles, which inherit job roles. However, you can also assign security profiles directly to job and abstract roles. You’re most likely to assign security profiles to abstract roles, such as Employee, to provide the data access that all employees need. For example, all employees must have access to the worker directory. You’re less likely to assign security profiles to job roles, as users with the same job role typically access different data instances.

This topic describes how to:

- Assign security profiles directly to a job or abstract role.
- Remove security profiles from a job or abstract role.

Assigning Security Profiles to Roles

You can assign security profiles to both predefined and custom job and abstract roles. Follow these steps to assign security profiles to a role:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role
2. On the Manage Data Roles and Security Profiles page, search for the job or abstract role.
3. In the search results, select the role and click **Edit**.
4. On the Edit Data Role: Role Details page, click **Next**.
5. On the Edit Data Role: Security Criteria page, select the security profiles that you want to assign to the role.
6. Click **Review**.
7. On the Edit Data Role: Review page, click **Submit**.

**Tip:** On the Manage Data Roles and Security Profiles page, search for the role again. In the search results, confirm that the **Assigned** icon, a check mark, appears in the **Security Profiles Assigned** column. The **Assigned** icon confirms that security profiles are assigned to the role.

### Revoking Security Profiles from Roles

You can remove security profiles that you assigned directly to a predefined or custom abstract or job role. For example, you may have assigned security profiles directly to a job role and included the job role in a data role later. In this case, users may have access to more data than you intended. Follow these steps to remove security profiles from a role:

1. On the Manage Data Role and Security Profiles page, search for the job or abstract role.
2. In the search results, select the role and confirm that security profiles are currently assigned to the role.
3. Click **Revoke Security Profiles**. All security profiles currently assigned directly to the role are revoked.

**Note:** To replace the security profiles in an HCM data role, edit the data role in the usual way. You can’t use the **Revoke Security Profiles** button.

### Previewing HCM Data Security: Explained

On occasion, users may report problems with accessing secured data, such as person and organization records. As users typically have multiple roles, diagnosing these problems can be challenging. To help you with this task, you can use the Preview HCM Data Security interface in the Workforce Structures work area. Using this interface, you can analyze a user’s data access based on all of his or her current roles and areas of responsibility. This topic explains how to use the Preview HCM Data Security interface.

#### Identifying the User

To start your analysis, you search for and select the user name. When you select the user, the following sections of the page are populated automatically.

<table>
<thead>
<tr>
<th>Page Section</th>
<th>Section Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currently Assigned Roles</td>
<td>The job, abstract, and data roles that the user currently inherits directly. This section also identifies security profiles assigned to those roles.</td>
</tr>
<tr>
<td>Currently Assigned Areas of Responsibility</td>
<td>Details of the user’s areas of responsibility, if any. You need this information when investigating access to person or position records if that access is secured by area of responsibility.</td>
</tr>
<tr>
<td>Session-Based Roles</td>
<td>The roles associated with the user’s latest session. Both directly and indirectly inherited roles are listed.</td>
</tr>
</tbody>
</table>

The user must have signed in at least once, as this information is taken from the user’s latest session.
Identifying the Privileges

Most data-access problems are of one of the following types:

- The user expects to access an instance of a secured object, such as a person record, but the record isn't found.
- The user expects to perform an action, such as Promote Worker, but the action isn't available.
- The user can access an instance of a secured object, such as a person record, but the record should not be accessible.
- The user can perform an action, such as Promote Worker, but the action should not be available.

To investigate these types of problems, start by identifying what the user was trying to do. For example, the user may have found the required person record but couldn't select the Promote Worker action. You then identify the data security privilege and data resource that control this access. If you know the names of the data security privilege and data resource, then you can select them in the Access Based on Privilege section. Alternatively, you can search for the associated data security policy by aggregate privilege name, for example. When you select a value in the search results, the Privilege and Data Resource fields are completed automatically.

Previewing Access

When the fields in the Access Based on Privilege section are complete, you click Preview Access. The Access Verification section of the page is updated automatically to identify every instance of the data security policy that's granted to the user. In the Verify Access For field, you select the secured record that's the subject of this investigation and click Verify. For example, you select the person record of the person the user couldn't promote. The section is updated automatically to show:

- The roles to which the data security policy is granted, and how the user inherits those roles
- The security profiles, if any, assigned to those roles
- Whether the roles make the record or action accessible to the user

This figure shows typical content of the Access Verification section.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Direct or Indirect</th>
<th>Inherited From</th>
<th>Security Profile Name</th>
<th>Record Accessible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Manager</td>
<td>Direct</td>
<td></td>
<td>View Manager Hierarchy</td>
<td>✔ Accessible</td>
</tr>
<tr>
<td>Promote Worker</td>
<td>Indirect</td>
<td>Line Manager</td>
<td></td>
<td>✗ Not accessible</td>
</tr>
</tbody>
</table>

When you click an instance of the role name in the Access Verification section, you see data security policy details, including the SQL predicate. The information provided by all sections of the Preview HCM Data Security page should be sufficient for you to diagnose and resolve most data-access issues.
Configuring HCM Data Roles and Security Profiles for Audit: Procedure

This procedure describes how to configure the attributes of HCM data roles and security profiles for audit. You must have the Application Implementation Consultant job role to perform this task.

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Application Extensions
   - Task: Manage Audit Policies

2. On the Manage Audit Policies page, click **Configure Business Object Attributes** in the Oracle Fusion Applications section.

3. On the Configure Business Object Attributes page, set **Product** to **HCM Core Setup**.

4. In the **Audit** column of the table of business objects that appears, select an object. For example, select **Person Security Profile** or **Data Role**.

5. In the Audited Attributes section of the page, a list of attributes for the object appears by default. Click **Create**.

   The **Select and Add Audit Attributes** dialog box opens.

6. In the **Select and Add Audit Attributes** dialog box, you can update the default selection of attributes to audit. For example you can deselect some attributes, if appropriate. Click **OK** to close the **Select and Add Audit Attributes** dialog box.

7. Click **Save and Close**.

8. On the Manage Audit Policies page, set **Audit Level** to **Auditing** in the Oracle Fusion Applications section.

9. Click **Save and Close**.

Changes made from now on to the selected attributes of the object are audited. A user who has the Internal Auditor job role can review audited changes on the Audit Reports page.

Related Topics

- [Auditing Oracle HCM Cloud Business Objects: Explained](#)

HCM Data Roles Configuration Diagnostic Test

The HCM Data Roles Configuration diagnostic test verifies that the Manage HCM Data Roles task flow is configured successfully for a specified user.

To run the HCM Data Roles Configuration diagnostic test, select **Settings and Actions > Run Diagnostics Tests**.

Diagnostic Test Parameters

**User Name**

The test is performed for the specified user. The user doesn’t have to be signed-in while the test is running. However, the user must have signed in at least once, because the test uses details from the user’s current or latest session.
HCM Security Profile Configuration Diagnostic Test

The HCM Security Profile Configuration diagnostic test verifies that the Manage Security Profiles task flows are configured successfully for a specified user.

To run the HCM Security Profile Configuration diagnostic test, select Settings and Actions > Run Diagnostics Tests.

Diagnostic Test Parameters

User Name
The test is performed for the specified user. The user doesn’t have to be signed-in while the test is running. However, the user must have signed in at least once, because the test uses details from the user’s current or latest session.

HCM Securing Objects Metadata Diagnostic Test

The HCM Securing Objects Metadata diagnostic test validates securing-object metadata for the HCM securing objects.

To run the HCM Securing Objects Metadata diagnostic test, select Settings and Actions > Run Diagnostics Tests.

Diagnostic Test Parameters

Securing Object
Enter the name of an HCM securing object from the following table.

<table>
<thead>
<tr>
<th>Securing Object Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERSON</td>
<td>Person</td>
</tr>
<tr>
<td>LDG</td>
<td>Legislative Data Group</td>
</tr>
<tr>
<td>POSITION</td>
<td>Position</td>
</tr>
<tr>
<td>ORGANIZATION</td>
<td>Organization</td>
</tr>
<tr>
<td>PAYROLL</td>
<td>Payroll</td>
</tr>
<tr>
<td>FLOWPATTERN</td>
<td>Payroll Flow</td>
</tr>
<tr>
<td>DOR</td>
<td>Document Type</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>Country</td>
</tr>
</tbody>
</table>
If you don’t enter the name of a securing object, then the test applies to all securing objects.

FAQs for HCM Data Roles and Security Profiles

What happens if I edit an HCM data role?

You can edit or replace the security profiles in an HCM data role. Saving your changes updates the relevant data instance sets. Users with this HCM data role find the updated data instance sets when they next sign in.

You can’t change the HCM data role name or select a different job role. To make such changes, you create a new HCM data role and disable this HCM data role, if appropriate.

How do I provision HCM data roles to users?

On the Create Role Mapping page, create a role mapping for the role.

Select the Autoprovision option to provision the role automatically to any user whose assignment matches the mapping attributes.

Select the Requestable option if any user whose assignment matches the mapping attributes can provision the role manually to other users.

Select the Self-Requestable option if any user whose assignment matches the mapping attributes can request the role.

What happens if I edit a security profile that’s enabled?

If the security profile is in use, then saving your changes updates the security profile’s data instance set. For example, if you remove a position from a position security profile, the position no longer appears in the data instance set. Users find the updated data instance set when they next access the data.

What happens if I disable a security profile?

The security profile returns no data. For example, a user with an HCM data role that allows the user to update organization definitions would continue to access organization-related tasks. However, the user couldn’t access organizations identified in a disabled organization security profile.

You can’t disable a security profile that another security profile includes.
How can I diagnose any issues with HCM data roles and security profiles?

Run the diagnostic tests shown in this table by selecting **Settings and Actions > Run Diagnostics Tests.**

<table>
<thead>
<tr>
<th>Diagnostic Test Name</th>
<th>Tests</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCM Data Roles Configuration</td>
<td>Configuration of Manage HCM Data Roles for a user</td>
</tr>
<tr>
<td>HCM Data Role Detailed Information</td>
<td>Potential problems with a data role</td>
</tr>
<tr>
<td>HCM Security Profile Configuration</td>
<td>Configuration of Manage Security Profiles tasks for a user</td>
</tr>
<tr>
<td>HCM Security Profiles Detailed Information</td>
<td>Potential problems with security profiles of a type</td>
</tr>
<tr>
<td>HCM Securing Objects Metadata</td>
<td>Securing-object metadata</td>
</tr>
</tbody>
</table>
Securing Person Records: Points to Consider

This topic describes ways of securing access to both public and managed person records. The recommended approaches minimize administration and improve security performance.

Securing Public Person Records

Public person records are those that all workers must access in a worker directory, for example. Use the View All Workers predefined security profile to provide this access. View All Workers provides access to:

- Employees, contingent workers, nonworkers, and pending workers
- The signed-in user’s own record
- Shared person information

View All Workers doesn’t provide access to future person records.

Securing Person Records by Manager Hierarchy

Managers must access the person records of the workers in their manager hierarchies. To provide this access, you secure person records by manager hierarchy. Use the predefined View Manager Hierarchy security profile wherever possible. This table summarizes the View Manager Hierarchy security profile. The values shown here are also the default values for these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person or Assignment Level</td>
<td>Person</td>
</tr>
<tr>
<td>Maximum Levels in Hierarchy</td>
<td>No maximum</td>
</tr>
<tr>
<td>Manager Type</td>
<td>Line Manager</td>
</tr>
<tr>
<td>Hierarchy Content</td>
<td>Manager Hierarchy</td>
</tr>
</tbody>
</table>

View Manager Hierarchy includes shared person information but not future person records.

For nonstandard requirements, create person security profiles. For example, if your enterprise has a custom Project Manager job role, then you can create a security profile for that manager type. Include it in an HCM data role and provision that role to all users who have the Project Manager job role.
Securing Person Records by Area of Responsibility

When you secure person records by area of responsibility, the set of records that a user can access is calculated dynamically. The calculation is based on the user’s assigned areas of responsibility. This approach has several advantages:

- It reduces the number of person security profiles and HCM data roles that you must manage.
- It improves security performance.
- You don't have to update security profiles when responsibilities change.

For example, consider the human resource (HR) specialists shown in this table. They perform the same job role but for workers in different business units.

<table>
<thead>
<tr>
<th>HR Specialist</th>
<th>Job Role</th>
<th>Business Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fen Lee</td>
<td>Human Resource Specialist</td>
<td>USA1 BU</td>
</tr>
<tr>
<td>John Gorman</td>
<td>Human Resource Specialist</td>
<td>USA2 BU</td>
</tr>
<tr>
<td>Jenna Markum</td>
<td>Human Resource Specialist</td>
<td>USA3 BU</td>
</tr>
</tbody>
</table>

To provide access to person records in each business unit, you:

- Define an area of responsibility for each HR specialist, where the scope of responsibility is the relevant business unit.
- Create a single person security profile that restricts access by area of responsibility and where Scope of Responsibility is Business unit.
- Create a single HCM data role to include the person security profile and assign it to all three HR specialists.
This figure summarizes the approach.

Tip: Scope of responsibility in a person security profile can be any one of several values, such as department or payroll. For users, define areas of responsibility based on a single scope value that you can also select in a person security profile.

When you secure access to person records by area of responsibility, the user doesn’t see all of the worker’s assignments. Instead:

- For current workers, authorized users can see current and suspended assignments only. Access to terminated assignments, such as those that were active before a global transfer, is prevented.
- For terminated workers, authorized users can see the most recently terminated assignment only.

Securing Access to Imported Candidates

You can secure access to the records of candidates imported from Oracle Taleo Recruiting Cloud Service. Set the Purpose field in the Basic Details section of the person security profile to one of these values:

- Imported Candidate Access
- Person and Imported Candidate Access

You can secure access to imported candidates by either area of responsibility or manager hierarchy.
The **Purpose** field is available only if the **Recruiting Integration** enterprise option is set to one of these values:

- Integrated with HCM Connect
- Fixed and Integrated with HCM Connect

Otherwise, the **Purpose** field doesn’t appear.

### Securing Person Records by Area of Responsibility: Procedure

In most cases, you secure access to person records by either manager hierarchy or area of responsibility. To secure by area of responsibility, you must first define areas of responsibility for relevant workers. This topic describes how to create a person security profile where access is secured by area of responsibility.

#### Defining the Person Security Profile

Follow these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Functional Area: Users and Security
   - Task: Manage Person Security Profile
2. On the Manage Person Security Profiles page, click **Create**.
3. In the Basic Details section of the Create Person Security Profile page, enter a name for the security profile. Complete other fields in the Basic Details section, as appropriate.
4. In the Area of Responsibility section, select **Secure by area of responsibility**.
5. Select a **Responsibility Type** value. For example, select **Benefits representative** or **Union representative**.
6. Select a **Scope of Responsibility** value. For example, if you select **Legal Employer**, then users can access person records in the legal employer for which they have the selected **Responsibility Type**. An area of responsibility can be based on multiple scope values, for example, both legal employer and job. In this case, only one of those values must be matched by the security profile.

   ✍ **Note:** The **Country** scope of responsibility identifies the country of the legal employer, not the country where the worker assignment is located.

7. All worker types, except **Candidate with offer**, are selected by default. Select and deselect worker types, as appropriate.
8. Click **Next**.

#### Previewing the Person Security Profile

On the Create Person Security Profile: Preview page, you can test the access that your security profile provides before you save it. Follow these steps:

1. On the Person Access Preview tab, select a user and click **Preview**. Typically, you select a user who has the area of responsibility that you identified when defining the security profile.
   - The User Summary section of the page is updated automatically to show the number of person records that this user could access.
The Assigned Areas of Responsibility section of the tab shows the selected user's areas of responsibility.

**Note:** The results from the Person Access Preview are based on the current person security profile only. Users may have roles that provide access to other person records.

2. In the Search Person section of the tab, you can search for specific person records to which the security profile provides access. The search is within the set of person records that was identified when you clicked **Preview** for the named user. For example, if the preview identified 50 person records, then the search is of those 50 person records.

3. To view the SQL predicate generated by this security profile, click the SQL Predicate for Person Access tab.

4. Click **Save and Close** to save the security profile.

**Related Topics**

- Areas of Responsibility: Explained
- Setting Scope of Responsibility: Examples

**Securing Person Records by Manager Hierarchy: Points to Consider**

The person records that a manager can access depend on how you specify the manager hierarchy in the person security profile. This topic describes the effect of the **Person or Assignment Level** option, which you set to either **Person** or **Assignment**.

**Note:** The **Person or Assignment Level** option, regardless of its setting, controls access to person records. You can’t enable access to particular assignments.

Consider the following example manager hierarchy.

Harry is a line manager with two assignments. In his primary assignment, he manages Sven’s primary assignment. In his assignment 2, Harry manages Jane’s primary assignment. Monica is a line manager with one assignment. She manages Jane’s assignment 2 and Amir’s primary assignment. In her primary assignment, Jane manages Franco’s primary...
assignment. In her assignment 2, Jane manages Kyle’s primary assignment. This figure shows this example manager hierarchy.

![Manager Hierarchy Diagram]

**Note:** Managers other than line managers can access person records secured by manager hierarchy only if their roles have the appropriate access to functions and data. Providing this access is a security configuration task.

**Person-Level Manager Hierarchy**

When **Person or Assignment Level** is **Person**, the security profile includes any person reporting directly or indirectly to any of the manager’s assignments.

This table shows the person records that each of the three managers can access in a person-level manager hierarchy.

<table>
<thead>
<tr>
<th>Manager</th>
<th>Sven</th>
<th>Jane</th>
<th>Franco</th>
<th>Kyle</th>
<th>Amir</th>
</tr>
</thead>
<tbody>
<tr>
<td>Harry</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Monica</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
The signed-in manager accesses the person records of every person in his or her manager hierarchy, subject to any other criteria in the security profile. For example, Harry can access Kyle’s person record, even though Kyle doesn’t report to an assignment that Harry’s manages.

### Assignment-Level Manager Hierarchy

When **Person or Assignment Level** is **Assignment**, managers see the person records of people who:

- Report to them directly from one or more assignments
- Report to assignments that they manage

This table shows the person records that each of the three managers can access in an assignment-level manager hierarchy.

<table>
<thead>
<tr>
<th>Manager</th>
<th>Sven</th>
<th>Jane</th>
<th>Franco</th>
<th>Kyle</th>
<th>Amir</th>
</tr>
</thead>
<tbody>
<tr>
<td>Harry</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Monica</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Jane</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

In this scenario:

- Harry accesses person records for Sven, Jane, and Franco. He can’t access Kyle’s record, because Kyle reports to an assignment that Monica manages.
- Monica accesses person records for Jane, Kyle, and Amir. She can’t access Franco’s record, because Franco reports to an assignment that Harry manages.
- Jane accesses person records for Franco and Kyle.

An assignment-level manager hierarchy isn’t the same as assignment-level security, which would secure access to individual assignments. You can’t secure access to individual assignments.

### Access to Terminated Workers

Line managers automatically lose access to terminated workers in their manager hierarchies on the day following the termination date.

**Related Topics**

- The Manager Hierarchy: How It’s Maintained
Specifying the Manager Type: Explained

When you secure person records by manager hierarchy, the security profile’s data instance set includes person records from manager hierarchies of the specified types. This topic describes the available type values and explains their effects. You select a Manager Type value when you perform the Manage Person Security Profile task.

This table describes the Manager Type values.

<table>
<thead>
<tr>
<th>Manager Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>The security profile includes all types of manager hierarchies.</td>
</tr>
<tr>
<td>Line Manager</td>
<td>The security profile includes only the line manager hierarchy.</td>
</tr>
<tr>
<td>Selected</td>
<td>The security profile includes only the specified type of manager hierarchy.</td>
</tr>
</tbody>
</table>

Typically, you select Line Manager for line managers, Project Manager for project managers, and so on. If you select All, then users with the line manager job role, for example, have line-manager access to all of their manager hierarchies. Avoid selecting All if this level of access isn’t required.

Manager Job Roles

Manager job roles other than line manager aren’t predefined. Creating job roles for managers such as project managers and resource managers is a security configuration task. Once those roles exist, you can assign security profiles to them either directly or by creating a separate HCM data role. Users with those roles can then access their manager hierarchies by selecting Navigator > My Team, for example.

Hierarchy Content: Explained

The Hierarchy Content attribute in a person security profile controls how access to manager hierarchies is delegated when you:

- Secure access to person records by manager hierarchy.
- Delegate a role that includes the person security profile.

To create a person security profile, use the Manage Person Security Profile task in the Setup and Maintenance work area.

Hierarchy Content Values

This table describes the Hierarchy Content values.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager hierarchy</td>
<td>The manager hierarchy of the signed-in user. This value is the default value.</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Don’t use this value if the associated role can be delegated.</td>
<td></td>
</tr>
<tr>
<td>Delegating manager hierarchy</td>
<td>The manager hierarchy of the delegating manager.</td>
</tr>
<tr>
<td></td>
<td>Select this value if the associated role is always delegated to a user who isn’t a manager and therefore has no manager hierarchy.</td>
</tr>
<tr>
<td>Both</td>
<td>The proxy user can access both his or her own manager hierarchy and the hierarchy of the delegating manager.</td>
</tr>
<tr>
<td></td>
<td>Select this value for the typical case of one manager delegating a line manager role to another manager.</td>
</tr>
</tbody>
</table>

When the line manager role is delegated to another line manager, the proxy can manage the delegator’s reports in the Person Management work area, for example. However, the proxy’s My Team information doesn’t show the delegator’s reports, because the manager hierarchy isn’t changed by the role delegation.

> **Note:** If the proxy user is in the delegator’s manager hierarchy, then the delegated role gives the proxy user access to his or her own record.

## Securing Person Records by Person Type: Explained

You can secure access to person records based on either their system person type or their user person type. For example, you can secure access to the person records of workers whose system person type is Employee. When you secure by person type, you can access the person records of workers with active or suspended assignments only. You can’t access the person records of terminated workers. This topic explains the effect of the **Access** value when you secure access to person records by person type.

### Restricted Access

When you secure by person type and set **Access** to **Restricted**, any other criteria in the security profile also apply. For example, you can select the values shown in this table:

<table>
<thead>
<tr>
<th>Type</th>
<th>System Person Type</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>System person type</td>
<td>Employee</td>
<td>Restricted</td>
</tr>
<tr>
<td>System person type</td>
<td>Contingent worker</td>
<td>Restricted</td>
</tr>
</tbody>
</table>

If you also secure access to person records by manager hierarchy in the same person security profile, then both sets of criteria apply. That is:

- The user can access the person records of employees and contingent workers in his or her reporting hierarchy.
- The user can’t access person records of other types in the reporting hierarchy or person records outside the reporting hierarchy using this person security profile.
All Access

When you secure by person type and set *Access* to *All*, the other criteria in the security profile have no effect. For example, if you set *System Person Type* to *Employee* and *Access* to *All*, then users can access all employees in the enterprise. Other criteria in the security profile, if any, are ignored for the selected worker type.

Securing Access to Candidates with Job Offers: Explained

Candidates with job offers from Oracle Recruiting Cloud have offer assignments in Oracle Human Capital Management Cloud. You can secure access to candidates with job offers based on these offer assignments. Therefore, a recruiter or human resource specialist can manage candidates with job offers securely in Oracle HCM Cloud before onboarding begins. This topic describes how to secure access to candidates with job offers.

Securing Access to Candidates with Job Offers

To secure access by area of responsibility, you select **Candidate with offer** in the Area of Responsibility section of the Create Person Security Profile page. Alternatively, you can select the **Access to candidates with offer** option in the Basic Details section of the Create Person Security Profile page. This option enables you to secure access to person records, including those of candidates with job offers, by criteria other than area of responsibility. For example, you can secure access by manager hierarchy. You can also secure access by workforce structures and global name range if those sections appear in the person security profile. The Workforce Structures and Global Name Range sections appear only if you upgraded from Release 11 to Release 12.

**Tip:** You can’t select both **Access to candidates with offer** and **Candidate with offer**. When you select **Secure by area of responsibility**, the **Access to candidates with offer** option is no longer available in the Basic Details section.

Ending Access to Candidates with Job Offers

When a candidate with a job offer becomes a pending worker, employee, or contingent worker, the offer assignment becomes inactive. You lose access to the person records of candidates with job offers when their offer assignments are inactive if:

- You can access only the inactive offer assignment, and the person security profile that secures your access evaluates active and suspended assignments only.
- Your access is secured by area of responsibility, and you don’t have that responsibility for the newly hired worker.
- The candidate is a rehire, and your previous access was based on the most recently terminated assignment. You lose that access when the worker has an active assignment if you don’t also have access to that active assignment.

Securing Person Records Using Custom Criteria: Examples

You can secure person records by either area of responsibility or manager hierarchy. You can also specify custom criteria, in the form of SQL statements, in addition to or in place of the standard criteria. This topic shows how to specify custom criteria in a person security profile when you perform the Manage Person Security Profile task.
The custom criteria can include any statement where the SQL predicate restricts by PERSON_ID or ASSIGNMENT_ID. The custom predicate must include either `&TABLE_ALIAS.PERSON_ID` or `&TABLE_ALIAS.ASSIGNMENT_ID` as a restricting column in the custom criteria.

Identifying Persons Born Before a Specified Date

This scenario shows how to use custom criteria in a person security profile. The person security profile data instance set must include persons who were born before 01 January, 1990.

You secure person records by custom criteria, and enter the following statement:

```
&TABLE_ALIAS.PERSON_ID IN (SELECT PERSON_ID FROM PER_PERSONS
WHERE DATE_OF_BIRTH < TO_DATE('01-JAN-1990', 'DD-MON-YYYY'))
```

- **Note:** You can include multiline comments in your SQL statements. Multiline comments start with a slash and an asterisk (`/*`) and end with an asterisk and a slash (`*/`). Single-line comments, which start with two hyphens (`--`), aren’t valid.

Defining Exceptions to Areas of Responsibility

You may want to exclude some worker records from the data instance set defined by an area of responsibility. For example, a worker may have access to all workers in an organization, except those in specific grades or locations. In these cases, you use custom criteria.

In very simple cases, you can use both the Area of Responsibility and Custom Criteria sections of the person security profile. You use the custom criteria to define just the exceptions in addition to any criteria specified in the Area of Responsibility section. More typically, especially where the exclusion is based on assignment values, you’re recommended to use only the Custom Criteria section. This approach is recommended for performance reasons.

- **Tip:** Use the Area of Responsibility section temporarily to define the basic access. Copy the SQL predicate from the SQL Predicate for Person Access tab on the Create Person Security Profile: Preview page to use as the basis of your custom criteria.

Tables and Views in Custom Criteria: Explained

You can secure access to person records using custom criteria in the form of SQL predicates. This topic identifies tables and views that you can’t use in custom SQL statements. The use of any of these tables or views is likely to cause errors, where the error message contains the text `ORA28113: POLICY PREDICATE HAS ERROR`.

This table identifies tables and views that you must not include in custom SQL statements when securing access to person records.

<table>
<thead>
<tr>
<th>Product</th>
<th>Table or View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contracts</td>
<td>- OKC_EMPLOYEE_CONTACT_V</td>
</tr>
<tr>
<td></td>
<td>- OKC_SEARCH_EMPLOYEE_V</td>
</tr>
<tr>
<td>Product</td>
<td>Table or View</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Oracle Human Capital Management Cloud</td>
<td></td>
</tr>
<tr>
<td>Securing HCM</td>
<td></td>
</tr>
<tr>
<td>Chapter 14</td>
<td></td>
</tr>
<tr>
<td>Person Security Profiles</td>
<td></td>
</tr>
<tr>
<td>OKC_SEARCH_INT_CONTACTS_V</td>
<td></td>
</tr>
<tr>
<td>OKC_SIGNER_CONTACTS_V</td>
<td></td>
</tr>
<tr>
<td>Financials for EMEA</td>
<td>JE_RU_FA_EMPLOYEE_V</td>
</tr>
<tr>
<td>General Ledger</td>
<td>GL_HIERVIEW_PERSON_INFO_V</td>
</tr>
<tr>
<td>Global Human Resources</td>
<td></td>
</tr>
<tr>
<td>HR_BU_LOCATIONS_X</td>
<td></td>
</tr>
<tr>
<td>HR_LOCATIONS</td>
<td></td>
</tr>
<tr>
<td>HR_LOCATIONS_ALL</td>
<td></td>
</tr>
<tr>
<td>HR_LOCATIONS_ALL_F</td>
<td></td>
</tr>
<tr>
<td>HR_LOCATIONS_ALL_F_VL</td>
<td></td>
</tr>
<tr>
<td>HR_LOCATIONS_ALL_VL</td>
<td></td>
</tr>
<tr>
<td>HR_LOCATIONS_ALL_X</td>
<td></td>
</tr>
<tr>
<td>PER_ADDRESSES_F</td>
<td></td>
</tr>
<tr>
<td>PER_ADDRESSES_FU_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_ADDRESSES_F</td>
<td></td>
</tr>
<tr>
<td>PER_ADDRESSES_F_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_CONT_WORKERS_CURRENT_X</td>
<td></td>
</tr>
<tr>
<td>PER_CONT_WORKERS_X</td>
<td></td>
</tr>
<tr>
<td>PER_DISPLAY_PHONES_V</td>
<td></td>
</tr>
<tr>
<td>PER_DRIVERS_LICENSES</td>
<td></td>
</tr>
<tr>
<td>PER_DRIVERS_LICENSES_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_DRIVERS_LICENSES_U_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_EMAIL_ADDRESSES</td>
<td></td>
</tr>
<tr>
<td>PER_EMAIL_ADDRESSES_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_EMAIL_ADDRESSES_U_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_EMAIL_ADDRESSES</td>
<td></td>
</tr>
<tr>
<td>PER_EMPLOYEES_CURRENT_X</td>
<td></td>
</tr>
<tr>
<td>PER_EMPLOYEES_X</td>
<td></td>
</tr>
<tr>
<td>PER_LOC_OTHER_ADDRESSES_V</td>
<td></td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS</td>
<td></td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS_U_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS</td>
<td></td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS_V</td>
<td></td>
</tr>
<tr>
<td>PER_PASSPORTS</td>
<td></td>
</tr>
<tr>
<td>PER_PASSPORTS_U_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_PASSPORTS</td>
<td></td>
</tr>
<tr>
<td>PER_PASSPORTS_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_ADDRESSES_V</td>
<td></td>
</tr>
<tr>
<td>PER_PHONES</td>
<td></td>
</tr>
<tr>
<td>PER_PHONES_U_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_PHONES</td>
<td></td>
</tr>
<tr>
<td>PER_PHONES_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_PHONES_V</td>
<td></td>
</tr>
<tr>
<td>PER_VISAS_PERMITS_F</td>
<td></td>
</tr>
<tr>
<td>PER_VISAS_PERMITS_U_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_VISAS_PERMITS_F_SEC</td>
<td></td>
</tr>
<tr>
<td>PER_VISAS_PERMITS_F</td>
<td></td>
</tr>
<tr>
<td>PER_WORKFORCE_CURRENT_X</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Table or View</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Global Payroll</td>
<td>• PAY_AMER_W4_LOC_ADDRESS_V</td>
</tr>
<tr>
<td></td>
<td>• PAY_AMER_W4_PERSON_ADDRESS_V</td>
</tr>
<tr>
<td>Grants Management</td>
<td>• GMS_ALL_CONTACTS_V</td>
</tr>
<tr>
<td></td>
<td>• GMS_INTERNAL_CONTACTS_V</td>
</tr>
<tr>
<td>Payments</td>
<td>• IBY_EXT_FD_EMP_HOME_ADDR</td>
</tr>
<tr>
<td>Planning Common Components</td>
<td>• MSC_AP_INTERNAL_LOCATIONS_V</td>
</tr>
<tr>
<td>Profile Management</td>
<td>• HRT_PERSONS_D</td>
</tr>
<tr>
<td></td>
<td>• HRT_PERSONS_X</td>
</tr>
<tr>
<td>Project Foundation</td>
<td>• PJF_PROJ_ALL_MEMBERS_V</td>
</tr>
<tr>
<td></td>
<td>• PRJ_PROJECT_MANAGER_V</td>
</tr>
<tr>
<td></td>
<td>• PRJ_TEAM_MEMBERS_F_V</td>
</tr>
<tr>
<td>Workforce Reputation Management</td>
<td>• HWR_VLTR_REGN_RGSTR_V</td>
</tr>
<tr>
<td></td>
<td>• HWR_VLTR_REGN_TOTAL_V</td>
</tr>
</tbody>
</table>

For more information about tables and views, see the Tables and Views for Oracle HCM Cloud guide.

**Related Topics**
- Tables and Views for Oracle HCM Cloud

**FAQs for Person Security Profiles**

**Can users see the contact records of the people they can access?**

Users who see the Contacts tab in the Manage Person work area can see a worker’s contacts, unless the contacts are workers. If a contact is a worker, then the contact’s details are secured by person security profile. Personally identifiable information (PII), such as phones and emails, isn’t visible unless the user inherits the Manage Contact Person PII aggregate privilege.

Any user can see the contact records of his or her own contacts.

**What happens if a person has multiple assignments or person types?**

A user who can access a person record can access all of the person’s assignments, regardless of the assignment type. The assignments can also be with different legal employers.
What happens if I include shared information in a person security profile?

Users can access any person information that’s shared with them. This access is in addition to the person records identified by the person security profile. If you leave this option deselected, then users can’t access shared person information unless the shared person record is identified by the person security profile.

What happens if I include future objects in a security profile?

Users can access future-dated persons, organizations, or positions that satisfy the security profile criteria. If you leave this option deselected, then users can’t access future-dated objects. For example, users couldn’t see an organization with a future start date, even though it satisfied all other criteria in the security profile. Date-effective records in objects aren’t affected by this option.

Can I secure access to person records by workforce structures or global name range?

Yes, but only if you upgraded from Release 11. If your implementation was new in Release 12 or later, then you can’t secure access to person records by workforce structures or global name range.
15 Organization and Other Security Profiles

Securing Organizations: Points to Consider

Some users maintain organization definitions. Others access lists of organizations while performing tasks such as creating assignments. The access requirements for these users differ. However, for both types of users you identify relevant organizations in an organization security profile. This topic discusses the effects of options that you select when creating an organization security profile. To create an organization security profile, use the Manage Organization Security Profile task.

Organizations with Multiple Classifications

Organizations may have more than one classification. For example, a department may also have the legal employer classification. An organization belongs to an organization security profile data instance set if it satisfies any one of the security profile’s classification criteria. For example, if you secure by department hierarchy only, a department that’s also a legal employer is included because it’s a department.

Securing by Organization Classification

To secure access to all organizations of a single classification, select the classification in the Secure by Organization section. For example, to secure access to all legal employers in the enterprise, set the Classification Name in the Secure by Classification section to Legal Employer. You can exclude selected legal employers from this access by listing them in the Organizations section and selecting Exclude in the Include or Exclude Organizations column.

Selecting the Top Organization in an Organization Hierarchy

If you select a named organization as the top organization in an organization hierarchy, then you must ensure that the organization remains valid. No automatic validation of the organization occurs, because changes to the organization hierarchy occur independently of the organization security profile.

Users With Multiple Assignments

You can select the department from the user’s assignment as the top organization in an organization hierarchy. Multiple top organizations may exist if the user has multiple assignments. In this case, all departments from the relevant subhierarchies of the organization hierarchy belong to the organization security profile data instance set.

The following figure illustrates the effects of this option when the user has multiple assignments.
The user has two assignments, one in department B and one in department D, which belong to the same organization hierarchy. The top organizations are therefore departments B and D, and the user’s data instance set of organizations therefore includes departments B, E, D, F, and G.

Creating Organization Security Profiles: Examples

An organization security profile identifies organizations by at least one of organization hierarchy, organization classification, and organization list.

These examples show some typical requirements for organization security profiles. Use the Manage Organization Security Profile task to create organization security profiles.

HR IT Administrator Who Maintains Organizations

The HR IT administrator maintains all types of organizations for the enterprise. The user’s access must reflect any changes to the organization hierarchy without requiring updates to the security profile. Therefore, you:

- Secure by organization hierarchy.
- Select a generic organization hierarchy. The security profile includes organizations of all classifications.
- Identify by name the top organization in the hierarchy. The top organization is unlikely to vary with the user’s own assignments.
If you secure by organization classification or list organizations by name, then you must maintain the security profile as the organization hierarchy evolves.

Human Resource Specialist Who Manages Employment Records in a Legal Employer

The human resource (HR) specialist accesses lists of various organizations, such as legal employers and business units, while managing employment information. To identify the organizations that the user can see in such lists, you:

- Secure by organization hierarchy.
- Select a generic organization hierarchy, because the user accesses more than one type of organization.
- Use the department from the user’s assignment as the top organization in the hierarchy. Using this value means that you can assign an HCM data role that includes this organization security profile to multiple HR specialists.

Securing Positions: Points to Consider

This topic describes some aspects to consider when deciding how to secure access to position records. It also describes how to preview the access provided by the security profile for a specified user before you save it.

Securing by Area of Responsibility

When you secure position records by area of responsibility, the set of records that the user can access is calculated dynamically. The calculation is based on the user’s assigned areas of responsibility. For example, a user may be the HR representative for a specific department. You create the position security profile based on these values. That is, you set Responsibility Type to Human resources representative and Scope to Department. In this case, any user who has that responsibility for a department can access position records defined for that department. If the user later becomes responsible for positions in a different department, then you update only that user’s area of responsibility. The position security profile remains valid without update. You can also create a single data role to include the position security profile and assign it to multiple representatives. The option to secure access by position list remains available, which enables you to refine further the list of positions that users can access. For performance reasons, you’re recommended to secure access to position records by area of responsibility whenever possible.

When you select the Area of Responsibility section in any position security profile, the Position Hierarchy and Workforce Structures sections become unavailable. These criteria are incompatible with securing by area of responsibility.

Securing by Position Hierarchy

Oracle HCM Cloud supports both position trees and the HCM Position Hierarchy. Depending on the values of the enterprise Position Hierarchy Configuration options, you can secure access to position records using either type of hierarchy.

Note: Any future enhancements related to position hierarchies will support only the HCM Position Hierarchy. Therefore, you should consider using the HCM Position Hierarchy rather than position trees.
You set the Position Hierarchy Configuration options on the Manage Enterprise HCM Information page. They determine whether the **Position Tree** field appears in the Position Hierarchy section of the Create Position Security profile page.

- If you select only **Use HCM Position Hierarchy**, then the **Position Tree** field is hidden.
- If you select only **Use Position Trees**, then the **Position Tree** field appears.
- If you select both options, then the **Hierarchy Type** field appears, where you can select either the HCM Position Hierarchy or the position tree.

When you edit an existing position security profile, the enterprise options have no effect. If the existing position security profile is based on the position tree, then the **Position Tree** field appears. Otherwise, the **Position Tree** field is hidden.

**Previewing the Security Profile**

Creating a position security profile is a two-step process. Once you have defined your security criteria, you click **Next** to open the Create Position Security Profile: Preview page. Here, you can test the access provided by the security profile before you save it. On the Position Access Preview tab, you can select a user and click **Preview**. This action returns the number of position records that this security profile allows the user to access. You also see the name and type of the user’s areas of responsibility, if any. You can then identify individual position records to which the security profile provides access by searching for them. The search is based on criteria such as position name, business unit, and incumbent. The search is performed within the set of position records that was returned by the Preview action.

You can review the automatically generated SQL predicate for your security criteria on the SQL Predicate for Position Access tab.

> **Note:** The results from the Position Access Preview are based on the current position security profile only. Users may have many roles that provide access to other position records.

**Related Topics**

- Areas of Responsibility: Explained
- Setting Scope of Responsibility: Examples

**Creating Position Security Profiles: Examples**

These scenarios show typical uses of position security profiles. To create a position security profile, use the Manage Position Security Profile task.

**Human Resource Specialist Who Manages Position Definitions**

Human resource (HR) specialists manage position definitions for specific business units. Each HR specialist has a defined area of responsibility, where the **Responsibility Type** is set to **Human resources representative** and the business unit is selected. In the position security profile, you:

- Secure by area of responsibility.
- Set **Responsibility Type** to **Human resources representative** and **Responsibility Scope** to **Business unit**.
You can include this security profile in a data role and provision the role to any HR specialist who manages positions in a business unit.

**Tip:** You can also secure by position list. For example, you could list positions to add to the set identified using area of responsibility.

### Line Manager Who Hires Workers

Line managers in your legal employer can hire workers whose positions are below the managers’ own positions in the position hierarchy. The managers’ positions must be associated with active assignments. Your enterprise is using the HCM Position Hierarchy. To identify these positions, you:

- Secure by position hierarchy.
- Set **Top Position** to **Use positions from all active user assignments**.
- Deselect **Include Top Position**.

You can include this position security profile in a data role and provision the role to any line manager in your legal employer.

### Creating Document Type Security Profiles: Examples

Some users manage document types for the enterprise. Others manage documents associated with the person records that they access. For example, workers manage their own documents. For all access requirements, you identify the document types that users can access in a document type security profile.

These scenarios show typical uses of document type security profiles. To create a document type security profile, use the Manage Document Type Security Profile task.

**Note:** Document type security profiles secure access to administrator-defined document types only. They don’t secure access to standard predefined document types, such as visas, work permits, and driver’s licenses. Access to person records provides access to the standard predefined document types.

### Workers Managing Their Own Documents

Workers can manage their own documents by editing their personal information. Implementors typically assign the predefined security profile **View All Document Types** directly to the employee and contingent worker roles. Workers can therefore access their own documents.

Alternatively, you can create a document type security profile that includes specified document types only. In the security profile, you list document types to either include or exclude. For example, you could create a document type security profile for workers that excludes disciplinary or medical documents. Workers would access all other document types.
Human Resource Specialists Managing Document Types

Human resource (HR) specialists who manage the enterprise document types must access all document types. You can provide this access by including the predefined security profile View All Document Types in the HCM data role for HR specialists. Using this security profile, HR specialists can also manage documents of administrator-defined types in the person records that they manage.

Legislative Data Group Security Profiles: Explained

You use a legislative data group (LDG) security profile to identify one or more LDGs to which you want to secure access. Use the Manage Legislative Data Group Security Profile task in the Setup and Maintenance work area.

View All Legislative Data Groups Security Profile

The predefined LDG security profile View All Legislative Data Groups provides access to all enterprise LDGs. Use this security profile wherever appropriate. For example, if users with a particular HCM data role manage all enterprise LDGs, then include View All Legislative Data Groups in that data role.

Creating LDG Security Profiles

If responsibility for particular LDGs belongs to various HCM data roles, then you create an appropriate LDG security profile for each data role. For example, you may need one LDG security profile for European LDGs and one for American LDGs.

Creating Payroll Security Profiles: Examples

These examples illustrate different methods you can use to provide access to payrolls for members of the Payroll department. You first organize your payroll definitions into appropriate payroll security profiles using the Manage Payroll Security Profiles task. Then you use the Assign Security Profiles to Role task to select the security profiles included in an HCM data role that you provision to a user.

Payroll Period Type

Using a payroll security profile to organize payroll definitions by payroll period type is the most common example. You create one security profile for monthly payrolls, another for semimonthly payrolls, and so on.

Regional Assignments

You can use payroll security profiles to group payrolls by the regions of the target employees’ work areas. For example, you can create one for Canadian facilities and another for European facilities.
Individual Contributors

Your company requires that payroll managers access only the payroll definitions that they manage. In this scenario, the payroll security profile includes only those payrolls.

Creating Flow Pattern Security Profiles: Examples

The following examples illustrate different methods you can use to organize payroll flows into appropriate security profiles. Use the Assign Security Profiles to Role task in the Setup and Maintenance work area to grant workers access to those profiles by data role.

Payroll Processing and QuickPay Flows

Payroll administrators are responsible for payroll processing. The payroll flow security profiles for the payroll administrator data role include the Payroll Cycle flow and the QuickPay flow.

End of Year Reporting

Some payroll administrators are responsible for year-end reporting. The payroll flow security profiles for their data role includes the End of Year flow and the Archive End-of-Year Payroll Results flow.

Hiring and Terminations

HR administrators are responsible for hiring and terminating employees. The payroll flow security profiles for the HR specialist data role includes the New Hire flow and the Termination flow.

Flow Security and Flow Owners: Explained

Your HCM data role security determines which flows you can submit or view. This topic explains how the HCM data roles and flow security work together. You define security for flow patterns using the Manage Payroll Flow Security Profile task in the Setup and Maintenance work area.

Submitting a flow generates a checklist of the included tasks. You become the owner of the flow and its tasks. If a flow pattern designates tasks to different owners, you remain the flow owner. Either you or the owner of a task can reassign the task to someone else, for example, to cover situations where the task is overdue and the task owner is on leave.
Payroll Flow Security and HCM Data Roles

HCM data roles secure the access to flows through data privileges and to the tasks on a checklist through functional privileges.

The following figure illustrates how the payroll manager and payroll administrator can submit a process or report and can view the results of the monthly payroll flow. Either the payroll manager or the payroll administrator can submit the flow and perform its tasks or have the tasks reassigned to them. The payroll manager and the payroll administrator can perform the same tasks because both of them have the same functional privileges. They can both submit and view the payroll flow data.

The following figure illustrates how only the payroll manager can calculate the payroll. The payroll manager can’t reassign this task to a payroll administrator, because the administrator doesn’t have the necessary functional privileges to submit the monthly payroll flow action.
Troubleshooting

The following table describes what action to take if you encounter problems submitting or completing a task in a flow.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can’t submit or view a flow</td>
<td>Confirm that the data role assigned to you includes a security profile for the payroll flow pattern.</td>
</tr>
<tr>
<td>Can’t perform a task, such as a process or report</td>
<td>Confirm that your data role is based on a job or abstract role that includes functional privileges to perform that task.</td>
</tr>
</tbody>
</table>

Related Topics

- Checklist and Flow Tasks: Explained
- Flow Pattern Parameters: Explained

FAQs for Organization and Other Security Profiles
What's the difference between a generic organization hierarchy and a department hierarchy?

A generic organization hierarchy is a single hierarchy that includes organizations of all classifications, such as division, legal entity, department, and tax reporting unit.

A department hierarchy includes only organizations with the department classification.

What happens if I select an organization security profile for a generic organization hierarchy?

If you secure by department, for example, the data instance set includes only organizations with the department classification from the generic organization hierarchy. The data instance set excludes other types of organizations.

Therefore, you can select the same organization security profile for multiple work structure types.

What happens if I use the department or position from the user's assignment as the top department or position?

The user’s access to the organization or position hierarchy depends on the user’s assignments. Therefore, the data instance set from a single security profile may be different for each user.

For a user with multiple assignments in the hierarchy, multiple top organizations or positions may exist. All organizations or positions from the relevant subhierarchies appear in the data instance set.

When do I need a country security profile?

Country security profiles identify one or more countries to appear in lists of countries. The predefined country security profile View All Countries meets most needs. However, you can limit the country list available to an HCM data role by creating a country security profile for that role. The countries that you can include are those defined in the table FND_TERRITORIES.

What happens if I include future objects in a security profile?

Users can access future-dated persons, organizations, or positions that satisfy the security profile criteria. If you leave this option deselected, then users can’t access future-dated objects. For example, users couldn’t see an organization with a future start date, even though it satisfied all other criteria in the security profile.

Date-effective records in objects aren’t affected by this option.
16 Using the Security Console

Graphical and Tabular Role Visualizations: Explained

On the Roles tab of the Security Console, you can review role hierarchies. You see either a tabular or a graphical view of a role hierarchy. Which view you see by default depends on the setting of the Enable default table view option on the Administration tab. This topic describes how to use each of these views.

Role hierarchies stretch from users at the top of the hierarchy to privileges at the bottom. In both graphical and tabular views, you can set the direction of the displayed hierarchy.

• To show from the selected user, role, or privilege up the hierarchy, set Expand Toward to Users.
• To show from the selected user, role, or privilege down the hierarchy, set Expand Toward to Roles.

The Tabular View

If the tabular view doesn’t appear when you select a security artifact on the Roles tab, then you can click the View as Table icon. In the tabular view, you can:

• Review the complete role hierarchy for a selected user or role. The table shows roles inherited both directly and indirectly.
• Search for a security artifact by entering a search term in the column search field and pressing Enter.
• Set the contents of the table as follows:
  o If Expand Toward is set to Privileges, then you can set Show to either Privileges or Roles.
  o If Expand Toward is set to Users, then you can set Show to either Roles or Users.

The resulting contents of the table depend on the start point. For example, if you select a privilege, Expand Toward is set to Privileges, and Show is set to Roles, then the table is empty.

• Export the displayed details to a Microsoft Excel spreadsheet.

The Graphical View

If the graphical view doesn’t appear when you select a security artifact on the Roles tab, then you can click the Show Graph icon. In the graphical view, users, privileges, and the various types of roles are represented by nodes and differentiated by both color and labels. These values are defined in the Legend. You can:

• Review roles inherited directly by the selected role or user. To see roles and privileges inherited indirectly, select a directly inherited role, right-click, and select either Expand or Expand All. Select Collapse or Collapse All to reverse the action. Alternatively, double-click a node to expand or collapse it.
• Use the Set as Focus action to make any selected node the center of the visualization.
• Use the Overview icon to manipulate the visualization. For example, clicking a node in the Overview moves the node to the center of the visualization. You can also use drag and drop.
• Hover on a legend entry to highlight the corresponding nodes in the visualization. Click a legend entry to add or remove corresponding nodes in the visualization.
In the Control Panel, you can:

- Switch the layout between radial and layered representations.
- Click the Search icon and enter a search term to find a security artifact among currently displayed nodes.
- Zoom in and out using either the Zoom in and Zoom out icons or the mouse wheel.
- Magnify areas of the visualization by clicking the Magnify icon and dragging it to the area of interest. Click the icon again to switch it off.
- Click the Zoom to Fit icon to center the image and fill the display area.

Simulating Navigator Menus: Procedure

You can simulate the Navigator for both users and roles. This feature can help you to identify how access is provided to specific work areas and tasks. You may need this information when creating roles, for example. This topic provides instructions for simulating the Navigator.

Simulating the Navigator for a Role

Follow these steps:

1. On the Roles tab of the Security Console, search for the role, which can be of any type.
2. In the search results, select Simulate Navigator in the Actions menu for the role. The Simulate Navigator page opens. Icons may appear against Navigator entries. In particular:
   - The Lock icon indicates that the role can’t access the entry.
   - The Warning icon indicates that the entry may not appear in the Navigator as the result of configuration, for example.
Entries without either of these two icons are available to the role.

Tip: To view just the entries that the role can access, set Show to Access granted.

Viewing Roles That Grant Access to a Navigator Entry

For any entry in the Navigator, regardless of whether it’s available to the role, you can identify the roles that grant access. Follow these steps:

1. Click the entry.
2. Select View Roles That Grant Access.
3. In the Roles That Grant Access dialog box, review the list of roles. The roles can be of all types. After reviewing this list, you can decide how to enable this access, if appropriate. For example, you may decide to provision an abstract role to a user or add an aggregate privilege to a custom role.
4. Click OK to close the Roles That Grant Access dialog box.

Viewing Privileges Required for Menu

For any entry in the Navigator, regardless of whether it’s available to the role, you can identify the privileges that grant access to:

- The Navigator entry
• Tasks in the associated work area

Follow these steps:

1. Click the entry.
2. Select View Privileges Required for Menu.
3. In the View Privileges for Work Area Access dialog box, review the list of privileges that grant access to:
   - The Navigator menu item
   - Task Panel entries in the associated work area. In the Access Granted column of this table, you can see whether the selected role can access these tasks.

   You can use this information when creating roles, for example. You can identify how to both add and remove access to specific tasks and work areas.
4. Click OK to close the View Privileges for Work Area Access dialog box.
5. Click Close to close the Simulate Navigator page.

Simulating the Navigator for a User

Search for the user on the Roles tab of the Security Console and select Simulate Navigator in the Actions menu for the user. Follow the instructions for simulating the Navigator for a role.

Reviewing Role Assignments: Procedure

You can use the Security Console to:

• View the roles assigned to a user.
• Identify users who have a specific role.

You must have the IT Security Manager job role to perform these tasks.

Viewing the Roles Assigned to a User

Follow these steps:

1. Open the Security Console.
2. On the Roles tab, search for and select the user.

   Depending on the enterprise setting, either a table or a graphical representation of the user's role hierarchy appears. Switch to the graphical representation if necessary to see the user and any roles that the user inherits directly. User and role names appear on hover. To expand an inherited role:

   a. Select the role and right-click.
   b. Select Expand. Repeat these steps as required to move down the hierarchy.

   Tip: Switch to the table to see the complete role hierarchy at once. You can export the details to Microsoft Excel from this view.
Identifying Users Who Have a Specific Role

Follow these steps:

1. On the Roles tab of the Security Console, search for and select the role.
2. Depending on the enterprise setting, either a table or a graphical representation of the role hierarchy appears. Switch to the graphical representation if it doesn’t appear by default.
3. Set Expand Toward to Users.

   **Tip:** Set the Expand Toward option to control the direction of the graph. You can move either up the hierarchy from the selected role (toward users) or down the hierarchy from the selected role (toward privileges).

In the refreshed graph, user names appear on hover. Users may inherit roles either directly or indirectly from other roles. Expand a role to view its hierarchy.

4. In the Legend, click the Tabular View icon for the User icon. The table lists all users who have the role. You can export this information to Microsoft Excel.

Reviewing Role Hierarchies: Explained

On the Security Console you can review the role hierarchy of a job role, an abstract role, a duty role, or an HCM data role. You must have the IT Security Manager job role to perform this task.

**Note:** Although you can review HCM data roles on the Security Console, you must manage them on the Manage HCM Data Role and Security Profiles page. Don’t attempt to edit them on the Security Console.

Follow these steps:

1. On the Roles tab of the Security Console, ensure that Expand Toward is set to Privileges.
2. Search for and select the role. Depending on the enterprise setting, either a table or a graphical representation of the role appears.
3. If the table doesn’t appear by default, click the View as Table icon. The table lists every role inherited either directly or indirectly by the selected role. Set Show to Privileges to switch from roles to privileges.

   **Tip:** Enter text in a column search field and press Enter to show only those roles or privileges that contain the specified text.

Click Export to Excel to export the current table data to Microsoft Excel.

Comparing Roles: Procedure

You can compare two roles to identify differences and similarities. The roles can be job roles, abstract roles, HCM data roles, duty roles, or aggregate privileges. You can compare roles of the same or different types. For example, you can compare a job role with a duty role or a custom job role with its predefined equivalent. This topic describes how to compare two roles.
Comparing Two Roles

Follow these steps:

2. In the **First Role** field, search for and select the first of the two roles to compare.
3. In the **Second Role** field, search for and select the second role.
4. Set **Filter Criteria** to one of these values to identify the security artifacts to compare in each of the roles:
   - Function security policies
   - Data security policies
   - Inherited roles
5. Set **Show** to one of the values shown in this table to identify the security artifacts to display in the comparison results:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All selected artifacts for both roles.</td>
</tr>
<tr>
<td>Only in first role</td>
<td>Selected artifacts that appear in the first role but not in the second role</td>
</tr>
<tr>
<td>Only in second role</td>
<td>Selected artifacts that appear in the second role but not in the first role</td>
</tr>
<tr>
<td>In both roles</td>
<td>Only those selected artifacts that appear in both roles</td>
</tr>
</tbody>
</table>

   For example, if you set **Filter Criteria** to **Inherited roles** and **Show** to **In both roles**, then you see the roles that both roles inherit. The comparison excludes any role that only one of the roles inherits.
6. Click **Compare**. You can query by example to filter the results. The comparison is refreshed automatically if you change the **Show** or **Filter Criteria** values.

   👁 **Tip:** Click **Export to Excel** to save the comparison data to a spreadsheet.
7. Click **Done** to close the Compare Roles page.

Alternative ways of comparing roles on the Roles tab exist. You can:

- In the search results, select **Compare Roles** from the Actions menu for a role in the search results
- In the graphical view of a role, select the role, right-click and select **Compare Roles**.

In both cases, the selected role becomes the first role in the role comparison.

Copying Privileges to the Second Role in the Comparison

You can make some updates to the second role in the comparison without having to edit the role explicitly. That is, you can copy a selected function or data security policy from the first role to the second role when you set:

- **Filter Criteria** to either Function security policies or Data security policies
- **Show** to Only in first role
Note: The second role in the comparison must be a custom role.

To copy a selected policy to the second role, you click Add to Second Role.

Reviewing Role Information on the Analytics Tab: Explained

All roles belong to a category. In most cases, the category identifies both the owning product family and the role type. For example, HCM - Job Roles, HCM - Duty Roles, and Common - Abstract Roles are role categories. This topic describes how to review statistics relating to role categories and details of individual roles on the Analytics tab of the Security Console.

On the Analytics tab, you can see these numbers for each role category:

- Roles in the category
- Role memberships (roles that are inherited by roles in this category)
- Function security policies granted to all roles in the category
- Data security policies granted to all roles in the category

This information appears in a table. The number of roles in each category also appears in a pie chart.

Reviewing Roles on the Analytics Tab

To review role details on the Analytics tab, follow these steps:

1. Select a role category to populate the Roles in Category section of the Analytics tab.
2. In the Roles in Category section, you see a list of all roles in the selected category. You can filter the list by entering a value in any of the column search fields and pressing Enter.
3. For a selected role, click the role name to open the Role Details page.
4. On the Role Details page, review the role’s:
   - Function security policies
   - Data security policies
   - Role hierarchy
   - User memberships (users who have the role)

Click Export to save this role information to a .csv file.

Security Console Analytics for Database Resources: Explained

You can review information about data security policies that grant access to a database resource, or about roles and users granted access to that resource.

To begin, select the Analytics tab, and then the Database Resources tab on the Analytics page. Select the resource you want to review in the Database Resource field. Then click Go. Results are presented in three tables.
Data Security Policies

The Data Security Policies table documents policies that grant access to the selected database resource.

Each row documents a policy, specifying by default:

- The data privileges it grants.
- The condition that defines how data is selected from the database resource.
- The policy name and description.
- A role that includes the policy.

For any given policy, this table may include multiple rows, one for each role in which the policy is used.

Authorized Roles

The Authorized Roles table documents roles with direct or indirect access to the selected database resource. Any given role may:

- Include one or more data security policies that grant access to the database resource. The Authorized Roles table includes one row for each policy belonging to the role.
- Inherit access to the database resource from one or more roles in its hierarchy. The Authorized Roles table includes one row for each inheritance.

By default, each row specifies:

- The name of the role it documents.
- The name of a subordinate role from which access is inherited, if any. (If the row documents access provided by a data security policy assigned directly to the subject role, this cell is blank.)
- The data privileges granted to the role.
- The condition that defines how data is selected from the database resource.

⚠️ Note: A role’s data security policies and hierarchy may grant access to any number of database resources. However, the Authorized Roles table displays records only of access to the database resource you selected.

Authorized Users

The Authorized Users table documents users who are assigned roles with access to the selected database resource.

By default, each row specifies a user name, a role the user is assigned, the data privileges granted to the user, and the condition that defines how data is selected from the database resource. For any given user, this table may include multiple rows, one for each grant of access by a data security policy belonging to, or inherited by, a role assigned to the user.

Manipulating the Results

In any of these three tables, you can:

- Add or remove columns. Select View - Columns.
- Search among the results. Select View - Query by Example to add a search field on each column in a table.
- Export results to a spreadsheet. Select the Export to Excel option available for each table.
Creating and Editing Job, Abstract, and Duty Roles

Copying HCM Roles: Points to Consider

Copying predefined roles and editing the copies is the recommended approach to creating roles. This topic describes what to consider when you’re copying a role.

Reviewing the Role Hierarchy

When you copy a predefined job, abstract, or duty role, you’re recommended first to review the role hierarchy. This review is to identify the inherited roles that you want to refer to, copy, or delete in your custom role. For example, the Payroll Manager job role inherits the Payroll Administrator job role, among others. When copying the Payroll Manager role, you must decide whether to copy the Payroll Administrator role, refer to it, or remove it from your copy. You can review the role hierarchy on the Roles tab of the Security Console in either graphical or tabular format. You can also:

- Export the role hierarchy to a spreadsheet from the Roles tab.
- Review the role hierarchy and export it to a spreadsheet from the Analytics tab.
- Run the User and Role Access Audit Report.

Tip: Aggregate privileges are never copied. When you copy a job or abstract role, its inherited aggregate privileges are referred to from your copy.

Reviewing Privileges

Job and abstract roles inherit function security privileges and data security policies from the roles that they inherit. Function security privileges and data security policies may also be granted directly to a job or abstract role. You can review these directly granted privileges on the Roles tab of the Security Console, as follows:

- In the graphical view of a role, its inherited roles and function security privileges are visible at the same time.
- In the tabular view, you set the Show value to switch between roles and function security privileges. You can export either view to a spreadsheet.

Once your custom role exists, edit it to add or remove directly granted function security privileges.

Note: Data security policies are visible only when you edit your role. You’re recommended to leave data security policies unchanged.

Transaction Analysis Duty Roles

Some roles, such as the Human Resource Analyst job role, inherit Transaction Analysis Duty roles, which are used in Oracle Transactional Business Intelligence report permissions. If you copy the Human Resource Analyst job role, or any other role that inherits Transaction Analysis Duty roles, then don’t copy the Transaction Analysis Duty roles. If you copy the roles, then you must update the permissions for the relevant reports to secure them using your copies of the roles. Instead, add the predefined Transaction Analysis Duty roles to your copy of the relevant job role, such as Human Resource Analyst.
Naming Copied Roles

By default, a copied role has the same name as its source role with the suffix Custom. The role codes of copied roles have the suffix _CUSTOM. Copied roles lose the prefix ORA_ automatically from their role codes. You can define a local naming convention for custom roles, with a prefix, suffix, or both, on the Administration tab of the Security Console.

**Note:** Copied roles take their naming pattern from the default values specified on the Administration tab of the Security Console. You can override this pattern on the Copy Role: Basic Information page for the role that you’re copying. However, the names of roles inherited by the copied role are unaffected. For example, if you perform a deep copy of the Employee role, then inherited duty roles take their naming pattern from the default values.

Duplicate Roles

If any role in the hierarchy already exists when you copy a role, then no copy of that role is made. For example, if you make a second copy of the Employee role, then copies of the inherited duty roles may already exist. In this case, membership is added to the existing copies of the roles. To create unique copies of inherited roles, you must enter unique values on the Administration tab of the Security Console before performing a deep copy.

To retain membership of the predefined job or abstract role hierarchy, perform a shallow copy of the predefined role.

**Related Topics**

- Setting Role Preferences: Explained
- User and Role Access Audit Report

Security Console Role-Copy Options: Explained

When you copy a role on the Security Console, you select one of the following options:

- Copy top role
- Copy top role and inherited roles

This topic explains the effects of each of these options.

Copy Top Role

If you select the Copy top role option, then only the top role from the selected role hierarchy is copied. Memberships are created for the copy in the roles of which the original is a member. That is, the copy of the top role references the inherited role hierarchy of the source role. Any changes made to those inherited roles appear in both the source role and the copy. Therefore, you must take care when you edit the role hierarchy of the copy. You can:

- Add roles directly to the copy without affecting the source role.
- Remove any role from the copy that it inherits directly without affecting the source role. However, if you remove any role that’s inherited indirectly by the copy, then any role that inherits the removed role’s parent role is affected.
- Add or remove function and data security privileges that are granted directly to the copy of the top role.

If you copy a custom role and edit any inherited role, then the changes affect any role that inherits the edited role.
The option of copying the top role is referred to as a shallow copy. This figure summarizes the effects of a shallow copy. It shows that the copy references the same instances of the inherited roles as the source role. No copies are made of the inherited roles.

You’re recommended to create a shallow copy unless you must make changes that could affect other roles or that you couldn’t make to predefined roles. To edit the inherited roles without affecting other roles, you must first make copies of those inherited roles. To copy the inherited roles, select the **Copy top role and inherited roles** option.

**Tip:** The Copy Role: Summary and Impact Report page provides a useful summary of your changes. Review this information to ensure that you haven’t accidentally made a change that affects other roles.

**Copy Top Role and Inherited Roles**

Selecting **Copy top role and inherited roles** is a request to copy the entire role hierarchy. These rules apply:

- Inherited aggregate privileges are never copied. Instead, membership is added to each aggregate privilege for the copy of the source role.
- Inherited duty roles are copied if a copy with the same name doesn’t already exist. Otherwise, membership is added to the existing copies of the duty roles for the new role.

When inherited duty roles are copied, custom duty roles are created. Therefore, you can edit them without affecting other roles. Equally, changes made subsequently to the source duty roles don’t appear in the copies of those roles. For example, if those duty roles are predefined and are updated during upgrade, then you may have to update your copies manually after upgrade. This option is referred to as a deep copy.
This figure shows the effects of a deep copy. In this example, copies of the inherited duty roles with the same name don’t already exist. Therefore, the inherited duty roles are copied when you copy the top role. Aggregate privileges are referenced from the new role.

Copying Abstract Roles: Explained

This topic provides guidance about copying abstract roles. This guidance also applies to job roles if you assign security profiles to them directly.

Copying Upgraded Abstract Roles with Inherited HCM, CRM, and FSCM Roles

This section describes how to copy abstract roles with assigned security profiles that were upgraded from Oracle Human Capital Management Cloud Release 11. This information doesn’t apply if:

- You didn’t upgrade abstract roles from Release 11.
- You upgraded abstract roles from Release 11, but you regenerated their data security policies after the upgrade.

The Simplified Reference Role Model was introduced in Release 10. In Releases 10 and 11, each predefined job role and abstract role was represented as an enterprise role. The enterprise role inherited an application role. When you assigned security profiles to an abstract role before Release 12, some additional roles were generated automatically. These additional roles had the name of the abstract role with the suffix (HCM), (CRM), or (FSCM). Data security policies were generated against these roles, which were inherited directly by the abstract role’s enterprise role. The presence of these roles means that the enterprise role was modified. This modification prevented the enterprise and application roles from being merged when the abstract roles were upgraded from Release 11.
As the enterprise and application roles for such abstract roles remain separate after the upgrade from Release 11, you must take care when copying them. If you perform a shallow copy of an upgraded enterprise role, then you keep membership of:

- The inherited (HCM), (CRM), and (FSCM) roles.
- The application role from the original role. If the application role is predefined, then you can’t edit it. Otherwise, any changes you make to the application role are also inherited by the role on which the copy was based.

Therefore, you’re recommended always to copy the application role and perform a shallow copy. If you must copy the enterprise role, then always perform a deep copy. Once the copy of the enterprise role exists, you must edit it to remove the inherited (HCM), (CRM), and (FSCM) roles. Otherwise, your custom role has the data security policies from the source role in addition to any that you create specifically for the custom role. The copied role can’t function as required unless you remove these roles.

**Copying Abstract Roles with Assigned Security Profiles**

This section provides guidance about copying roles in the following circumstances:

- You’re a new customer in Release 12 or later and are copying predefined abstract roles with assigned security profiles.
- You’re creating custom abstract roles, assigning security profiles to them directly, and then copying them.
- You upgraded from Release 11, regenerated the data security policies for an abstract role with assigned security profiles, and are now copying those roles.

In all of these cases, the data security policies from the assigned security profiles are granted to the top-level role. Therefore, if you copy an abstract role, you copy all of its data security policies, including those that were generated from the assigned security profiles. These data security policies can be difficult to remove successfully from the role copy on the Security Console. Therefore, to avoid copying unwanted data security policies, you’re recommended to revoke security profiles from abstract roles before you copy them. Reassign the security profiles to the abstract role when the copy is complete.

**Tip:** If you have already made a copy of a predefined abstract role with assigned security profiles, then you can remove the copied data security policies as follows:

1. Edit your custom role.
2. On the Data Security Policies page, filter by policy names beginning with the prefix ORA_. These policies were generated from security profiles assigned to the predefined abstract role that you copied.
3. Remove all policies beginning with ORA_ in the filtered list.

Any remaining data security policies are either predefined and should not be removed or generated from security profiles assigned to your custom role.

**Copying Job and Abstract Roles: Procedure**

You can copy any job role or abstract role and use it as the basis for a custom role. Copying roles is more efficient than creating them from scratch, especially if your changes are minor. This topic explains how to copy a role to create a role. You must have the IT Security Manager job role to perform this task.

**Copying a Role**

Follow these steps:

1. On the Roles tab of the Security Console, search for the role to copy.
2. Select the role in the search results. The role hierarchy appears in tabular format by default.

   **Tip:** Click the **Show Graph** icon to show the hierarchy in graphical format.

3. In the search results, click the down arrow for the selected role and select **Copy Role**.
4. In the **Copy Options** dialog box, select a copy option.
5. Click **Copy Role**.
6. On the Copy Role: Basic Information page, review and edit the **Role Name**, **Role Code**, and **Description** values, as appropriate.

   **Tip:** The role name and code have the default prefix and suffix for copied roles specified on the Roles subtab of the Security Console Administration tab. You can overwrite these values for the role that you're copying. However, any roles inherited by the copied role are unaffected by any name changes that you make on the Copy Role: Basic Information page.

7. Click the **Summary and Impact Report** train stop.
8. Click **Submit and Close**, then **OK** to close the confirmation message.
9. Review the progress of your copy on the Role Copy Status subtab of the Security Console Administration tab. Once the status is **Complete**, you can edit the copied role.

   If you prefer, you can visit the intermediate train stops after the Copy Role: Basic Information page and edit your copy of the role before you save it.

### Editing Job and Abstract Roles: Procedure

You can create a role by copying a predefined job role or abstract role and editing the copy. This topic describes how to edit a role on the Security Console. You must have the IT Security Manager job role to perform this task.

#### Editing the Role

Follow these steps:

1. On the Roles tab of the Security Console, search for and select your custom role.
2. In the search results, click the down arrow for the selected role and select **Edit Role**.
3. On the Edit Role: Basic Information page, you can edit the role name and description, but not the role code.
4. Click **Next**.

#### Managing Functional Security Privileges

On the Edit Role: Functional Security Policies page, any function security privileges granted to the copied role appear on the Privileges tab. Select a privilege to view details of the code resources that it secures in the Details section of the page.

To remove a privilege from the role, select the privilege and click the **Delete** icon. To add a privilege to the role:

1. Click **Add Function Security Policy**.
2. In the **Add Function Security Policy** dialog box, search for and select a privilege or role.
3. If you select a role, then click **Add Selected Privileges** to add all function security privileges from the selected role to your custom role. If you select a single privilege, then click **Add Privilege to Role**.
4. Click **OK** to close the confirmation message.
5. Repeat from step 2 for additional privileges.
7. Click Next.

Note: If a function security privilege forms part of an aggregate privilege, then add the aggregate privilege to the role hierarchy. Don’t grant the function security privilege directly to the role. The Security Console enforces this approach.

The Resources tab, which is read-only, lists any resources granted to the role directly rather than through function security privileges. As you can’t grant resources directly to roles on the Security Console, only resource grants created before Release 12 could appear on this tab. You can’t edit these values.

Managing Data Security Policies
Make no changes on the Copy Role: Data Security Policies page.

Note: Whether this page is enabled for edit depends on the current setting of the Enable edit of data security policies option. Set this option on the Roles subtab of the Security Console Administration tab.

Click Next.

Adding and Removing Inherited Roles
The Edit Role: Role Hierarchy page shows the copied role and its inherited aggregate privileges and duty roles. The hierarchy is in tabular format by default. You can add or remove roles.

To remove a role:
1. Select the role in the table.
2. Click the Delete icon.
3. Click OK to close the confirmation message.

To add a role:
1. Click the Add Role icon.
2. In the Add Role Membership dialog box, search for and select the role to add.
3. Click Add Role Membership.
4. Click OK to close the confirmation message.
5. Repeat from step 2 for additional roles.
6. Close the Add Role Membership dialog box.
   The Edit Role: Role Hierarchy page shows the updated role hierarchy.
7. Click Next.

Provisioning the Role to Users
To provision the role to users, you must create a role mapping. Don’t provision the role to users on the Security Console.

Note: Whether this page is enabled for edit depends on the current setting of the Enable edit of user role membership option. Set this option on the Roles subtab of the Security Console Administration tab.

Click Next.
Reviewing the Role

On the Edit Role: Summary and Impact Report page, review the summary of changes. Click Back to make corrections. Otherwise:

1. Click Save and Close to save the role.
2. Click OK to close the confirmation message.

The role is available immediately.

Creating Job or Abstract Roles from Scratch: Procedure

If the predefined roles aren’t suitable or you need a role with few privileges, then you can create a role from scratch. This topic explains how to create a job role or abstract role. To perform this task, you must have the IT Security Manager job role.

Entering Basic Information

Follow these steps:

1. On the Roles tab of the Security Console, click Create Role.
2. On the Create Role: Basic Information page, enter the role’s display name in the Role Name field. For example, enter Sales Department Administration Job Role.
3. Complete the Role Code field. For example, enter SALES_DEPT_ADMIN_JOB.
   Abstract roles have the suffix _ABSTRACT, and job roles have the suffix _JOB.
4. In the Role Category field, select either HCM - Abstract Roles or HCM - Job Roles, as appropriate.

   Note: Be sure to select the HCM - Job Roles category when creating job roles. Otherwise, your job roles don’t appear in the list of available job roles when you create an HCM data role.

5. Click Next.

Adding Functional Security Policies

When you create a role from scratch, you’re most likely to add one or more aggregate privileges or duty roles to your role. You’re less likely to grant function security privileges directly to the role.

If you aren’t granting function security privileges, then click Next. Otherwise, to grant function security privileges to the role:

2. In the Add Function Security Policy dialog box, search for and select a privilege or role.
3. If you select a role, then click Add Selected Privileges to add all function security privileges from a selected role to your custom role. If you select a single privilege, then click Add Privilege to Role.
4. Click OK to close the confirmation message.
5. Repeat from step 2 for additional privileges.
7. Click Next.
Note: If a function security privilege forms part of an aggregate privilege, then add the aggregate privilege to the role hierarchy. Don’t grant the function security privilege directly to the role. The Security Console enforces this approach.

Creating Data Security Policies
Make no entries on the Create Role: Data Security Policies page.

Note: Whether this page is enabled for edit depends on the current setting of the Enable edit of data security policies option. Set this option on the Roles subtab of the Security Console Administration tab.

Click Next.

Building the Role Hierarchy
The Create Role: Role Hierarchy page shows the hierarchy of your custom role in tabular format by default. You can add one or more aggregate privileges, job roles, abstract roles, and duty roles to the role. Typically, when creating a job or abstract role you add aggregate privileges. Roles are always added directly to the role that you’re creating.

To add a role:
1. Click the Add Role icon.
2. In the Add Role Membership dialog box, search for and select the role to add.
3. Click Add Role Membership.
4. Click OK to close the confirmation message.
5. Repeat from step 2 for additional roles.
6. When you finish adding roles, close the Add Role Membership dialog box.
7. Click Next.

Provisioning the Role
To provision the role to users, you must create a role mapping once the role exists. Don’t provision the role to users on the Security Console.

Note: Whether this page is enabled for edit depends on the current setting of the Enable edit of user role membership option. Set this option on the Roles subtab of the Security Console Administration tab.

Click Next.

Reviewing the Role
On the Create Role: Summary and Impact Report page, review the summary of the changes. Click Back to make corrections. Otherwise:
1. Click Save and Close to save the role.
2. Click OK to close the confirmation message.

Your custom role is available immediately.
Copying and Editing Duty Roles: Procedure

You can copy a duty role and edit the copy to create a duty role. Copying duty roles is the recommended way of creating duty roles. This topic explains how to copy a duty role and edit the copy. You must have the IT Security Manager job role to perform these tasks.

Copying a Duty Role

Follow these steps:

1. On the Roles tab of the Security Console, search for the duty role to copy.
2. Select the role in the search results. The role hierarchy appears in tabular format by default.
   
   **Tip:** Click the Show Graph icon to show the hierarchy in graphical format.

3. In the search results, click the down arrow for the selected role and select **Copy Role**.
4. In the **Copy Options** dialog box, select a copy option.
5. Click **Copy Role**.
6. On the Copy Role: Basic Information page, edit the **Role Name**, **Role Code**, and **Description** values, as appropriate.
   
   **Tip:** The role name and code have the default prefix and suffix for copied roles specified on the Roles subtab of the Security Console Administration tab. You can overwrite these values for the role that you’re copying. However, any roles inherited by the copied role are unaffected by any name changes that you make on the Copy Role: Basic Information page.

7. Click the **Summary and Impact Report** train stop.
8. Click **Submit and Close**, then **OK** to close the confirmation message.
9. Review the progress of your copy on the Role Copy Status subtab of the Security Console Administration tab. Once the status is **Complete**, you can edit the copied role.

Editing the Copied Duty Role

Follow these steps:

1. On the Roles tab of the Security Console, search for and select your copy of the duty role.
2. In the search results, click the down arrow for the selected role and select **Edit Role**.
3. On the Edit Role: Basic Information page, you can edit the role name and description, but not the role code.
4. Click **Next**.

Managing Functional Security Policies

On the Edit Role: Functional Security Policies page, any function security privileges granted to the copied role appear on the Privileges tab. Select a privilege to view details of the code resources that it secures.

To remove a privilege from the role, select the privilege and click the **Delete** icon. To add a privilege to the role:

1. Click **Add Function Security Policy**.
2. In the **Add Function Security Policy** dialog box, search for and select a privilege or role.
3. If you select a role, then click **Add Selected Privileges** to grant all function security privileges from the selected role to your custom role. If you select a single privilege, then click **Add Privilege to Role**.

4. Click **OK** to close the confirmation message.

5. Repeat from step 2 for additional privileges.


7. Click **Next**.

**Note:** If a function security privilege forms part of an aggregate privilege, then add the aggregate privilege to the role hierarchy. Don’t grant the function security privilege directly to the role. The Security Console enforces this approach.

The Resources tab, which is read-only, lists any resources granted to the role directly rather than through function security privileges. As you can’t grant resources directly to roles on the Security Console, only resource grants created before Release 12 could appear on this tab. You can’t edit these values.

### Managing Data Security Policies

Make no changes on the Edit Role: Data Security Policies page.

**Note:** Whether this page is enabled for edit depends on the current setting of the **Enable edit of data security policies** option. Set this option on the Roles subtab of the Security Console Administration tab.

Click **Next**.

### Adding and Removing Inherited Roles

The Edit Role: Role Hierarchy page shows the copied duty role and any duty roles and aggregate privileges that it inherits. The hierarchy is in tabular format by default. You can add or remove roles.

To remove a role:

1. Select the role in the table.
2. Click the **Delete** icon.
3. Click **OK** to close the information message.

To add a role:

1. Click **Add Role**.
2. In the **Add Role Membership** dialog box, search for and select the role to add.
3. Click **Add Role Membership**.
4. Click **OK** to close the confirmation message.
5. Repeat from step 2 for additional roles.
6. Close the **Add Role Membership** dialog box.

The Edit Role: Role Hierarchy page shows the updated role hierarchy.

7. Click **Next**.

### Reviewing the Role

On the Edit Role: Summary and Impact Report page, review the summary of changes. Click **Back** to make corrections. Otherwise:

1. Click **Save and Close** to save the role.
2. Click **OK** to close the confirmation message.

The role is available immediately.
18 Regenerating Roles

Regenerating Roles: Explained

You must regenerate an HCM data role if you change its role hierarchy. For example, if you remove an aggregate privilege from a custom job role, then you must regenerate any data role that inherits the job role. You must also regenerate any abstract role to which security profiles are assigned if you change its role hierarchy. Regenerating a role updates its data security policies to reflect the latest role hierarchy. This topic introduces the ways in which you can regenerate data and abstract roles.

Regenerating Multiple Roles

To regenerate multiple roles at once, you use the Process Grants Regeneration process. Before you can use this process, you must add the Resubmit All Roles button to the Manage Data Roles and Security Profiles page. Adding this button is a once-only task.

Regenerating Roles Individually

To regenerate a single data or abstract role, you can use the Process Grants Regeneration process. Alternatively, you can edit the role on the Manage Data Roles and Security Profiles page.

Follow these steps:

1. Search for the data or abstract role.
2. Select the role in the Search Results and click Edit.
3. On the Edit Data Role: Select Role page, click Next.
5. On the Edit Data Role: Review page, click Submit.

This procedure automatically regenerates the role’s data security policies based on the security profiles assigned to the role.

Note: You must regenerate updated, predefined roles after each release upgrade of Oracle HCM Cloud. For example, if the predefined Payroll Manager role is updated in an upgrade, then you must regenerate any data role that inherits that job role.

Enabling the Grants Regeneration Process: Procedure

You can regenerate HCM data roles and abstract roles individually by editing them on the Manage Data Roles and Security Profiles page. Alternatively, to regenerate one or more roles, you can run the Process Grants Regeneration process. This topic describes how to enable this process by adding the Resubmit All Roles button to the Manage Data Roles and Security Profiles page. You perform this task once only.
Adding the Resubmit All Roles Button

Follow these steps:

1. Sign in with the following roles or privileges:
   - IT Security Manager
   - Application Implementation Consultant or Human Capital Management Application Administrator

2. Create and activate a sandbox.


4. In the Tasks panel tab of the Workforce Structures work area, select Manage Data Roles and Security Profiles.

   ⚠️ Note: Don’t select this task in the Setup and Maintenance work area. Select it in the Workforce Structures work area.

5. In the Settings and Actions menu in the global header, select Customize Pages... to open the Page Composer. Follow these steps to add the Resubmit All Roles button to the Manage Data Roles and Security Profiles page.
   
   - In the dialog box that opens, select the Site layer and click OK.
   - From the View menu in the Page Composer, select Source. This option opens a source-code area at the bottom of the page.
   - Expand the source-code area to show more of the content.
   - Move the cursor to the Manage Data Roles and Security Profiles page header and left-click. In the warning about editing a shared component, click Edit.

   ⚠️ Note: You aren’t editing the page header, but this approach provides a quick way to find the Resubmit All Roles button in the source code.

   - The toolbar component that contains the Resubmit All Roles button opens in the source-code area.
   - In the source-code area, right-click the commandToolbarButton: Resubmit All Roles entry and click Show Component. The Resubmit All Roles button now appears on the Manage Data Roles and Security Profiles page.

6. Close the Page Composer.

7. Select the sandbox, click More, and publish your changes.

The Resubmit All Roles button is now available to all users of the Manage Data Roles and Security Profiles page to regenerate roles.

Regenerating Multiple Data and Abstract Roles: Procedure

You must regenerate an HCM data role if changes are made to the data security policies of its inherited job role. For example, if an aggregate privilege is removed from the job role, then you must regenerate any data role that inherits the job role. You must also regenerate any abstract role that has directly assigned security profiles if changes are made to the role’s data security policies. You can regenerate data and abstract roles individually by editing them on the Manage Data Roles and Security Profiles page. Alternatively, to regenerate one or more roles, you can run the Process Grants Regeneration process. This topic describes how to run this process.
Running Process Grants Regeneration

Follow these steps.

1. Sign in with the IT Security Manager role or privileges and select **Navigator > My Client Groups > Workforce Structures**.
2. In the Tasks panel tab of the Workforce Structures work area, select the Manage Data Roles and Security Profiles task.
3. On the Manage Data Roles and Security Profiles page, click **Resubmit All Roles**.

   **Note:** The **Resubmit All Roles** button doesn’t appear by default. You must configure the page to include this button. Configuring the page is a once-only task.

   The Process Flow page opens.

4. On the Process Flow page, click **Schedule**.


6. On the Schedule: Process Grants Regeneration page:
   a. In the **Process Flow** field, enter a name for this run of the process. You can enter any text that helps you to identify this run.
   b. In the **Mode** field, select a value. This table describes the values.

<table>
<thead>
<tr>
<th>Mode Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Named Job Role</td>
<td>Regenerates any data role that inherits the specified job role directly. Data roles that inherit the job role indirectly aren't regenerated.</td>
</tr>
<tr>
<td>Named Data Role</td>
<td>Regenerates the specified data role only.</td>
</tr>
<tr>
<td>Named Abstract Role</td>
<td>Regenerates the specified abstract role only.</td>
</tr>
<tr>
<td>Process All Roles</td>
<td>Regenerates all roles to which security profiles are assigned. In this mode, secured access for all roles is recalculated and the secured access of all users is refreshed. The time taken to complete this process depends on the number of roles to be regenerated.</td>
</tr>
</tbody>
</table>

   c. If you’re regenerating a named role, then select a **Role** value.
   d. Select a **Run** value.
   e. Click **Submit**.

   On the Process Flow page, the processing information refreshes automatically while the process is running. You can open other pages and return to this page to review progress. When the process completes, click the process run name to see the process results. The Process Flow page shows the name that you specified for this run. The Process Results section of the page lists all roles that were processed and indicates whether the regeneration succeeded.

7. Click **Done** to close the page.
19 Securing Content Sections in Person Profiles

Securing Content Sections in Person Profiles: Explained

Sensitive data for a worker appears in content sections in person profiles. For example, a person profile can contain information about competencies, performance ratings, job criticality, risk of loss, degrees, and so on. To give users an appropriate level of access to person-profile contents, you can secure this information at the content-section level.

This topic:
- Introduces content types and content sections
- Describes the task that manages content-section access for selected roles
- Explains how data security policies are constructed to secure access to custom content types
- Describes regeneration of the affected data and abstract roles

Content Types and Content Sections

Content types are the skills, qualities, and qualifications that you track in talent profiles. You select content types from the content library to create content sections for the profile type. You can secure access to content sections in person profiles only. The content types can be either predefined or custom but must be associated with the person profile type.

Manage Profile Content Section Access

Use the Manage Profile Content Section Access task in the Setup and Maintenance work area to secure access to content sections in person profiles. You must have the IT Security Manager role or privileges to perform this task. For a selected content section, you can:

- Identify the predefined or custom job roles and abstract roles that can access the content section in person profiles.
- Specify the level of access for each role. The levels are shown in this table.

<table>
<thead>
<tr>
<th>Access Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Users can view content-section data.</td>
</tr>
<tr>
<td>Edit</td>
<td>Users can edit content-section data. This access includes View and Report access.</td>
</tr>
<tr>
<td>Report</td>
<td>Users can include content-section data in Oracle Business Intelligence Publisher reports.</td>
</tr>
</tbody>
</table>

Data Security Policies

When you map a predefined content type to a role, a predefined data security privilege is granted to the role automatically. When you map a custom content type to a role, a data security privilege is both generated and granted to the role.
automatically. For example, you could map the custom Leadership content type to the predefined Employee abstract role and set the access level to **Edit**. This table shows the resulting data security policy. The data security privilege shown in this data security policy would be generated and granted to the role.

<table>
<thead>
<tr>
<th>Data Security Policy</th>
<th>Data Resource</th>
<th>Data Security Privilege</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_PER_EMPLOYEE_ABSTRACT Grant on Profile Content Type LEADERSHIP</td>
<td>Person Detail</td>
<td>Manage Leadership Content Type</td>
<td>HCM:PER:PER_ALL_ PEOPLE_F:View Own Record</td>
</tr>
</tbody>
</table>

These rules apply to the data security policy:

- The policy name is in the form: **role code, Grant on Profile Content Type content type code**. The policy description is the same as the policy name.
- The data resource is Person Detail.
- The data security privileges are in the form: **Manage | Report | View | content type name Content Type**
- The condition, which controls access to specific instances of person records, identifies the relevant person security profile.

**Regeneration of Data and Abstract Roles**

After saving your changes on the Manage Profile Content Section Access page, you must regenerate:

- Data roles that inherit any of the job roles to which you mapped a content section
- Abstract roles to which you mapped a content section and to which security profiles are assigned

Regenerating roles updates their data security permissions. If you don’t regenerate relevant roles, then users can’t access content sections in person profiles.

> **Note:** If you plan to copy abstract or job roles to which security profiles are assigned, then revoke the security profiles before you perform the copy. This precaution ensures that any data security policies, including those generated when you map content sections to a role, aren’t copied.

**Restrictions**

Content sections in person profiles are unsecured when person profiles are included in:

- Best-fit analyses
- Profile comparisons
- Oracle Transactional Business Intelligence reports

**Related Topics**

- Regenerating Roles: Explained
Securing Content Sections in Person Profiles: Procedure

You can enable a job role or abstract role to access selected content sections in person profiles. You can also specify the level of access for each role. This topic describes how to perform this task. You must have the IT Security Manager job role or privileges.

Securing Access to Content Sections in Person Profiles

Sign in and follow these steps:

1. In the Setup and Maintenance work area, use the Manage Profile Content Section Access task.
2. In the Content Sections section of the Manage Profile Content Section Access page, select a content section.

   The Roles section is updated automatically for the selected content section. It shows any roles that already have access to the content section and their access level. You can change the access level, if appropriate.

3. To map the content section to a job or abstract role:
   
   a. In the Roles section of the page, click Add.
   b. Search for and select the role.
   c. Select any combination of View, Edit, and Report to set the access for the role. When you select Edit, View and Report are selected automatically.

   Repeat this step for additional roles.

4. To remove a role, select it and click Remove.
5. Save your changes.
6. Repeat from step 2 for additional content sections.

Note: You must regenerate:

- Data roles that inherit any of the job roles to which you mapped a content section
- Abstract roles to which you mapped a content section and to which security profiles are assigned

Related Topics

- Regenerating Roles: Explained
20 Securing Access to Succession Plans, Incumbents, and Candidates

Securing Access to Succession Plans, Incumbents, and Candidates: Overview

This topic provides an overview of the ways in which you can configure user access to succession plans, incumbents, and candidates.

Providing Access to All Succession Plans in the Succession Plans Work Area

In the Succession Plans work area, human resource specialists (HR specialists) can manage succession plans for which they’re owners. However, no predefined job role enables any user to manage all succession plans. To give selected users this access, you can create a super user job role and provision the job role directly to those users. The job role is granted custom data security policies that provide access to all succession plans.

You can also enable users with this super user job role to access Oracle Transactional Business Intelligence (OTBI) subject areas for all succession plans. You can either edit your custom job role to add OTBI access or provide a separate job role that has OTBI access. By creating one role with OTBI access and one without, you can provide selective access to OTBI subject areas for succession management.

Configuring Access to Lists of Succession Plan Incumbents and Candidates

HR specialists and line managers select incumbents and candidates from lists of workers secured by the person security profiles assigned to their roles. However, you may want to present different lists of workers to HR specialists and line managers when they’re selecting incumbents and candidates. For example, you may want to restrict the lists in some way or include workers who wouldn’t otherwise appear. To achieve this flexible access, you can replace the predefined data security policies that secure access to these lists with custom data security policies. As the incumbent and candidate lists are secured separately, you can specify different conditions for each list. For example, you could specify that:

- The list of incumbents includes only workers in a specific location.
- The list of candidates includes only workers in the legal employer for which the HR specialist has the human resources representative responsibility.
Creating a Succession Plans Super User Job Role: Worked Example

This example shows how to create a job role that provides access to all succession plans in the Succession Plans work area. The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s the name of the job role?</td>
<td>Succession Plans Super User Job</td>
</tr>
<tr>
<td>What’s the code of the job role?</td>
<td>SUCCESison_PLAN_Super_USER_JOB</td>
</tr>
<tr>
<td>What are the names of the data security</td>
<td>• Succession Plans Custom Policy</td>
</tr>
<tr>
<td>policies?</td>
<td>• Succession Candidate Custom Policy</td>
</tr>
<tr>
<td></td>
<td>• Succession Person Detail Custom Policy</td>
</tr>
<tr>
<td>What’s the enterprise suffix for copied roles?</td>
<td>Custom</td>
</tr>
<tr>
<td>Is there an enterprise prefix for copied roles?</td>
<td>No</td>
</tr>
<tr>
<td>What’s the name of the role mapping?</td>
<td>Access All Succession Plans</td>
</tr>
<tr>
<td>How do users acquire the role?</td>
<td>Users with the human resources representative</td>
</tr>
<tr>
<td></td>
<td>responsibility can provision the role to other users.</td>
</tr>
</tbody>
</table>

Summary of the Tasks

Enable access to all succession plans in the Succession Plans work area by:

1. Copying the predefined Succession Plan Management duty role and editing the copy
2. Creating a job role
3. Granting data security policies to the job role
4. Creating a role hierarchy for the job role
5. Creating a role mapping
6. Optionally, editing the job role to enable access to Oracle Transactional Business Intelligence (OTBI) subject areas for Succession Management
Copying the Succession Plan Management Duty Role

You copy the predefined Succession Plan Management duty role and edit it to remove the existing data security policy.

1. Sign in with the IT Security Manager role or privileges and select Navigator > Tools > Security Console.
2. On the Roles tab of the Security Console, search for the predefined Succession Plan Management (ORA_HRM_SUCCESSION_PLAN_DUTY) duty role.
3. In the search results, select Copy Role on the role’s Actions menu.
4. In the Copy Options dialog box, select Copy top role and click Copy Role. On the Copy Role: Basic information page, the name of the copied role is Succession Plan Management Custom (HRM_SUCCESSION_PLAN_DUTY_CUSTOM).
5. Click the Data Security Policies train stop. On the Data Security Policies page, the Grant on Succession Plan Detail policy is listed.
6. On the Actions menu for the data security policy, click Remove Data Security Policy.
7. In the Warning dialog box, click Yes.
8. Click the Summary and Impact Report train stop.
9. On the Summary and Impact Report page, click Submit and Close to create the duty role.
10. Click OK to close the Confirmation dialog box.

Creating a Job Role

You create the Succession Plans Super User Job role.

1. On the Roles tab of the Security Console, click Create Role.
2. On the Create Role: Basic Information page, enter the role name Succession Plans Super User Job.
3. Enter the role code SUCCESSION_PLANS_SUPER_USER_JOB.
4. In the Role Category field, select HCM - Job Roles.
5. Click the Data Security Policies train stop.

Granting Data Security Policies to the Job Role

You create three data security policies for the Succession Plans Super User Job role.

1. On the Data Security Policies page, click Create Data Security Policy to open the Create Data Security Policy dialog box.
2. In the Create Data Security Policy dialog box, enter the policy name Succession Plans Custom Policy.
3. Search for and select the database resource Succession Plan Detail (HRM_PLANS).
4. Select All values in the Data Set field.
5. Select these values in the Actions field:
   - Add Worker to Succession Plan
   - Create Succession Plan for Worker
   - Manage Succession Plan
   - View Succession Plan
6. Click OK to close the Create Data Security Policy dialog box.
7. Repeat from step 1 to create two further data security policies. Complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Policy Name</th>
<th>Database Resource</th>
<th>Data Set</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Succession Candidate Custom Policy</td>
<td>Succession Plan Candidate (HRM_PLAN_CANDIDATES)</td>
<td>All values</td>
<td>◦ Manage Succession Plan Candidate</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>◦ View Succession Plan Candidate</td>
</tr>
<tr>
<td>Succession Person Detail Custom Policy</td>
<td>Person Detail (PER_ALL_PEOPLE_F)</td>
<td>All values</td>
<td>◦ Add Worker to Succession Plan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>◦ Create Succession Plan for Worker</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>◦ View Succession Plan</td>
</tr>
</tbody>
</table>

You now see the three data security policies listed on the Data Security Policies page.

Defining the Role Hierarchy for the Job Role

You add the Create Succession Plan for Worker aggregate privilege and the Succession Plan Management Custom duty role to the Succession Plans Super User Job role hierarchy.

1. Click the Role Hierarchy train stop.
2. On the Role Hierarchy page, click Add Role.
3. In the Add Role Membership dialog box, search for the Create Succession Plan for Worker (ORA_HRM_SUCCESSION_PLAN_CREATE_DUTY) aggregate privilege.
4. Select the aggregate privilege in the search results and click Add Role Membership.
5. Repeat from step 3 to add the Succession Plan Management Custom duty role.
6. Close the Add Role Membership dialog box.
7. Click the Summary and Impact Report train stop.
8. Click Save and Close.
9. Click OK to close the Confirmation dialog box.

Creating a Role Mapping

You create a role mapping to enable the Succession Plans Super User Job role to be provisioned to users.

1. In the Setup and Maintenance work area, go to the following:
   o Offering: Workforce Development
   o Functional Area: Users and Security
   o Task: Manage Role Provisioning Rules
2. On the Manage Role Mappings page, click the Create icon in the Search Results section.
3. In the Mapping Name field on the Create Role Mapping page, enter Access All Succession Plans.
4. Complete the fields in the Conditions section as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Assignment Status</td>
<td>Active</td>
</tr>
</tbody>
</table>
5. In the Associated Roles section, click the **Add Row** icon.
6. In the **Role Name** field, search for and select Succession Plans Super User Job.
7. Select the **Requestable** option and deselect the **Autoprovision** option.
8. Click **Save and Close**.

Users with the human resources representative responsibility can now provision the Succession Plans Super User Job role to other users. A user who has the role can manage all succession plans in the Succession Plans work area with the following exceptions:

- A user who is also the Candidate Manager for a plan can edit only the plan’s candidate list.
- A user who is also the Viewer of a plan can view the plan but not edit it.

### Enabling Access to OTBI Subject Areas

To enable users who have the Succession Plans Super User Job role to access OTBI subject areas for Succession Management, you edit two of the job role’s data security policies and add a role to the role hierarchy.

1. Sign in with the IT Security Manager job role or privileges and select **Navigator > Tools > Security Console**.
3. In the search results, select **Edit Role** on the role’s Actions menu.
4. Click the **Data Security Policies** train stop.
5. On the Actions menu for the Succession Plans Custom Policy data security policy, select **Edit Data Security Policy**.
6. In the **Edit Data Security Policy** dialog box, select **View Report Succession Plan** in the **Actions** field. All available actions are now selected for this data security policy.
7. In the Actions menu for the Succession Candidate Custom Policy data security policy, select **Edit Data Security Policy**.
8. In the **Edit Data Security Policy** dialog box, select **View Report Succession Plan Candidacy** in the Actions field. All available actions are now selected for this data security policy.
9. Click the **Role Hierarchy** train stop.
10. Click **Add Role**.
11. In the **Add Role Membership** dialog box, search for and select the predefined Succession Management Transaction Analysis Duty (FBI_SUCCESSION_MANAGEMENT_TRANSACTION_ANALYSIS_DUTY) role.
12. Click **Add Role Membership**.
13. Close the **Add Role Membership** dialog box.
14. Click the **Summary and Impact Report** train stop.
15. Click **Save and Close**.

Any user who has the Succession Management Super User Job role can now access OTBI subject areas for Succession Management.
Configuring Access to Lists of Incumbents and Candidates: Worked Example

Human resource specialists (HR specialists) select incumbents and candidates for succession plans from lists of workers. By default, the workers who appear in those lists are defined by the person security profile assigned to the HR specialist's data role. You may want to vary this access. For example, you may want to present lists of incumbents and candidates that are restricted in some way. This example shows how to create an HCM data role for HR specialists with access to restricted lists of succession plan incumbents and candidates.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s the name of the HCM data role?</td>
<td>HR Specialist - Restricted Incumbents and Candidates</td>
</tr>
<tr>
<td>What are the name and display name of the database resource condition for incumbents?</td>
<td>Incumbent List and Incumbent List Securing Condition</td>
</tr>
<tr>
<td>What are the name and display name of the database resource condition for candidates?</td>
<td>Candidate List and Candidate List Securing Condition</td>
</tr>
<tr>
<td>How will the database resource conditions be specified?</td>
<td>SQL predicate</td>
</tr>
<tr>
<td>Which workers should appear in the lists of incumbents and candidates for HR specialists?</td>
<td>Employees in the department for which the HR specialist has the human resources representative responsibility</td>
</tr>
<tr>
<td>What’s the name of the data security policy for incumbents?</td>
<td>Restricted Access to Incumbents Policy</td>
</tr>
<tr>
<td>What’s the name of the data security policy for candidates?</td>
<td>Restricted Access to Candidates Policy</td>
</tr>
</tbody>
</table>

Summary of the Tasks

Enable access to restricted lists of incumbents and candidates by:

1. Creating an HCM data role
2. Creating two database resource conditions
3. Editing the HCM data role to end date existing data security policies
4. Creating replacement data security policies for the HCM data role that reference the new database resource conditions
Creating the HCM Data Role

You create an HCM data role with view-all access.

1. Sign in with the IT Security Manager role or privileges.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Workforce Development
   - Functional Area: Users and Security
   - Task: Assign Security Profiles to Role
3. On the Manage Data Roles and Security Profiles page, click Create.
4. On the Create Data Role: Select Role page, complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Role</td>
<td>HR Specialist - Restricted Incumbents and Candidates</td>
</tr>
<tr>
<td>Job Role</td>
<td>Human Resource Specialist</td>
</tr>
</tbody>
</table>

5. Click Next.
6. On the Create Role: Security Criteria page, select the security profiles shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Security Profile</td>
<td>View All Organizations</td>
</tr>
<tr>
<td>Position Security Profile</td>
<td>View All Positions</td>
</tr>
<tr>
<td>Country Security Profile</td>
<td>View All Countries</td>
</tr>
<tr>
<td>LDG Security Profile</td>
<td>View All Legislative Data Groups</td>
</tr>
<tr>
<td>Person Security Profile (Person)</td>
<td>View All Workers</td>
</tr>
<tr>
<td>Person Security Profile (Public Person)</td>
<td>View All People</td>
</tr>
<tr>
<td>Document Type Security Profile</td>
<td>View All Document Types</td>
</tr>
<tr>
<td>Payroll Security Profile</td>
<td>View All Payrolls</td>
</tr>
<tr>
<td>Flow Pattern Security Profile</td>
<td>View All Flows</td>
</tr>
</tbody>
</table>

7. Click Review.
8. On the Create Data Role: Review page, click Submit.
Creating Database Resource Conditions

You create two database resource conditions that you will include in data security policies.

1. Select **Navigator > Tools > Security Console**.
2. On the Security Console, click the Administration tab.
3. On the General subtab, click **Manage Database Resources**.
4. On the Manage Database Resources and Policies page, enter PER_ALL_PEOPLE_F in the **Object Name** field and click **Search**.
5. In the Search Results section, click the **Edit** icon.
7. On the Condition tab, click the **Create** icon.
8. In the **Create Database Resource Condition** dialog box, complete the fields as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Incumbent List</td>
</tr>
<tr>
<td>Display Name</td>
<td>Incumbent List Securing Condition</td>
</tr>
<tr>
<td>Condition Type</td>
<td>SQL predicate</td>
</tr>
</tbody>
</table>

In the **SQL Predicate** field, enter the following statement:

```sql
EXISTS(SELECT 1 FROM PER_ALL_ASSIGNMENTS_M ASG,PER_PERIODS_OF_SERVICE PS,PER_ASG_RESPONSIBILITIES RES
WHERE ASG.ASSIGNMENT_TYPE IN('E')
AND ASG.EFFECTIVE_LATEST_CHANGE='Y'
AND SYSDATE BETWEEN ASG.EFFECTIVE_START_DATE AND
ASG.EFFECTIVE_END_DATE
AND PS.PERIOD_OF_SERVICE_ID=ASG.PERIOD_OF_SERVICE_ID
AND (ASG.ASSIGNMENT_STATUS_TYPE IN ('ACTIVE','SUSPENDED') OR (ASG.ASSIGNMENT_STATUS_TYPE IN ('INACTIVE')
AND NOT EXISTS
SELECT 1 FROM PER_ALL_ASSIGNMENTS_M EXASG
WHERE EXASG.ASSIGNMENT_TYPE IN('E','C','N','P')
AND EXASG.EFFECTIVE_LATEST_CHANGE='Y'
AND EXASG.PERSON_ID = ASG.PERSON_ID
AND SYSDATE BETWEEN LEAST(SYSDATE,EXASG.EFFECTIVE_START_DATE) AND
EXASG.EFFECTIVE_END_DATE
AND EXASG.ASSIGNMENT_STATUS_TYPE IN
('ACTIVE','SUSPENDED')
AND PS.ACTUAL_TERMINATION_DATE = (SELECT MAX(ALLPS.ACTUAL_TERMINATION_DATE) FROM
PER_PERIODS_OF_SERVICE ALLPS
WHERE ALLPS.PERSON_ID = ASG.PERSON_ID
AND ALLPS.ACTUAL_TERMINATION_DATE IS NOT NULL))
AND SYSDATE BETWEEN
RES.START_DATE AND NVL(RES.END_DATE,SYSDATE)
AND ASG.PERSON_ID=&TABLE_ALIAS.PERSON_ID AND RES.PERSON_ID=(SELECT
NVL(HRC_SESSION_UTIL.GET_USER_PERSONID,-1) FROM DUAL)
AND RES.RESPONSIBILITY_TYPE='HR_REP' AND ASG.ORGANIZATION_ID=RES.ORGANIZATION_ID
AND ((SELECT
NVL(HRC_SESSION_UTIL.GET_USER_PERSONID,-1)
FROM DUAL)<>&TABLE_ALIAS.PERSON_ID))
```

**Tip:** To generate a SQL predicate that you can use or edit, create a person security profile with the required conditions. Copy the SQL predicate from the SQL Predicate for Person Access tab on the Create Person Security Profile: Preview page.

9. Click **Save**.
10. Repeat steps 7 through 9 for the candidate condition using the values shown in this table and the same SQL predicate.
### End Dating Data Security Policies Granted to the HCM Data Role

You edit the HCM data role to end date the existing data security policies.

1. Click the Roles tab on the Security Console.
2. Search for and select the HR Specialist - Restricted Incumbents and Candidates data role.
3. In the search results, select **Edit Role** on the role’s Actions menu.
4. On the Basic Information page, click the **Data Security Policies** train stop.
5. In the **Privilege** search field, enter Add Worker to Succession Plan and press **Enter**.
6. In the row containing the specified privilege for the Person Detail data resource, select **Edit Data Security Policy** on the Actions menu.
7. In the **Edit Data Security Policy** dialog box, enter today’s date in the **End Date** field.
8. Click **OK** to close the **Edit Data Security Policy** dialog box.

### Creating Data Security Policies

You create two data security policies that provide restricted access to incumbents and candidates for your HCM data role.

1. On the Create Data Security Policies page, click **Create Data Security Policy**.
2. Complete the fields in the **Create Data Security Policy** dialog box using the values shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy Name</td>
<td>Restricted Access to Incumbents Policy</td>
</tr>
<tr>
<td>Database Resource</td>
<td>Person Detail</td>
</tr>
<tr>
<td>Data Set</td>
<td>Select by instance set</td>
</tr>
<tr>
<td>Condition Name</td>
<td>Incumbent List Securing Condition</td>
</tr>
<tr>
<td>Actions</td>
<td>Create Succession Plan for Worker</td>
</tr>
</tbody>
</table>

3. Click **OK**.
4. Repeat steps 1 through 3 using the values shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy Name</td>
<td>Restricted Access to Candidates Policy</td>
</tr>
<tr>
<td>Database Resource</td>
<td>Person Detail</td>
</tr>
<tr>
<td>Data Set</td>
<td>Select by instance set</td>
</tr>
<tr>
<td>Condition Name</td>
<td>Candidate List Securing Condition</td>
</tr>
<tr>
<td>Actions</td>
<td>Add Worker to Succession Plan</td>
</tr>
</tbody>
</table>

5. Click the **Summary and Impact Report** train stop.

6. Click **Save and Close** to save your changes to the HCM data role.

To provision the HCM data role to users, create a role mapping.

**Tip:** To implement these enhancements for the Line Manager abstract role, the steps are the same except that you don’t have to create a data role. As the Line Manager role is likely to have directly assigned security profiles, you edit the Line Manager role to end date the relevant data security policies.
21 Security and Reporting

Oracle Fusion Transactional Business Intelligence Security: Explained

Oracle Fusion Transactional Business Intelligence is a real-time, self-service reporting solution. All application users with appropriate roles can use Transactional Business Intelligence to create analyses that support decision-making. In addition, business users can perform current-state analysis of their business applications using a variety of tools. These include Oracle Business Intelligence Enterprise Edition as the standard query and reporting tool, Oracle Business Intelligence Answers, and Oracle Business Intelligence Dashboard end-user tools. This topic summarizes how access is secured to Transactional Business Intelligence subject areas, Business Intelligence Catalog folders, and Business Intelligence reports.

Subject Areas

Subject areas are functionally secured using duty roles. The names of duty roles that grant access to subject areas include the words Transaction Analysis Duty (for example, Workforce Transaction Analysis Duty).

This table identifies the subject areas that predefined HCM job roles can access.

<table>
<thead>
<tr>
<th>HCM Job Role</th>
<th>Subject Areas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benefits Manager</td>
<td>All Benefits</td>
</tr>
<tr>
<td>Compensation Manager</td>
<td>All Compensation</td>
</tr>
<tr>
<td>Compensation Analyst</td>
<td>All Compensation</td>
</tr>
<tr>
<td>Human Resource Analyst</td>
<td>Goals, Workforce Management, Workforce Performance, Workforce Profiles, and Talent Review</td>
</tr>
<tr>
<td>Line Manager</td>
<td>All Workforce Management</td>
</tr>
<tr>
<td>Payroll Manager</td>
<td>All Payroll</td>
</tr>
</tbody>
</table>

Analyses fail if the user can’t access all subject areas in a report.

Business Intelligence Catalog Folders

Business Intelligence Catalog folders are functionally secured using the same duty roles that secure access to the subject areas. Therefore, a user who inherits the Workforce Transaction Analysis Duty can access both the Workforce Management folder in the Business Intelligence Catalog and the Workforce Management subject areas.

This table identifies the folders that predefined HCM job roles can access.
## Business Intelligence Reports

Analyses are secured based on the folders in which they’re stored. If you haven’t secured Business Intelligence reports using the report privileges, then they’re secured at the folder level by default. You can set permissions against folders and reports for Application Roles, Catalog Groups, or Users.

You can set permissions to:

- Read, Execute, Write, or Delete
- Change Permissions
- Set Ownership
- Run Publisher Report
- Schedule Publisher Report
- View Publisher Output

## How Reporting Data Is Secured: Explained

The data that’s returned in Oracle Transactional Business Intelligence reports is secured in a similar way to the data that’s returned in application pages. Data access is granted by roles that are linked to security profiles. This topic describes the part played by Transaction Analysis Duty Roles in securing access to data in Transactional Business Intelligence reports. It also describes how to enable this access in custom job roles.

### Transaction Analysis Duty Roles

Each of the Transaction Analysis Duty roles providing access to subject areas and Business Intelligence Catalog folders is granted one or more data security policies. These policies enable access to the data.
Custom Job Roles

If you create a job role with access to Transactional Business Intelligence reports, then you must give the role the correct duty roles. Your custom role must have both the OBI and HCM versions of the Transaction Analysis Duty roles. These duty roles ensure that your custom job role has the function and data security for running the reports.

For example, if your role must access the Workforce Transaction Analysis subject areas, then it must inherit the duty roles shown in this table.

<table>
<thead>
<tr>
<th>Duty Role</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workforce Transaction Analysis Duty</td>
<td>OBI</td>
</tr>
<tr>
<td>Workforce Transaction Analysis</td>
<td>HCM</td>
</tr>
</tbody>
</table>

The Workforce Transaction Analysis Duty role is granted relevant data security policies and inherits BI Consumer Role.

**Note:** You’re recommended not to copy the OBI Transaction Analysis Duty roles. Instead, add the predefined OBI Transaction Analysis Duty roles to your custom role. If you copy the roles, then you must update the permissions for relevant reports to secure them using your copies of the roles.

Business Intelligence Roles: Explained

Oracle Business Intelligence roles apply to both Oracle Business Intelligence Publisher and Oracle Fusion Transactional Business Intelligence. They grant access to Business Intelligence functionality, such as the ability to run or author reports. These roles are in addition to the roles that grant access to reports, subject areas, Business Intelligence catalog folders, and HCM data. This topic describes the Business Intelligence roles.

This table lists the Business Intelligence roles.

<table>
<thead>
<tr>
<th>Business Intelligence Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Consumer Role</td>
<td>Runs Business Intelligence reports.</td>
</tr>
<tr>
<td>BI Author Role</td>
<td>Creates and edits reports.</td>
</tr>
<tr>
<td>BI Administrator Role</td>
<td>Performs administrative tasks such as creating and editing dashboards and modifying security permissions for reports, folders, and so on.</td>
</tr>
<tr>
<td>BI Publisher Data Model Developer Role</td>
<td>Creates and edits Business Intelligence Publisher data models.</td>
</tr>
</tbody>
</table>
BI Consumer Role
The predefined Transactional Business Intelligence Transaction Analysis Duty roles inherit BI Consumer Role. You can configure custom roles to inherit BI Consumer Role so that they can run reports but not author them.

BI Author Role
BI Author Role inherits BI Consumer Role. Users with BI Author Role can create, edit, and run Transactional Business Intelligence reports.

BI Administrator Role
BI Administrator Role is a superuser role. It inherits BI Author Role, which inherits BI Consumer Role. You’re recommended to provision this role to users in a test environment only.

None of the predefined HCM job roles has BI Administrator Role access.

BI Publisher Data Model Developer Role
BI Publisher Data Model Developer Role is inherited by the Application Developer role, which is inherited by the Application Implementation Consultant role. Therefore, users with either of these predefined job roles can manage Business Intelligence Publisher data models.

Viewing Reporting Roles and Permissions: Procedure
Viewing reporting roles and permissions can help you to understand how Oracle Transactional Business Intelligence security works.

This topic explains how to view:
- The reporting roles that a job role inherits
- The permissions for sample Oracle Transactional Business Intelligence reports in the Business Intelligence Catalog

Viewing Inherited Reporting Roles on the Security Console
Sign in with the IT Security Manager job role and follow these steps:

1. On the Security Console, search for and select a job role. For example, search for and select the Human Resource Analyst job role. Depending on the enterprise setting, either a graphical or a tabular representation of the role appears. Switch to the tabular view if it doesn’t appear by default.

2. Human Resource Analyst inherits many Transaction Analysis duty roles, such as Documents of Record Transaction Analysis and Absence Management Transaction Analysis. These roles (without the word Duty in their names) are HCM roles. Their role codes start with the characters ORA_. Find these roles in the table.

3. Notice also the many Transaction Analysis Duty roles (with the word Duty in their names) that appear here. For example, Human Resource Analyst inherits the Documents of Record Transaction Analysis Duty and Absence Management Transaction Analysis Duty roles. These roles are OBI roles. Their role codes start with the characters FBI_. Find these roles in the table.
4. Notice that the Absence Management Transaction Analysis Duty role inherits BI Consumer Role. Most of the OBI duty roles inherit BI Consumer Role.

5. The Human Resource Analyst role inherits BI Author Role directly. Find BI Author Role. Notice that BI Author Role also inherits BI Consumer Role.

Tip: You can export the role hierarchy to a spreadsheet for offline review.

Viewing Permissions in the Business Intelligence Catalog
To view these permissions, you must have a role that inherits BI Administrator Role. None of the predefined HCM job roles inherit BI Administrator Role.

1. Open the Reports and Analytics work area.
2. In the Contents pane, click the Browse Catalog icon. The Business Intelligence Catalog page opens.
3. In the Folders pane, expand Shared Folders.
   Expand the Human Capital Management folder and then the Payroll folder.
4. Click the Transactional Analysis Samples folder.
   A list of reports appears on the BI Catalog page.
5. Under Costing Reports, click More > Permissions.
   The Permissions dialog box opens. Scroll if necessary to see the complete list of permissions, which includes the role BI Administrator Role.
6. Click the Oracle Applications tab to return to the home page.

Business Intelligence Publisher Secured List Views: Explained
Oracle Business Intelligence Publisher is a set of tools for creating formatted reports based on data models. You can access Business Intelligence Publisher from Business Intelligence Composer or the Business Intelligence Catalog by clicking New > Report. This topic describes how you can use secured list views to secure access to data in Business Intelligence reports.

Some reporting tools combine the data model, layout, and translation in one report file. With that approach, business-intelligence administrators must maintain multiple copies of the same report to support minor changes. By contrast, Business Intelligence Publisher separates the data model, layout, and translation. Therefore, reports can be:

- Generated and consumed in many output formats, such as PDF and spreadsheet
- Scheduled for delivery to email, printers, and so on
- Printed in multiple languages by adding translation files
- Scheduled for delivery to multiple recipients

Business Intelligence Publisher Data Security and Secured List Views
When you create a Business Intelligence Publisher data model with physical SQL, you have two options.
You can:

1. Select data directly from a database table, in which case the data you return isn’t subject to data-security restrictions. Because you can create data models on unsecured data, you’re recommended to minimize the number of users who can create data models.

2. Join to a secured list view in your select statements. The data returned is determined by the security profiles that are assigned to the roles of the user who’s running the report.

The following tables show, for each database table:

- The secured list view
- The data security privilege required to report on data in the table, if it’s accessed using the secured list view

These duty roles have the privileges shown in the following table:

- Absence Management Transaction Analysis
- Payroll Transaction Analysis
- Vacancy Transaction Analysis
- Workforce Transaction Analysis

<table>
<thead>
<tr>
<th>Table</th>
<th>Secured List View</th>
<th>Data Security Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR_ALL_ORGANIZATION_UNITS_F</td>
<td>PER_DEPARTMENT_SECURED_LIST_V</td>
<td>Report Department Data</td>
</tr>
<tr>
<td>HR_ALL_POSITIONS_F</td>
<td>PER_POSITION_SECURED_LIST_V</td>
<td>Report Position Data</td>
</tr>
<tr>
<td>PER_JOBS_F</td>
<td>PER_JOB_SECURED_LIST_V</td>
<td>Report HR Job Data</td>
</tr>
<tr>
<td>PER_LOCATIONS</td>
<td>PER_LOCATION_SECURED_LIST_V</td>
<td>Report Location Data</td>
</tr>
<tr>
<td>PER_GRADES_F</td>
<td>PER_GRADE_SECURED_LIST_V</td>
<td>Report Assignment Grade Data</td>
</tr>
</tbody>
</table>

Note: PER_JOBS_F, PER_LOCATIONS, and PER_GRADES_F aren’t currently secured. The secured list views and privileges for these tables aren’t currently used.

These duty roles have the privileges shown in the following table:

- Documents of Record Transaction Analysis
- Payroll Transaction Analysis
- Workforce Transaction Analysis

<table>
<thead>
<tr>
<th>Table</th>
<th>Secured List View</th>
<th>Data Security Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ALL_PEOPLE_F</td>
<td>PER_PERSON_SECURED_LIST_V</td>
<td>Report Person Data</td>
</tr>
<tr>
<td>PER_PERSONS</td>
<td>PER_PUB_PERS_SECURED_LIST_V</td>
<td>Report Person Deferred Data</td>
</tr>
</tbody>
</table>

The Payroll Transaction Analysis duty role has the privileges shown in this table.
Table  Secured List View  Data Security Privilege

<table>
<thead>
<tr>
<th>Table</th>
<th>Secured List View</th>
<th>Data Security Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR_ALL_ORGANIZATION_UNITS_F</td>
<td>PER_LEGAL_EMP SECURED LIST_V</td>
<td>Report Legal Employer Data</td>
</tr>
<tr>
<td>PER_LEGISLATIVE_DATA_GROUPS</td>
<td>PER_LDG SECURED LIST_V</td>
<td>Report Legislative Data Group Data</td>
</tr>
<tr>
<td>PAY_ALL_PAYROLLS_F</td>
<td>PAY_PAYROLL SECURED LIST_V</td>
<td>Report Payroll Definition Data</td>
</tr>
</tbody>
</table>

The Compensation Transaction Analysis duty role has the privilege shown in this table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Secured List View</th>
<th>Data Security Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP_SALARY</td>
<td>CMP_SALARY SECURED LIST_V</td>
<td>Report Salary Data</td>
</tr>
</tbody>
</table>

The Human Resource Analyst job role has the privilege shown in this table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Secured List View</th>
<th>Data Security Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ALL_ASSIGNMENTS_M</td>
<td>PER_ASSIGNMENT SECURED LIST_V</td>
<td>Report Assignment Data</td>
</tr>
</tbody>
</table>

You can find details of the secured list views in the Tables and Views for Oracle HCM Cloud guide on the Oracle Help Center.

### Business Intelligence Publisher and PII Data: Explained

Personally identifiable information (PII) tables are secured at the database level using virtual private database (VPD) policies. Only authorized users can report on data in PII tables. This restriction also applies to Oracle Business Intelligence Publisher reports. The data in PII tables is protected using data security privileges that are granted by means of duty roles in the usual way. This topic identifies the tables that contain PII data and the data security privileges that are used to report on them.

#### Tables Containing PII Information

This table lists the PII tables and the privileges that are used to report on data in those tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Data Security Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADDRESSES_F</td>
<td>Report Person Address</td>
</tr>
<tr>
<td>PER_CONTACT_RELSHIPS_F</td>
<td>Report Person Contact</td>
</tr>
<tr>
<td>PER_DRIVERS_LICENSES</td>
<td>Report Driver License</td>
</tr>
<tr>
<td>PER_EMAIL_ADDRESSES</td>
<td>Report Person Email</td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS</td>
<td>Report Person National Identifier</td>
</tr>
<tr>
<td>Table</td>
<td>Data Security Privilege</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>PER_PASSPORTS</td>
<td>Report Person Passport</td>
</tr>
<tr>
<td>PER_PERSON_DLVRY_METHODS</td>
<td>Report Person Communication Method</td>
</tr>
<tr>
<td>PER_PHONES</td>
<td>Report Person Phone</td>
</tr>
<tr>
<td>PER_VISAS_PERMITS_F</td>
<td>Report Person Visa</td>
</tr>
</tbody>
</table>

Note: Work email and phone aren't protected.

All of these privileges are accessible using the Workforce Confidential Reporting duty role, which the Human Resource Analyst job role inherits.

Dimension Security: Explained

A dimension is a collection of business attributes or a hierarchy structure that you use to group or aggregate numeric measures. All Oracle Transactional Business Intelligence dimensions are unsecured, except for the Assignment Manager dimension. Therefore, when you select a single dimension, such as the worker or department dimension, you can see all worker and department data unfiltered. Oracle Transactional Business Intelligence data security isn’t applied until you select more than one dimension or one dimension plus one or more metrics.

For example, if you select Department Name from the Workforce Management - Worker Assignment Real Time subject area, then you can view all departments. When you add Assignment Count to the report, data security is applied and you can view workers only in the departments that you can access.

Assignment Manager

Assignment Manager is a hierarchical structure representing the reporting relationship between workers and managers. This dimension is the only secured HCM dimension in Oracle Transactional Business Intelligence. The Assignment Manager hierarchy is restricted to line managers. If the signed-in user doesn’t have direct reports, then he or she sees no data when you include Assignment Manager in the report.

Reserve the use of Assignment Manager for line managers only. Some other job roles, such as human resource analyst, may need access to manager information. In these cases, use the Manager Name in the Worker dimension instead of the Assignment Manager hierarchy.

FAQs for Security and Reporting
How can I give line managers access to compensation subject areas?

The predefined Line Manager role has no access to compensation subject areas. To provide this access, create a Line Manager job role. Add both the Compensation Transaction Analysis Duty and Compensation Transaction Analysis roles to the custom role.

How can I give line managers access to talent management subject areas?

The predefined Line Manager role has no access to talent management subject areas. To provide this access, create a Line Manager role. Add relevant transaction analysis duty roles to the custom role. For example, you may want to provide access to Workforce Goals subject areas. In this case, add both the Goal Management Transaction Analysis Duty and Goal Management Transaction Analysis roles to your custom role.
22 Auditing Oracle HCM Cloud Business Objects

Auditing Oracle HCM Cloud Business Objects: Explained

You can record and later retrieve audit information about the creation, update, and deletion of Oracle HCM Cloud business objects. This audit information is stored without user intervention. This topic summarizes how to manage audit policies and access the audit reports.

Audit Policies

You create audit policies to identify:

- Business objects to audit
- The attributes of the selected business objects to audit

Therefore, you can audit changes to a subset of a selected business object’s attributes, if appropriate.

Enabling and Disabling Audit

By default, auditing is disabled for all applications. To enable auditing for Oracle HCM Cloud, you:

1. Configure business objects for audit on the Configure Business Object Attributes page.
2. Enable auditing for Oracle Fusion Applications on the Manage Audit Policies page.

Auditing begins for the specified objects immediately.

To stop auditing an entire object, you can deselect the object on the Configure Business Object Attributes page. You can also select different attributes for audit at any time. If necessary, you can disable all auditing for Oracle Fusion Applications on the Manage Audit Policies page.

To manage audit, you must have the Manage Audit Policies (FND_MANAGE_AUDIT_POLICIES_PRIV) function security privilege. The predefined Application Implementation Consultant job role has this privilege.

Audit Reports

To access the data recorded by the audit process, you view audit reports in the Audit Reports work area. To open the Audit Reports work area, select Navigator > Tools > Audit Reports.

To view audit reports, you must have the View Audit Reports (FND_VIEW_AUDIT_REPORTS_PRIV) function security privilege. The predefined Internal Auditor job role has this privilege.

Related Topics

- Audit History: Explained
- Audit Event Types: Explained
Enabling Audit for Oracle HCM Cloud Business Objects: Procedure

This procedure describes how to enable audit for selected HCM business objects.

Selecting Products to Audit

Follow these steps:

1. In the Setup and Maintenance work area, go to the following for your offering:
   - Functional Area: Application Extensions
   - Task: Manage Audit Policies
2. On the Manage Audit Policies page, click **Configure Business Object Attributes** in the Oracle Fusion Applications section.
3. On the Configure Business Object Attributes page, select a product. For example, set **Product** to **HCM Core Setup**.

When you select a product, the objects that you can audit are listed in groups in the Objects section of the page. For example, for HCM Core Setup you see:

- Audit Top Node
  - Job
  - Common Work Structure
  - Location
  - Grade
  - Organization
  - Position
  - Data Role
  - Security Profiles

Under each of these object groups, you see hierarchies of objects and their auditable components. For example, in the Position group you see this hierarchy:

- Position
  - Position Valid Grade
  - Position Extra Information
- PositionLegCategoryVO
Selecting Objects and Attributes to Audit

Follow these steps:

1. In the **Audit** column of the table of business objects, select an item to audit. These rules apply:
   - When you select a single component, such as Position Valid Grade, its object group and the Audit Top Node are selected automatically.
   - When you select an object group, such as Position, every entry in the group and the Audit Top Node are selected automatically.
   - If you select Audit Top Node, then every object group and its contents are selected automatically.

2. You can configure the attributes to audit only when you select a single component, such as Position Valid Grade. When you select a single component, the Audited Components section of the page is updated automatically to list the attributes that are audited by default. To update the list of attributes, click the **Create** icon.

The **Select and Add Audit Attributes** dialog box opens.

3. In the **Select and Add Audit Attributes** dialog box, you can deselect the selected attributes, if appropriate, and select additional attributes. To audit flexfield attributes, if any, select the **Flexfields (Additional Attributes)** option. This option appears only if the selected component has flexfields.

4. Click **OK** to close the dialog box.

5. Click **Save and Close** on the Configure Business Object Attributes page.

Enabling Audit

On the Manage Audit Policies page:

1. Set **Audit Level** to **Auditing**.
2. Click **Save and Close** to close the Manage Audit Policies page.

Changes made from now on by any user to the selected attributes of the object are audited. A user who has the Internal Auditor job role or privileges can review audited changes on the Audit Reports page.

Auditable Oracle HCM Cloud Business Objects

This topic lists the Oracle HCM Cloud business objects that you can audit.

This table lists the business objects that you can audit for each product.

<table>
<thead>
<tr>
<th>Product</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCM Absence Management</td>
<td>Absences Records</td>
</tr>
<tr>
<td>HCM Compensation</td>
<td>Salary</td>
</tr>
<tr>
<td>HCM Core Processes</td>
<td>Worker Employment</td>
</tr>
<tr>
<td></td>
<td>Document Records</td>
</tr>
<tr>
<td></td>
<td>Person</td>
</tr>
<tr>
<td></td>
<td>Checklist</td>
</tr>
<tr>
<td></td>
<td>Health and Safety</td>
</tr>
</tbody>
</table>
### Auditing Oracle HCM Cloud Business Objects

<table>
<thead>
<tr>
<th>Product</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Eligible Jobs</td>
</tr>
<tr>
<td></td>
<td>• Seniority Dates</td>
</tr>
<tr>
<td></td>
<td>• Health and Safety Incident Core</td>
</tr>
<tr>
<td></td>
<td>• Health and Safety Incident Event</td>
</tr>
<tr>
<td></td>
<td>• HNS Incident Kiosk</td>
</tr>
<tr>
<td></td>
<td>• Health and Safety Action</td>
</tr>
<tr>
<td>HCM Core Setup</td>
<td>• Job</td>
</tr>
<tr>
<td></td>
<td>• Common Work Structure</td>
</tr>
<tr>
<td></td>
<td>• Location</td>
</tr>
<tr>
<td></td>
<td>• Grade</td>
</tr>
<tr>
<td></td>
<td>• Organization</td>
</tr>
<tr>
<td></td>
<td>• Position</td>
</tr>
<tr>
<td></td>
<td>• Data Role</td>
</tr>
<tr>
<td></td>
<td>• Security Profiles</td>
</tr>
<tr>
<td>HCM Payroll</td>
<td>• Pay Core Audit</td>
</tr>
<tr>
<td></td>
<td>• Pay Security Profile</td>
</tr>
<tr>
<td>HCM Talent</td>
<td>• Talent Content Library</td>
</tr>
<tr>
<td></td>
<td>• Talent Pools</td>
</tr>
<tr>
<td></td>
<td>• Talent Profiles</td>
</tr>
<tr>
<td></td>
<td>• Talent Profiles Setup</td>
</tr>
<tr>
<td></td>
<td>• Performance Evaluations</td>
</tr>
<tr>
<td></td>
<td>• Succession Plans</td>
</tr>
<tr>
<td>HCM Employee Wellness</td>
<td>• Activities</td>
</tr>
<tr>
<td></td>
<td>• Wellness User</td>
</tr>
<tr>
<td>HCM Recruiting</td>
<td>• Requisition</td>
</tr>
<tr>
<td></td>
<td>• Description</td>
</tr>
</tbody>
</table>

To configure the object components and attributes to audit for each business object, perform the Manage Audit Policies task.

### Enabling Access to HCM Audit Data: Points to Consider

This topic introduces ways of enabling access to HCM audit data.

#### Create a Data Role

You can create an HCM data role that includes the Internal Auditor job role with security profiles to identify the data that the role accesses. For example, to access audit data for person records, the HCM data role must include an appropriate person security profile. Use the predefined View All Workers security profile to enable access to audit data for all worker records.

#### Create Job Roles

Your enterprise may allow other job roles, such as human resource specialist, to access audit data for the auditable business objects that they access. To enable this access, you create a version of the job role to which you add the relevant privileges. You include this custom job role in an HCM data role with one or more security profiles that identify the data.
23 Certificate Management

Managing Certificates: Explained

Certificates establish keys for the encryption and decryption of data that Oracle Cloud applications exchange with other applications. Use the Certificates page in the Security Console functional area to work with certificates in either of two formats, PGP and X.509.

For each format, a certificate consists of a public key and a private key. The Certificates page displays one record for each certificate. Each record reports these values:

- **Type:** For a PGP certificate, "Public Key" is the only type. For an X.509 certificate, the type is either "Self-Signed Certificate" or "Trusted Certificate" (one signed by a certificate authority).
- **Private Key:** A check mark indicates that the certificate's private key is present. For either certificate format, the private key is present for your own certificates (those you generate in the Security Console). The private key is absent when a certificate belongs to an external source and you import it through the Security Console.
- **Status:** For a PGP certificate, the only value is "Not Applicable." (A PGP certificate has no status.) For an X.509 certificate, the status is derived from the certificate.

Click the Actions menu to take an appropriate action for a certificate. Actions include:

- Generate PGP or X.509 certificates.
- Generate signing requests to transform X.509 certificates from self-signed to trusted.
- Export or import PGP or X.509 certificates.
- Delete certificates.

Generating Certificates: Explained

For a PGP or X.509 certificate, one operation creates both the public and private keys. From the Certificates page, select the Generate option. In a Generate page, select the certificate format, then enter values appropriate for the format.

For a PGP certificate, these values include:

- An alias (name) and passphrase to identify the certificate uniquely.
- The type of generated key: DSA or RSA.
- Key length: 512, 1024, or 2048.
- Encryption algorithm option for key generation: AES128, AES256

For an X.509 certificate, these values include:

- An alias (name) and private key password to identify the certificate uniquely.
- A common name, which is an element of the "distinguished name" for the certificate. The common name identifies the entity for which the certificate is being created, in its communications with other web entities. It must match the name of the entity presenting the certificate. The maximum length is 64 characters.
• Optionally, other identifying values: Organization, Organization Unit, Locality, State/Province, and Country. These are also elements of the distinguished name for the certificate, although the Security Console does not perform any validation on these values.
• An algorithm by which keys are generated, MD5 or SHA1.
• A key length.
• A validity period, in days. This period is preset to a value established on the General Administration page. You can enter a new value to override the preset value.

Generating a Signing Request: Procedure

You can generate a request for a certificate authority (CA) to sign a self-signed X.509 certificate, to make it a trusted certificate. (This process does not apply to PGP certificates.)

1. Select **Generate Certificate Signing Request**. This option is available in either of two menus:
   - One menu opens in the Certificates page, from the row for a self-signed X.509 certificate.
   - The other menu is the Actions menu in the details page for that certificate.
2. Provide the private key password for the certificate, then select a file location.
3. Save the request file. Its default name is \[alias\]_CSR.csr.

You are expected to follow a process established by your organization to forward the file to a CA. You would import the trusted certificate returned in response.

Importing and Exporting X.509 Certificates: Procedure

For an X.509 certificate, you import or export a complete certificate in a single operation.

To export:

1. From the Certificates page, select the menu available in the row for the certificate you want to export. Or open the details page for that certificate and select its Actions menu.
2. In either menu, select Export, then Certificate.
3. Select a location for the export file. By default, this file is called \[alias\].cer.

To import, use either of two procedures. Select the one appropriate for what you want to do:

• The first procedure replaces a self-signed certificate with a trusted version (one signed by a CA) of the same certificate. (A prerequisite is that you have received a response to a signing request.)
  a. In the Certificates page, locate the row for the self-signed certificate, and open its menu. Or, open the details page for the certificate, and select its Actions menu. In either menu, select Import.
  b. Enter the private key password for the certificate.
  c. Browse for and select the file returned by a CA in response to a signing request, and click the Import button.

In the Certificates page, the type value for the certificate changes from self-signed to trusted.

• The second procedure imports a new X.509 certificate. You can import a .cer file, or you can import a keystore that contains one or more certificates.
  a. In the Certificates page, click the Import button. An Import page opens.
b. Select X.509, then choose whether you are importing a certificate or a keystore.
c. Enter identifying values, which depend on what you have chosen to import. In either case, enter an alias (which, if you are importing a .cer file, need not match its alias). For a keystore, you must also provide a keystore password and a private key password.
d. Browse for and select the import file.
e. Select Import and Close.

Importing and Exporting PGP Certificates: Procedure

For a PGP certificate, you export the public and private keys for a certificate in separate operations. You can import only public keys. (The assumption is that you will import keys from external sources, who will not provide their private keys to you.)

To export:
1. From the Certificates page, select the menu available in the row for the certificate you want to export. Or open the details page for that certificate and select its Actions menu.
2. In either menu, select Export, then Public Key or Private Key.
3. If you selected Private Key, provide its passphrase. (The public key does not require one.)
4. Select a location for the export file. By default, this file is called [alias]_pub.asc or [alias]_priv.asc.

To import a new PGP public key:
1. On the Certificates page, select the Import button.
2. In the Import page, select PGP and specify an alias (which need not match the alias of the file you are importing).
3. Browse for the public-key file, then select Import and Close.

The Certificates page displays a record for the imported certificate, with the Private Key cell unchecked.

Use a distinct import procedure if you need to replace the public key for a certificate you have already imported, and do not want to change the name of the certificate:
1. In the Certificates page, locate the row for the certificate whose public key you have imported, and open its menu. Or, open the details page for the certificate, and select its Actions menu. In either menu, select Import.
2. Browse for the public-key file, then select Import.

Deleting Certificates: Procedure

You can delete both PGP and X.509 certificates:
1. In the Certificates page, select the menu available in the row for the certificate you want to delete. Or, in the details page for that certificate, select the Actions menu.
2. In either menu, select Delete.
3. Respond to a warning message. If the certificate’s private key is present, you must enter the passphrase (for a PGP certificate) or private key password (for an X.509 certificate) as you respond to the warning. Either value would have been created as your organization generated the certificate.
Role Optimizer: Explained

Role optimization is the process used to analyze the existing role hierarchy for redundancies or other inefficiencies. Role optimization enables you to create a role hierarchy that minimizes the number of roles necessary to authorize every job role to its currently authorized privileges. The role optimizer feature automates the analysis process and generates a report you can use to optimize your job hierarchies.

Reasons to Optimize

Changes to the predefined role hierarchies can put the privacy of your application data at risk. You can unintentionally make your data less secure if you:

- Create duty roles with small groups of privileges in an attempt to minimize:
  - Dependencies
  - The impact of making incremental changes
- Grant privileges that already exist in the role hierarchy

The following figure shows how roles can proliferate or have duplicate privileges over time making your role hierarchy less efficient.
Benefits of Optimization

By using the role optimizer, you can:

- Increase user productivity.
  
  You save time that you can perform other tasks.
- Reduce administrative costs.
  
  You reduce the number of security objects and the amount of time you spend maintaining that you must administer them.
- Decrease access risk associated with undocumented role hierarchy changes.
  
  You identify and can eliminate redundant and inappropriate grants of privilege.

The following figure shows how the role optimizer can suggest more efficient role hierarchies.

Role Optimizer Access

The role optimizer feature is available as a predefined report. Schedule and submit the Role Optimization Report on the Overview page of the Scheduled Processes work area. The process:

1. Analyzes your existing job role hierarchies.
2. Generates the optimized job role hierarchy and stores the data for each job role in a separate CSV file.
3. Archives and attaches the CSV files as the process output.
4. Generates a log and archives it as a ZIP file. The log file includes technical details of the analysis for troubleshooting.
Note: The role optimization process makes no changes to your security structures. You use the report to map privileges to roles and update the role hierarchies.

Role Optimization Report

Use the Role Optimization Report to create the most efficient role hierarchy for your organization. Use the report results to evaluate and, if necessary, update your role hierarchy. The report results enable you to create a role hierarchy with the minimum number of roles necessary to authorize every job role to every privilege it is currently authorized to.

Users with the IT Security Manager role can run the Role Optimization Report, which is available from the security console.

You should run this report if you:

- Make changes to the predefined role hierarchy.
- Implement your own role hierarchy instead of the predefined role hierarchy.

Note: The process makes no changes to your role hierarchies.

The predefined role hierarchy in the security reference implementation is optimized as delivered.

Report Files

Monitor the process status on the Overview page. When the status value is Succeeded, two files appear in the Log and Output section of the report details.

The following table describes the two files that appear when you run the Role Optimization report.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClusterAnalysis-Job-CSVs. zip</td>
<td>Contains one CSV file for every job role. Each CSV file contains the duty roles and privileges that make up the optimized job role hierarchy. The name of a CSV file, identifies the job role hierarchy data that the file contains. For example, the ClustersforJob-AR_ REVENUE_ MANAGER_ JOB_ 14240.csv file contains all of the role hierarchy data for the Accounts Receivables Revenue Manager job role.</td>
</tr>
<tr>
<td>Diagnostics. zip</td>
<td>Contains a log file that provides technical details about the analysis process. You can use this file for troubleshooting purposes.</td>
</tr>
</tbody>
</table>

Import the raw data from the CSV file into your preferred application to read the results. Report data appears in these two sections:

- Privilege Clusters
- Cluster Details
Role Optimization Report Results

**Privilege Clusters**
The Privilege Clusters section lists each privilege and the name of a recommended privilege cluster. Specific cluster recommendations are described in the cluster details section.

**Cluster Details**
A Cluster Details section appears for each privilege cluster referenced in the Privilege Clusters section. Each detail section includes:

- Cluster name.
- Names of recommended candidate roles that map to the privilege cluster.
- Names and descriptions of the jobs and privileges associated with the cluster.

The following table provides descriptions of the fields that appear in the Cluster Details section.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Name</td>
<td>The name of the optimized cluster, usually in this format: Cluster ###</td>
</tr>
<tr>
<td>Primary, Secondary, Tertiary Candidate Role</td>
<td>Recommended role mappings for the privileges in the cluster. Up to three recommended duty roles map to the listed privileges. Select a role. Then assign the privileges in the cluster to that role.</td>
</tr>
<tr>
<td>Jobs in Cluster</td>
<td>The number of job roles that inherit the privilege cluster. A list of job names and descriptions is also included.</td>
</tr>
<tr>
<td>Privileges in Cluster</td>
<td>The number of privileges that make up the cluster. A list of privilege names and descriptions is also included.</td>
</tr>
</tbody>
</table>

ORACLE
Advanced Data Security

Advanced Data Security: Explained

Advanced Data Security offers two types of added data protection. Database Vault protects data from access by highly privileged users and Transparent Data Encryption encrypts data at rest. Advanced Data Security is available for Oracle Applications Cloud by subscription to Break-Glass service.

Oracle Database Vault

Database Vault reduces the risk of highly privileged users such as database and system administrators accessing and viewing your application data. This feature restricts access to specific database objects, such as the application tables and SOA objects.

Administrators can perform regular database maintenance activities, but cannot select from the application tables. If a DBA requires access to the application tables, request temporary access to the Oracle Fusion schema at which point keystroke auditing is enabled.

Transparent Data Encryption

Transparent Data Encryption (TDE) protects Oracle Fusion Applications data which is at rest on the file system from being read or used. Data in the database files (DBF) is protected because DBF files are encrypted. Data in backups and in temporary files is protected. All data from an encrypted tablespace is automatically encrypted when written to the undo tablespace, to the redo logs, and to any temporary tablespace.

Advanced security enables encryption at the tablespace level on all tablespaces which contain applications data. This includes SOA tablespaces which might contain dehydrated payloads with applications data.

Encryption keys are stored in the Oracle Wallet. The Oracle Wallet is an encrypted container outside the database that stores authentication and signing credentials, including passwords, the TDE master key, PKI private keys, certificates, and trusted certificates needed by secure sockets layer (SSL). Tablespace keys are stored in the header of the tablespace and in the header of each operating system (OS) file that makes up the tablespace. These keys are encrypted with the master key which is stored in the Oracle Wallet. Tablespace keys are AES128-bit encryption while the TDE master key is always an AES256-bit encryption.
Glossary

abstract role
A description of a person’s function in the enterprise that is unrelated to the person’s job (position), such as employee, contingent worker, or line manager.

action
The kind of access, such as view or edit, named in a security policy.

aggregate privilege
A predefined role that combines one function security privilege with related data security policies.

assignment
A set of information, including job, position, pay, compensation, managers, working hours, and work location, that defines a worker’s or nonworker’s role in a legal employer.

business unit
A unit of an enterprise that performs one or many business functions that can be rolled up in a management hierarchy.

candidate
In a succession plan, a person identified to fill a job or position or replace a named incumbent.

competency
Any measurable behavior required by an organization, job, or position that a person may demonstrate in the work context. A competency can be a piece of knowledge, a skill, an attitude, or an attribute.

condition
The part of a data security policy that specifies what portions of a database resource are secured.

content type
An attribute such as a skill, quality, or qualification that is added to a profile.

contingent worker
A self-employed or agency-supplied worker. Contingent worker work relationships with legal employers are typically of a specified duration. Any person who has a contingent worker work relationship with a legal employer is a contingent worker.
**data dimension**
A stripe of data accessible by a user. Sometimes referred to as data security context.

**data instance set**
The set of HCM data, such as one or more persons, organizations, or payrolls, identified by an HCM security profile.

**data role**
A role for a defined set of data describing the job a user does within that defined set of data. A data role inherits job or abstract roles and grants entitlement to access data within a specific dimension of data based on data security policies. A type of enterprise role.

**data security**
The control of access and action a user can take against which data.

**data security policy**
A grant of entitlement to a role on an object or attribute group for a given condition.

**database resource**
An applications data object at the instance, instance set, or global level, which is secured by data security policies.

**delegated role**
A job, abstract, or data role that a user, known as the delegator, assigns to another user, known as the proxy user.

**department**
A division of a business enterprise dealing with a particular area of activity.

**division**
A business-oriented subdivision within an enterprise. Each division is organized to deliver products and services or address different markets.

**document type**
A categorization of person documents that provides a set of options to control what document information to retain, who can access the documents, whether the documents require approval, and whether the documents are subject to expiry. A document type exists for a combination of document category and subcategory.

**duty role**
A group of function and data privileges representing one duty of a job. Duty roles are specific to applications, stored in the policy store, and shared within an application instance.

**effective start date**
For a date-effective object, the start date of a physical record in the object’s history. A physical record is available to transactions between its effective start and end dates.
enterprise
An organization with one or more legal entities under common control.

entitlement
Grant of access to functions and data. Oracle Fusion Middleware term for privilege.

flexfield
A flexible data field that you can configure such that it contains one or more segments or stores additional information. Each segment has a value and a meaning.

flexfield segment
An extensible data field that represents an attribute and captures a value corresponding to a predefined, single extension column in the database. A segment appears globally or based on a context of other captured information.

function security
The control of access to a page or a specific use of a page. Function security controls what a user can do.

generic organization hierarchy
An organization hierarchy that includes organizations of all classifications.

grade
A component of the employment model that defines the level of compensation for a worker.

HCM
Abbreviation for Human Capital Management.

HCM data role
A job role, such as benefits administrator, associated with instances of HCM data, such as all employees in a department.

HCM securing object
An HCM object that secures access to data in related objects. For example, access to specified person records allows access to data secured by person records, such as goal plans and evaluations.

job
A generic role that is independent of any single department or location. For example, the jobs Manager and Consultant can occur in many departments.

job role
A role, such as an accounts payable manager or application implementation consultant, that usually identifies and aggregates the duties or responsibilities that make up the job.
**LDAP**

**LDG**
Abbreviation for legislative data group.

**legal employer**
A legal entity that employs people.

**legal entity**
An entity identified and given rights and responsibilities by commercial law through the registration with country's appropriate authority.

**legislative data group**
A means of partitioning payroll and related data. At least one legislative data group is required for each country where the enterprise operates. Each legislative data group is associated with one or more payroll statutory units.

**managed person**
A person for whom a user can maintain some information. For example, line managers can maintain information about their direct and indirect reports.

**nonworker**
A person, such as a volunteer or retiree, who is not engaged in the core businesses of the enterprise or legal employer but who may receive payments from a legal employer. Any person who has a nonworker work relationship with a legal employer is a nonworker.

**party**
A physical entity, such as a person, organization or group, that the deploying company has an interest in tracking.

**pending worker**
A person who will be hired or start a contingent worker placement and for whom you create a person record that is effective before the hire or start date.

**person number**
A person ID that is unique in the enterprise, allocated automatically or manually, and valid throughout the enterprise for all of a person’s work and person-to-person relationships.

**person profile**
A collection of skills, experience, qualifications, work preferences, and career planning information for a worker.
person type
A subcategory of a system person type, which the enterprise can define. Person type is specified for a person at the assignment level.

position
A specific occurrence of one job that is fixed within one department. It is also often restricted to one location. For example, the position Finance Manager is an instance of the job Manager in the Finance Department.

privilege cluster
In the output of the Role Optimization Report, a group of privileges that you can map to a duty role.

public person
A person for whom basic information, such as name and phone, is available to all workers in worker directories and elsewhere.

resource
People designated as able to be assigned to work objects, for example, service agents, sales managers, or partner contacts. A sales manager and partner contact can be assigned to work on a lead or opportunity. A service agent can be assigned to a service request.

role
Controls access to application functions and data.

role hierarchy
Structure of roles to reflect an organization’s lines of authority and responsibility. In a role hierarchy, a parent role inherits all the entitlement of one or more child roles.

role mapping
A relationship between one or more roles and one or more assignment conditions. Users with at least one assignment that matches the conditions qualify for the associated roles.

role provisioning
The automatic or manual allocation of a role to a user.

sandbox
A testing environment that isolates untested code changes from the mainline environment so that these changes don’t affect the mainline metadata or other sandboxes.

security profile
A set of criteria that identifies HCM objects of a single type for the purposes of securing access to those objects. The relevant HCM objects are persons, organizations, positions, countries, LDGs, document types, payrolls, and payroll flows.
security reference implementation
Predefined function and data security that includes role based access control, and policies that protect functions, and data. The reference implementation supports identity management, access provisioning, and security enforcement across the tools, data transformations, access methods, and the information life cycle of an enterprise.

SQL predicate
A type of condition using SQL to constrain the data secured by a data security policy.

subject area
A set of columns, or pieces of data, related to a specific business object or area.

succession plan
A plan that identifies candidates for a role or position or to succeed a named incumbent.

system person type
A fixed name that the application uses to identify a group of people.

tax reporting unit
A legal entity that groups workers for the purpose of tax and social insurance reporting.

URL
Abbreviation for Uniform Resource Locator.

user person type
A name, derived from a system person type, that you can configure to your requirements to identify a group of people.

work area
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.

work relationship
An association between a person and a legal employer, where the worker type determines whether the relationship is a nonworker, contingent worker, or employee work relationship.

worker type
A classification selected on a person's work relationship, which can be employee, contingent worker, pending worker, or nonworker.